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1Getting Started
Welcome to mySewnet™ Cross Stitcher. mySewnet™ Cross Stitcher helps you create 
beautiful cross stitch designs to embroider on your machine. Cross types include full 
crosses, half crosses, quarter crosses, half height crosses, half width crosses and mini 
crosses.

Place outlines of standard and freehand backstitch, and use French knots for the perfect 
accent. Design traditional cross stitch motifs on the screen or use the Cross Stitch Design 
Wizard to produce designs automatically from clipart, drawings and photos.

Flood fill areas with crosses of any color. Alternatively, choose a ready made cross stitch or 
blackwork pattern. Create your own fill patterns, too. Reflect your design up to eight times 
automatically with the amazing Multiply feature. Draw shapes in different outline and fill 
styles. 

Place text with TrueType® or specially designed fixed fonts.

Cross Stitch Design Wizard
Use the Cross Stitch Design Wizard to convert pictures automatically to crosses, to load a 
picture as a background, to load an existing cross stitch design or to start a new design 
with no picture.

Finding Information

Reference Guide
The Reference Guide gives information on key features, with short ’How-To’ examples, 
which will help you learn how to use the module, and full reference information. The 
Reference Guide is supplied in PDF format , ready for printing.

Create QuickCross 
Design

Load Picture for New 
Cross Stitch Design 

Load Existing Cross 
Stitch Design

Start a New Cross 
Design with no Picture

Create a new design 
by converting color 
areas in a picture to 
crosses. 

Create a new design by 
loading a picture, and 
selecting the cross and 
design size. 

Open an existing cross 
stitch design,  preview 
it in the assistant, then 
load it. 

Select the desired cross 
size and design area, then 
start with a blank work 
area.
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Online Help
The online help contains the ’How-To’ examples and full reference information. Use the 
Help icon , press F1 or click the Help button. Where available, a help topic will appear 
that is relevant to the item where help was requested.

Viewing and Printing PDF Guides
To find all the Reference and Sample Guides for your mySewnet™ Embroidery Software, in 
Windows® 10 and 11 select the Desktop tile on the start screen. Then double-click the 
mySewnet™ Embroidery Software shortcut on your desktop, and double-click Reference 
Guides or Sample Guides. Select the desired PDF guide.

To view and print the PDF Guides, you will need a PDF reader such as Windows® Reader (included in 
Windows® 10 & 11) or Adobe® Reader (available from adobe.com).

Readme
The most up-to-date details about the mySewnet™ Embroidery Software are in the 
Readme.rtf file . (Double-click on a Readme file to open it in WordPad or Microsoft® 
Word.)

Sample Files
Samples are provided for your use. Download the sample files from the Downloads page: 
download.mysewnet.com. Copy the samples folder to the folder of your choice. 

For the exercises in this manual, the mySewnet folder is used.
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Where to Start
Starting mySewnet™ Cross Stitcher

Windows® 10 & 11 Start Screen
1 At the bottom left of your computer screen, open the Windows® 10 or 11 Start Screen.
2 In the Windows Start menu, scroll down to the mySewnet folder.
3 Click the mySewnet™ Cross Stitcher icon  to launch it.

Within mySewnet™ Embroidery
1 Launch mySewnet™ Embroidery .
2 In the Welcome screen, click the Cross Stitcher icon . mySewnet™ Cross Stitcher will start.

Shortcuts
An alternative to the Start screen/menu method described previously is to use a Shortcut 
to mySewnet™ Embroidery. This is created automatically during the installation process.

Windows® 10 & 11 (Desktop)
1 Close or minimize any programs you have running.
2 Double-click on the Shortcut to the mySewnet™ Embroidery Software folder. A list of the programs 

appears.
3 Double-click on the mySewnet™ Cross Stitcher icon  to launch it.

Closing mySewnet™ Cross Stitcher

Exit
Ends the mySewnet™ Cross Stitcher session. You can also use the Close command on the 
mySewnet™ Cross Stitcher Control menu.

Shortcuts
■ Mouse: Click the Close icon  on the title bar.
■ Keys: Alt + F4

About mySewnet™ Cross Stitcher
Access via the Help menu. The version number of mySewnet™ Cross Stitcher is given here. 
You will need this if you contact technical support at any time.

Shortcut
■ Keys: Alt, L, A
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Parts of the Software Window

Title Bar
The title bar at the top of the window is highlighted if mySewnet™ Cross Stitcher is active. 
The title bar shows the module name and the name of the currently loaded cross stitch 
design. 

The Quick Access toolbar gives icons for the following frequently used features: Insert, 
Save, Save As, Export, Print, Undo, Redo, Life View and Design Player. If more than one 
instance of mySewnet™ Cross Stitcher is open, each open window will show the name of 
the cross stitch design file.

Ribbon Bar
There are 8 tabs on the ribbon: File, Home, Create, Multiply, Letter, Pattern, View and Help.

An alternative way to access ribbon options is to press the Alt key, then the highlighted letter of the tab, 
followed by the highlighted letter of the tab item, e.g. Alt, H, U to remove unused colors in the design. Some 
functions are available by pressing the Ctrl key and another key at the same time. These shortcuts are 
shown in the tooltip for the relevant function.

Title BarQuick Access Toolbar Ribbon Bar Tabs

Status Bar Design Area Design Panel

Ribbon Bar

Cut, copy, paste or delete selected stitches

Use a selection tool to select stitches View the design as it will be when stitched out

Rotate the selected stitches
View and hide crosses, backstitch & knots

Remove colors not used in the design

Home Tab
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Use the Home tab to select, copy, move and rotate parts of a design; to view and hide 
crosses, backstitch and knots, and to display the design with Life View and Design Player.

Use the Create tab to draw and erase crosses, backstitch and French knots, to flood fill 
areas with crosses or a pattern, and to draw shapes.

Use the Multiply tab to repeat stitch placement or edit actions automatically by reflecting 
across, down or rotating. 

Use the Letter tab to add lettering using Fixed or TrueType fonts. Create new fonts from 
most TrueType® or OpenType® fonts on your computer.

Use the Pattern tab to choose fill patterns for use with shapes and lettering, and to create 
new patterns from a small stitch design.

Use the View tab to adjust the Grid, measure a design, show and hide the background 
picture, and change the view mode.

Work Area
The work area is the area where the design is displayed and edited.

Design Area
The design area is the area within the work area where stitches can be placed and edited. 
Use View Mode to switch between 3D , 2D  and Block  stitch views. 

When the grid is shown, this shows the extent of the design area. When the Grid is on, the 
design area shows grid lines with uniform spacing. If chosen, there may be dark grid lines 
every five or ten grid squares. Each grid square corresponds to one cross in the design. 

If there is a background picture, this is only shown within the design area.

Design Panel
To the right of the work area is the design panel. 

The Design Information shows the dimensions (Height  and Width ), Stitch Count , 
and number of colors  for the active design.

The Color Select area shows all the currently available thread colors. Thread colors can be 
added as desired or added automatically. Use the Move and Merge color buttons to 
change the thread order. Use the Notes box to enter details about the design.

Status Bar
The status bar is found at the bottom of the window. Starting from the left, the status bar 
shows:

■ The selection tools.
■ The pointer coordinates.
■ The zoom tools and Zoom Bar.
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mySewnet™ Cross Stitcher Terms and Conventions
On-screen Pointers
The pointer is most commonly shown as an arrow  on the screen.

If it is positioned over a text box, such as the Letters box on the Letter tab, it changes to an 
I-bar  and you can type. 

If Zoom To Rectangle  is chosen, the zoom in pointer  appears. When zoomed in, if 
the Pan feature is used to move around the screen, the Pan pointer  appears. 

The Box Select , Freehand Select , or Point Select  pointer appears when the 
associated Select function is chosen. 

The horizontal double-headed arrow  pointer appears when the mouse pointer is over 
the Flip Horizontal handle . The vertical double-headed arrow  pointer appears 
when the mouse pointer is over the Flip Vertical handle . When the pointer is over a 
selection, the four arrow pointer appears , showing that the selection can be moved.

When the drawing functions on the Create tab are chosen, the pointer appears as follows:

The drawing pointers are red when set to Erase.
When Pick Color is used to choose a color in the Design Area, or used to choose additional 
colors on the Thread Colors page of the Cross Stitch Design Wizard, the Pick Color 
pointer  appears. 

The measure pointer  appears when Get Length is chosen.

The cross-hair pointer  appears when using Place Center  in the Multiply tab.

File Formats

Cross Stitch Design Files
mySewnet™ Cross Stitcher loads and stores cross stitch designs in files with the extension 
.krz.

When a .krz file made in a previous version of Cross Stitcher is loaded, thread colors are automatically 
identified and converted when the thread manufacturer and thread number matches a mySewnet™ Cross 
Stitcher thread. Colors that do not match are converted to the Import Thread Range chosen in mySewnet™ 
Configure.

Full Cross Quarter Cross Half Cross Forward Half Cross 
Backward

Mini Cross Half Width Cross Half Height Cross Standard 
Backstitch

Freehand 
Backstitch

French Knot Flood Fill



mySewnet™ Cross Stitcher   Getting Started              7

Picture Files
mySewnet™ Cross Stitcher can load any of the following picture file formats: Windows or 
OS2 Bitmap (.bmp), JPEG-JFIF Compliant (.jpg, .jif, .jpeg), Portable Network Graphics (.png), 
Tagged Image File Format uncompressed (.tiff, .tif ), Windows Meta File (.wmf), Windows 
Enhanced Meta File (.emf) and Windows Icon (.ico).

mySewnet™ Cross Stitcher can create pictures and videos of designs from Design Player 
and Life View.

Embroidery Files
mySewnet™ Cross Stitcher can export embroidery files in any of the following formats: 
Brother/Baby Lock/Bernina PEC (.pec), Brother/Baby Lock/Bernina PES (.pes version 2 - 11), 
Compucon/Singer PSW (.xxx), Husqvarna Viking / Pfaff (.vp4, .vp3 and .vip), Husqvarna 
(.hus ,.shv), Janome (.jef and .sew), Melco (.exp), Pfaff (.pcs), Tajima (.dst) and Toyota (.10*).

Note: The preferred file format for exporting embroideries is .vp4, as this will preserve thread color 
information and notes.
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Hints on Planning Cross Stitch Designs
Design Size
The Design Area is determined by the Width x Cross Size and Height x Cross Size. It is 
shown on the Design Size page of the Cross Stitch Design Wizard and in Design Properties.

The Width and Height in the design Information in the Design Panel gives the size of the 
actual embroidery that will be created from the current cross stitch design.

If there are French knots at the edges of a design, the embroidery Width and Height may be greater than 
the Design Size.

Flood Fill
When an area is flood filled, the fill does not relate to the background picture. An empty 
area can be flood filled until it meets existing crosses and/or backstitch. A connected area 
of the same colored crosses can be flood filled until it meets an empty area, backstitch or 
crosses in a different color.

Sometimes it may help to hide the background picture so that you can clearly see the area 
you wish to flood fill; for example, if there are lines in the background picture that are 
similar to backstitch.

Stitch Layers and Movement Stitches in the Embroidery
When you create an embroidery from a cross stitch design, mySewnet™ Cross Stitcher 
generates crosses in the color order in the palette. Then the palette order is repeated for 
backstitch and French knots.

If there are backstitch and French knots in the same color, the backstitch is stitched out 
and then the French knots, all as a single color block. To ensure French knots are stitched 
after a different backstitch color, use the Color Select area to change the order of thread 
colors in the palette.

Crosses and Movement Stitches
Movement stitches are automatically placed between each color area, and between 
crosses of the same color if they are not connected. Minimize movement stitches, and 
therefore the trims required after embroidery, by linking crosses of a color to at least one 
other cross in that color.

For a neat finish to your cross stitch embroideries, trim the movement stitches before each color change.

Standard Backstitch and Freehand Backstitch
Standard Backstitch  is drawn in short sections that snap 
to the sides and diagonals of grid squares. This means the 
end points for Standard Backstitch are the corners of the 
grid squares.
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Freehand Backstitch  is drawn as a separate layer to 
Standard Backstitch. Freehand Backstitch is placed using 
end points that snap to half grid spacing anywhere on the 
design. This means that a single section of Freehand 
Backstitch can be any length that will fit within the design.

Although the screen shows Standard Backstitch and 
Freehand Backstitch as separate layers, they are stitched 
out together when they are the same color. There will be movement stitches between 
sections of backstitch if they do not connect at an end point. Freehand Backstitch will not 
join to other backstitch without a movement stitch if it simply crosses over without the 
end points connecting. To reduce movement stitches, place Freehand Backstitch so that 
the end points connect to Standard Backstitch sections or other Freehand Backstitch 
sections.

It is possible to place Freehand Backstitch directly on top of Standard Backstitch and both sections will be 
stitched. This can be used for special effects, such as thickening a line without having to change the 

number of threads in Color Properties .

French Knots and Movement Stitches
French knots are stitched individually. They are not connected to other stitches. Therefore, 
there are movement stitches to and from all French knots. Use French knots to add 
decorative details to your designs.

Stitch Counts
The number of stitches shown in the Design panel and printouts is an approximation and 
may not match the number of stitches shown when the embroidery is copied or loaded 
into other mySewnet™ Embroidery Software modules.

Printing a Worksheet
Use the print options on the File menu or the Print icon  to print a worksheet for the 
embroidery created from the design.
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Information for Hand Cross Stitchers
Many effects from hand cross stitch are possible with mySewnet™ Cross Stitcher. Change 
the cross size, alter the number of threads and choose different stitch types to create many 
different styles.

Cross Size
Varying the cross size (in Design Properties) produces a wide range of embroidery results. 
For example, small cross sizes, such as 1.4mm resemble petit point. Larger cross sizes, such 
as 1.8mm or 2mm are closer to traditional gros point or cross stitch. 

To create cross stitch designs at the same sizes as real counted fabrics, set the Cross Size as 
shown:

Thread Count
Altering the number of threads (in Design Properties and Color Properties ) also has an 
effect. For example, single thread allows the crosses to be seen more clearly. Double or 
triple thread produces embroidery looking more like 'tapestry' or needlepoint. The 
number of threads may also be varied depending on the cross size — a small cross size 
such as 1.4mm often stitches out best using single thread. Cross sizes of 1.6mm, 1.8mm or 
2.0mm are often effective with double thread. Designs with larger cross size may benefit 
from triple thread, especially for backstitch threads.

Stitch Types
A number of different stitches are used in mySewnet™ Cross Stitcher. A Full Cross is similar 
to a full cross in hand work, and can be placed as part crosses in quarters and halves.

Small stitches are available as half width, half height and mini crosses.

Aida Count Cross Size

11 2.3mm (0.091")

14 1.8mm (0.071")

16 (also 32 on Linen) 1.6mm (0.063")

18 1.4mm (0.055")

22 1.2mm (0.047")

Full Cross Quarter Cross Half Cross Forward Half Cross Backward 

Mini Cross Half Height Cross Half Width Cross 
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Use two types of backstitch to create outlines.

Also place French knots  in any of nine grid positions for decorative details.

Color Combinations
Certain adaptations to hand cross stitch techniques will produce machine embroidery 
files that are easier to stitch. For example, combine colors when possible to reduce the 
number of thread changes required. Always try to link crosses of a color to at least one 
other cross in that color. This will avoid movement stitches that have to be trimmed after 
embroidery.

Standard Backstitch Freehand Backstitch
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Design Styles
Use mySewnet™ Cross Stitcher to create traditional cross stitch and other embroidery 
styles.

Eastern European Cross Stitch
One and two-color cross stitch designs, often in red and black or orange and black, are 
popular in peasant embroidery in Russia, Romania, and many other countries of Eastern 
Europe. These may be produced using mySewnet™ Cross Stitcher.

Assisi Work
This traditional hand cross style, named after 
the town of Assisi in Italy, may be reproduced 
using mySewnet™ Cross Stitcher. The design is 
outlined in black, using double or triple 
threads. This outline stitch is sometimes called 
Holbein stitch. The background of the design is 
worked in single thread cross stitch in a strong 
color, traditionally china blue, but red may also 
be used. Full Crosses should be used, with no 
partial crosses or any of the smaller cross types. 
A 'reverse' or 'relief' effect is therefore 
achieved. 1.8mm is a suitable cross size to use 
for this type of embroidery. This type of cross 
stitch is traditionally done on fairly loose 
weave linen or cotton fabric, although it looks equally good on other fabrics. Simple 
shapes are most suited to this style of cross stitch.

Blackwork and Redwork
These are backstitch-only styles, generally using only black or 
red thread. Traditional patterned shapes in backstitch are 
used to fill areas of the design instead of using conventional 
crosses. A number of fill patterns are provided that can be 
used for this style of embroidery. Switch between blackwork 
and redwork fill simply by changing the color on a fill pattern.

Designs created only in backstitch are often called blackwork. 
They often use a single color (blackwork or redwork; 
blackwork was popular in Elizabethan England; redwork is 
well known in North American folk quilts). mySewnet™ Cross 
Stitcher includes many beautiful blackwork fill patterns.
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Gobelin
Gobelin is placed as parallel vertical or slanted stitches of 
equal length, and is used to fill areas with a simple stitch 
pattern. In mySewnet™ Cross Stitcher, use Half Forward or 
Half Backward Crosses for gobelin slanted at 45 degrees, or 
use Freehand Backstitch for vertical or near-vertical gobelin 
stitch.

Rice Stitch

Rice stitch is a normal cross with a small stitch across each 
arm of the cross. This gives the appearance of overlapping crosses. To 
produce this effect, use a large cross size for the design and place the small 
stitches across the arms with Freehand Backstitch, often in a different color 
to the main cross.

Lace
Use blackwork to create simulated lace resembling heritage styles such as Tenerife lace, 
Hardanger or Filet-Guipure. Create outlines with backstitch, then fill with blackwork 
patterns. Stitch the designs on light net fabric (similar to that used for bridal veils) with a 
heavy water-soluble stabilizer. Then wash the fabric to remove the stabilizer.
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2Managing Cross Stitch Designs
A new design can be started with New . This will start the Cross Stitch Design Wizard. 
Use the Cross Stitch Design Wizard to create a new design automatically, load a picture for 
a new design, load an existing design or start a new design with no picture.

On the main screen, you can Open  a design, Open Recently Used Designs or Load a 
Design with Drag and Drop. You can also Insert  existing designs into the current 
design.

When starting from a blank design, you may start creating your design with any drawing, 
pattern, shape or lettering features. However, it is also common to follow a picture when 
creating a design. Use the Load Picture for New Cross Stitch Design option of the Cross 
Stitch Design Wizard to open or scan a picture to follow.

If you wish to create or edit your own picture, use mySewnet™ Draw & Paint or an image editor of your 
choice.
Save finished designs with Save  or Save As , then create the final embroidery with 
Export . Alternatively, you can copy part of a design as an embroidery with Copy 
Embroidery .

New
Use New  to clear the mySewnet™ Cross Stitcher screen so that you can start a new 
cross stitch design. You are prompted to save the design if changes have been made. The 
Cross Stitch Design Wizard appears, so you can select whether to create a QuickCross 
Design, load a picture for a new design, load an existing design or start a new design with 
no background picture.

See “Using the Cross Stitch Design Wizard” on page 28.
A cross stitch design may be a maximum of 400 x 400 full crosses. A full cross fills one grid 
square on the design area.

Shortcuts
■ File Menu: 
■ Keys: Ctrl + N

New Window
Use File, New Window to open an additional mySewnet™ Cross Stitcher window so that 
you can paste a block to start a new project, or place embroideries, lettering, motifs, 
SuperDesigns or frames to form a project.

To move between open mySewnet™ Cross Stitcher windows, hover over the mySewnet™ Cross Stitcher icon 
on the taskbar, and select the desired window.

Shortcuts
■ File Menu: 
■ Keys: Ctrl + Shift + N
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Open
Open
Use Open  to load an existing design file (extension .krz). mySewnet™ Cross Stitcher 
displays the Open dialog box so you can choose a design to open.

Open Recently Used Designs with the File 1,2 ... command, or Load a Design with Drag and Drop from 
Windows® Explorer.
The following options allow you to specify which file to open:

File Name
Type or select the filename you want to open. This box lists files with the .krz extension.

Files of Type
This is set to Cross Stitch Files (*.krz) and may not be changed, so that only cross stitch 
design files can be opened.

Look In
Select the drive or folder containing the file that you want to open.

Shortcuts
■ File Menu: 
■ Keys: Ctrl + O

Open Recently Used Designs
Use File, Recent to open previously used cross stitch design (.krz) files via the filenames 
listed in the Recent section of the File menu. Select the name of the desired design.

Load a Design with Drag and Drop
To drag and drop a cross stitch design (.krz) file onto the screen, use Windows® Explorer.

Use Open to load a file by name, or Recent on the File menu to open recently used designs.

Open a Design with Drag and Drop
1 Open a window in Explorer. If required, resize the Explorer window so you can see both Explorer and 

mySewnet™ Cross Stitcher.
In Windows® 10 & 11, click File Explorer on the Status Bar.

2 Browse through the drives and folders of your computer to find the 
Documents\mySewnet\Samples\Cross Stitch\Krz folder.

3 Click on the desired design name to highlight it.
4 Use the mouse to drag and drop the design onto the mySewnet™ Cross Stitcher screen. The design 

will be displayed on the screen.
You may be asked if you want to save the current design.

5 Close Windows® Explorer.
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Insert
Use Insert  to insert existing cross stitch designs (.krz files) into the current design.

Click the Insert icon and the Open dialog box appears. Browse to the desired folder, click 
to select the design, then click Open. The design is placed in the middle of the design area 
and automatically selected so that it can be moved, mirrored, copied or cut.

You can use Insert to transfer design elements between cross stitch design files. Simply delete all the objects 
from a design except the desired design element (for instance, in a floral design delete everything except 
one flower that you want to use somewhere else). Save the isolated design element as a new cross stitch 
design file (.krz). Open the design where you want to insert the isolated design element, then browse and 
insert it with Insert. If you do this several times then you will gradually build up your own library of design 
elements.

Shortcuts
■ Quick Access Toolbar: 
■ Keys: Ctrl + I; Alt, 1

Load a Cross Stitch Design with Insert
1 Click the Insert icon . The Open dialog box will appear. 
2 Browse to the desired folder.
3 Scroll down to see more designs, if available.
4 Scroll to display all the designs in a folder, and click a thumbnail to choose a new design.
5 Click on a thumbnail, then click Open to insert the design. It is placed in the center of the current 

design, and the dialog box is closed.
6 Click the Cancel button to exit without selecting a design. The most recently inserted design will still 

be selected as the current selection.

Click to select a design

Scroll to view more folders

Load the selected design

Scroll to view more designs
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Save
Save
Use Save  to save the design file under its current name and folder. When you save a 
design for the first time, mySewnet™ Cross Stitcher displays the Save As dialog box so you 
can name the design file. If you want to change the name and folder of an existing design 
before you save it, choose the Save As command.

Shortcuts
■ Quick Access Toolbar: 
■ Keys: Ctrl + S; Alt, 2

Save As
Use Save As  to save the cross stitch design (.krz) file with a new name. mySewnet™ 
Cross Stitcher displays the Save As dialog box so you can name your design. To save a 
design with its existing file name and folder, use Save.

Shortcuts
■ Quick Access Toolbar: 
■ Keys: Ctrl + Shift + S; Alt, 3

Save On Exit
If you make changes to a design, then try to close the design before saving the changes, a 
message will appear, asking if you want to save the changed design.
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If you exit mySewnet™ Cross Stitcher or start the Cross Stitch Design Wizard then you will 
be asked about the open design. Choose between:

Export
Click Export  to save the selected design as a .vp4 embroidery file, or in an alternative 
embroidery format. Use the Design Player to see how the embroidery will be exported 
according to the current Optimize for Sewing options.

You can customize the initial Optimize for Sewing Options in mySewnet™ Configure.

The preferred file format for exporting embroideries is Husqvarna Viking / Pfaff .vp4, as 
this will preserve thread color information and notes for viewing and printing.

You can also export embroideries as Brother/Baby Lock/Bernina PEC (.pec), Brother/Baby 
Lock/Bernina PES (.pes), Compucon/Singer PSW (.xxx), Husqvarna (.hus ,.shv), Husqvarna 
Viking /Pfaff (.vp4, .vp3 and .vip), Janome (.jef and .sew), Melco Expanded (.exp), Pfaff 
(.pcs), Tajima (.dst) or Toyota (.10o).

The initial name will be the current name with "Exported" added. The text "Exported" may be changed in 
mySewnet™ Configure.

Shortcuts
■ Quick Access Toolbar: 
■ Keys: Ctrl + E; Alt, 4

Optimize for Sewing Options
All of these options are initially selected when saving as a .vp4 file, or in any other format.

Yes Save the changes to the design. If it is a new design, the Save As dialog box appears.

No Do not save the design and continue. Any changes to the design are lost. If it was a new 
design then it is discarded without being saved.

Cancel Do not save the design, but keep the design open and do not close mySewnet™ Cross 
Stitcher.
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Combine: Merge the embroideries into a single embroidery during Export.

Combine is not enabled if there is only one design, and for embroidery formats that are automatically 
combined.
Remove Overlap: Prevent areas of stitches building up where embroideries overlap.

Remove Overlap is not available when Combine is not enabled.
Only deselect this option if, for example, your embroideries are low density and you wish to have a blend 
effect where they overlap.
ColorSort: Reduce the number of thread colors during Export.

Optimize Stitch Length: Automatically remove small and insignificant stitches. See 
“Stitch Length Optimizer Options” on page 20.

Cutwork Needle lines in the Inspira Cutwork Needle "thread range", and Felting Needle colors in the Inspira 
Felting Needle "thread range", are unaffected by Optimize Stitch Length.

Decoration
Decorations are not available in mySewnet™ Cross Stitcher.

Hoop Orientation
Set the hoop orientation.

Rotate to fit natural hoop position: Rotate the embroidery if needed to fit with the 
default hoop orientation for the machine. This option is only available if the hoop on the 
main screen is in the rotated orientation. It is useful if you prefer to create a "landscape" 
shaped project in the rotated orientation.

Flip design for felting or reverse embroidery: Flip the embroidery for being stitched in 
reverse. If an embroidery contains a Felting Needle color effect this option is selected 
initially. 

Splitting options
Multipart hoops are not available in mySewnet™ Cross Stitcher.

Additional Sections
Additional dialog sections are available, depending on the chosen file format.

■ If .pes is chosen, you can select your machine type, file version, hoop size and rotation.
■ If .jef is chosen, you can select your machine type, hoop size and rotation.

Next
View the Save, or Saving As dialog, depending on the selected file format.

Export an Embroidery
1 Create a cross stitch project.
2 Save the cross stitch. See “Save As” on page 17.
3 In the Quick Access toolbar, click Export . The Export dialog box appears.
4 Select an embroidery format from the drop-down list.
5 Select your optimization options.
6 If you are using felting, use "Flip design for felting or reverse embroidery" to flip the design.
7 Click OK.
8 The Save As dialog will appear. Export the embroidery as desired. 
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Stitch Length Optimizer Options
Use the Stitch Length Optimizer Options dialog box to automatically remove small and 
insignificant stitches. You can adjust the stitch removal sensitivity, or the minimum 
significant stitch length.

Stitch Length Sensitivity
Adjust the sensitivity of the optimization. Low is set as the default.

■ Choose from Low, Medium or High.

Minimum Significant Stitch Length
Select the shortest stitch length that you consider to be significant. Stitches below this 
length are removed during the optimization process. The default stitch length is 0.8 mm.

Cutwork Needle lines are unaffected by the Minimum Significant Stitch Length.
■ Choose from 0.6 mm, 0.8 mm or 1.0 mm.

Sending Embroideries 
Send designs to your mySewnet™ enabled embroidery machine via mySewnet™ from 
within the mySewnet™ Embroidery Software, or directly from your mySewnet™ account.

Use mySewnet™ Connect to change your mySewnet™ settings, and to send embroideries 
directly to some HUSQVARNA VIKING® or PFAFF® machines using Direct USB Connection.

Send
Use the Send dialog to send the selected embroidery to the mySewnet™ Cloud, or to your 
machine.
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Send to mySewnet™ Cloud
Send the selected embroidery design to the mySewnet™ Cloud.

Send Express to mySewnet™ Device
Send the selected embroidery design direct to the mySewnet™ enabled machine or 
computer.

Select the computer or machine from the list below.

Direct USB Cable
Send or Send Express to a machine with a direct USB connection.

Filename
You can change the name of the design before sending it.

Sending via mySewnet™

Sending from a Machine to mySewnet™ Embroidery
You can send an embroidery from a mySewnet™ enabled embroidery machine to 
mySewnet™ Embroidery on your computer. Adjust the embroidery, then return it to your 
machine for stitching.

To be able to send from your machine to mySewnet™ Embroidery, and to send to your 
machine with Send Express to mySewnet™ Device:

■ mySewnet™ Connect must be running on the computer
■ You must use a mySewnet™ enabled embroidery machine with the most recent updates 

installed
■ The computer and embroidery machine must be signed in to the same mySewnet™ 

account.

Send the design to the mySewnet™ Cloud 
Send directly to a mySewnet™ device 

Select the machine or computer for sending to

Send to a machine using a Direct USB cable

Start the mySewnet™ Connect utility 

Change the design name before sending



22          mySewnet™ Cross Stitcher   Managing Cross Stitch Designs 

An embroidery moved from a machine to mySewnet™ Embroidery will include no special features from the 
embroidery machine, for example changing the words for lettering. This is also true of designs sent in the 
other direction.

Send from an Embroidery Machine
1 Go to the embroidery machine.
2 Tap the Cloud button at the top and ensure that you are signed in to mySewnet™.
3 Select embroidery mode, and then load an embroidery.
4 In the machine screen, choose the send to software option. 
5 Select the computer to send to, then send the embroidery. 

The embroidery will open in a new mySewnet™ Embroidery window.
6 When you have adjusted the embroidery, save the changes to your computer.

You can name your computer in the mySewnet tab of mySewnet™ Configure.
You can then use Send Express to mySewnet™ Device to return the edited embroidery to 
your machine for stitching out.

When you send from your embroidery machine to mySewnet™ Embroidery, the embroidery may be sent to 
a window beneath the active maximized window. The mySewnet™ button in the taskbar flashes to 
indicate that a design has been sent.

Using Send Express to mySewnet™ Device
1 In the File menu, select Send.
2 In the Send dialog box, select your machine name from the list. 

A message tells you that the design was sent.
3 On the machine, tap to accept the design from your computer.
4 Stitch out the design.

You can use Send to mySewnet™ in the Explorer Plugin to send embroideries to mySewnet™. See the 
mySewnet™ Configure Reference Guide and Help.

Sending to a Machine via Direct USB Connection
Use mySewnet™ Connect to send embroideries directly to your embroidery machine 
screen, or to the embroideries folder on your embroidery machine with Direct USB 
Connection.

■ mySewnet™ Connect must be open to transfer files directly to and from the embroidery 
machine when it is connected to your computer. 

■ Use the file manager on your embroidery machine to browse your computer and copy 
embroideries to any folder on your machine.

When Direct USB Connection is established, the machine name will be shown in the Machine menu.

Using mySewnet™ Connect with Direct USB Connection
Before using Direct USB Connection, ensure that your drivers are up to date at 
mysewnet.com

1 First, check your Direct USB connection.
Switch off your embroidery machine.

2 Open mySewnet™ Configure , and if the mySewnet™ Connect icon cannot be seen in the system 
tray, click Start mySewnet™ Connect  on the Utilities tab. 
The mySewnet™ Connect icon can be seen in the system tray, however it is flagged as inactive .

3 Switch on your embroidery machine, and wait for it to initialize. The mySewnet™ Connect icon is now 
flagged as active . 
You can now send embroideries to your embroidery machine’s screen or designs folder.
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Communication will also be shown as established if  a connection exists with mySewnet™.
4 Open mySewnet™ Embroidery, then use Insert  to load an embroidery design.
5 In the File menu click Send.
6 In the Send dialog box, select Send Express to USB connected machine, then click Send. The 

embroidery appears on the embroidery machine screen.
You can now stitch it on your embroidery machine.

7 In the Send dialog box, select Send to USB connected machine. Then click Send to send the 
embroidery to the MyFiles or Personal Files folder on your embroidery machine.
You can also send embroideries to your directly connected machine via the mySewnet™ Embroidery 
Software Explorer Plugin. See the mySewnet™ Configure Reference Guide and Help.

8 Right-click the mySewnet™ Connect system tray icon. A context menu appears.
9 Ensure that Start Automatically is selected, to start mySewnet™ Connect whenever your computer is 

started.
10 Click About mySewnet™ Connect to view the version number.

You will need this version number if you contact technical support at any time.

mySewnet™ Connect
Use the mySewnet™ Connect module in the mySewnet™ Embroidery Software to access 
your mySewnet™ settings in mySewnet™ Configure, and to send embroideries directly to 
some HUSQVARNA VIKING® or PFAFF® machines using Direct USB Connection.

To change your mySewnet™ settings, see the mySewnet™ Configure Reference Guide and Help.
Use the mySewnet™ Connect menu to check the status of your mySewnet™ or Direct USB 
Connection.

The System Tray Icon
When mySewnet™ Connect is running, it appears as an icon in the system tray  at the 
bottom right of your computer screen. The icon will show whether or not communication 
is established with your machine as follows:

■ Click or right-click the icon to see the mySewnet™ Connect Menu.

Communication is shown as established when a connection exists with either mySewnet™ or with your 
embroidery machine via Direct USB Connection.

Starting mySewnet™ Connect
mySewnet™ Connect is set to start automatically when you restart your computer. If it is 
not open, use the following steps.

1 Open mySewnet™ Configure .
2 On the Utilities tab, click Start mySewnet™ Connect . The mySewnet™ Connect icon  can now 

be seen in the system tray.
3 To close mySewnet™ Connect, click the icon in the system tray and in the mySewnet™ Connect menu 

click Exit.

mySewnet™ Connect Menu
Click the mySewnet™ Connect icon in the system tray to see a menu of options.

Communication established No communication
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The menu tells you whether you are signed in to mySewnet™, and if Direct USB 
connection is active.

For mySewnet™ the current status in mySewnet™ Configure is listed, for Direct USB your machine name or 
Not Connected are present. If you have more than one machine, the first found is used.

■ Select About mySewnet™ Connect to see the version number and copyright.
■ Select Start Automatically to select or deselect the automatic start when Windows® starts.
■ Select mySewnet™ Options to view the mySewnet tab in mySewnet™ Configure.
■ Select Direct USB Settings to view the shared drives list.
■ Select Help to display help pages about mySewnet™ Connect.
■ Select Exit to close mySewnet™ Connect and remove it from the system tray.

Shared Drive Selection
Click the icon in the system tray, and select Direct USB Settings in the popup menu that 
appears.

The Shared drives list shows all the drives on the computer. Drives that are selected with 
check marks can be browsed from your embroidery machine. All available drives are 
selected when mySewnet™ Connect is installed. If you add new drives after installing 
mySewnet™ Connect, such as a USB stick, you will need to click the drive so it is checked. 
Click the check boxes to uncheck drives that you do not want to browse from your 
embroidery machine.

The mySewnet™ Cloud Sync Tool
Use the mySewnet™ Cloud Sync Tool to manage the content of your mySewnet™ 
compatible embroidery machine from your PC.

The mySewnet™ Cloud Sync Tool is available from: www.mysewnet.com
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Select your machine brand, Register or Sign In, and in the Home page select mySewnet™ 
Cloud to download and install the Sync Tool.

The System Tray Icon
When the mySewnet™ Cloud Sync Tool is running, there is an icon on the bottom right of 
your computer screen. The icon will show whether or not the Sync Tool is running:

■ Left-click the icon to view your mySewnet™ folder and the mySewnet™ website.

■ Right-click the icon to see the mySewnet™ Cloud Sync Tool menu.

For more information, click Getting Started in the mySewnet™ Cloud Sync Tool menu.

Examples
Place a Border of Buds for the Happy House Sampler

1 In mySewnet™ Cross Stitcher , start the Cross Stitch Design Wizard and select Start a New Cross 
Stitch Design with no Picture. then click Next.

2 In the Design Size page set the Cross Size to 1.8mm.
3 Set Width (Crosses) to 63, and set Height (Crosses) to 66. Then click Finish.
4 In the Home tab of the ribbon bar, click Design Properties.
5 In the Design Properties dialog box, ensure that in Thread Count both Crosses and Backstitch are set 

to Single (2 Threads). Click OK.
6 In the View tab, ensure that Grid is set to Every 10 Lines .
7 Click the Insert icon  and the Open dialog box will appear.

If the folder shown in the Viewer is not Documents\mySewnet\Samples\Cross Stitch\Krz, browse to this 
folder.

8 Click the small flower called 'Bud 2.krz'.
9 Click Open to load the design.
10 Notice the flower is selected with Box Select. On the selection box, click the Flip Vertical  and Flip 

Horizontal  handles to turn the design the opposite way around.
11 Click and drag Bud 2 to position it one square from the left edge and one square down from the top 

edge.
12 In the Home tab, click Copy .
13 Click Paste , then click and drag the new copy of Bud 2 to the right so that it joins onto the first 

one.
14 Paste four more copies of Bud 2 and join them in a line across the top of the design area.

15 Click outside the last bud to deselect it and set it in place.
To add some text, see “Create Text for the Happy House Sampler” on page 120.

Add Designs to the Happy House Sampler
1 In mySewnet™ Cross Stitcher , select File, New  to start the Cross Stitch Design Wizard, select 

Load Existing Cross Stitch Design, and click Next. in the Open Existing Design page click Load a 
Design  and load Documents\mySewnet\Samples\Cross Stitch\Krz\HappyHouseBudsText.krz.

Sync Tool Active Sync Tool Inactive
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Alternatively, set up the work area and create the sampler text as described in “Create Text for the Happy 
House Sampler” on page 120.

2 In Design Properties on the Home tab ensure that Thread Count, Crosses and Backstitch are set to 
Single (2 Threads), and in the View tab ensure that the Grid is on.

3 In the Quick Access toolbar, click Insert . 
4 In the Open dialog box browse to Documents\mySewnet\Samples\Cross Stitch\Krz\Farmer Man.krz, 

then click Open. The design will be displayed on the screen and it will be selected with Box Select.
5 Click and drag inside the selection area to position the farmer on the left of the design, so that he is 

one grid square inside the left edge of the design area and the top of his hat is level with the ’H’ in 
House.

6 Click Insert  and in the Open dialog box load 'Farmer Woman.krz'. The design will be displayed on 
the screen and it will be selected with Box Select.

7 Click and drag inside the selection area to position the farmer on the right of the design, so that her 
arm and boot to the right are below the right end of the line of buds, and her feet are level with her 
husband’s.

8 Click Insert  and in the Open dialog box 
load 'Small House.krz'. The design will be 
displayed on the screen and it will be 
selected with Box Select.
Alternatively, browse to 
Documents\mySewnet\My Designs\ and select 
the copy of 'Small House.krz'. that you created 
in “Draw a House with Stitches” on page 92.

9 Position the house so that it is between the 
two farmers, and level with their feet.

10 Click outside the selection to deselect it and 
set it in place.

11 Click Insert  and load 
Documents\mySewnet\Samples\Cross 
Stitch\Krz \Boxed Heart.krz. The design will 
be displayed on the screen and it will be 
selected with Box Select.
Notice that the box around the heart is made 
of Half Width and Half Height Crosses to create 
a narrow border of crosses.

12 Click and drag inside the selection area to 
position the boxed heart over the farmer’s 
head, level with the top of 'Happy'.

13 Click Copy .
14 Click the Paste  icon, then click and drag the new copy of the boxed heart to position it over the 

other farmer’s head, level with the top of 'Happy'.
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15 Click outside the selection to deselect it and set it in place.

To remove unused threads, see “Remove Unused Colors From the Happy House Cross Stitch” on page 75.
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3Using the Cross Stitch Design 
Wizard
Use the Cross Stitch Design Wizard to convert pictures automatically to crosses. Also use 
the Cross Stitch Design Wizard to load a picture as a background only, load an existing 
cross stitch design or start a new design with no picture.

The Cross Stitch Design Wizard is started by New and also when mySewnet™ Cross Stitcher 
is started.

Create QuickCross Design
Create a new design by converting color areas in a 
picture to crosses. Choose an existing picture or obtain 
a new picture from a scanner or digital camera. If 
desired, crop the picture and straighten scanned 
pictures. Set the cross size and design area in crosses, or 
select a hoop to set the design area. Select the 
maximum number of colors and the desired thread 
range to use for the cross colors.

Load Picture for New Cross Stitch 
Design
Create a new design by loading a picture. If desired, crop 
the picture and straighten scanned pictures. Set the 
cross size and design area in crosses, or select a hoop to 
set the design area. The picture is loaded into 
mySewnet™ Cross Stitcher.

Load Existing Cross Stitch Design
Open an existing cross stitch design to preview it in the 
wizard, then close the wizard and load the design in 
mySewnet™ Cross Stitcher. The design area and palette 
will be set according to the design loaded.
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Start a New Cross Stitch Design with no Picture
Select the desired cross size and design area, then 
close the Cross Stitch Design Wizard and start with a 
blank work area.
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Hints and Tips on QuickCross Designs
Use Different Thread Ranges
Choose different Thread Ranges and numbers of colors to see the effect of different 
selections. For instance, neon thread ranges give 'pop art' effects.

Enhance Eye Highlights
When converting a portrait, use Pick Color on the Thread Colors page to select the 
highlights in the eyes. This will brighten the eyes and enhance the converted picture.

Remove Isolated Crosses
After the design is created, check for isolated crosses. If an isolated cross is not important 
for detail, replace it with the surrounding color, or a connected color. This will reduce the 
number of movement stitches in the finished embroidery.

Reduce Color Changes
Reduce the number of colors in the design. To do this, choose a color you wish to keep and 
then flood fill or paint full crosses over similar colors until only the chosen colors remain. 
Alternatively, use Merge Colors  in the Color Select area of the Design panel to change 
all crosses of one color to another color. It is recommended to do this one color at a time, 
so you can see the effect of replacing each color. When you reduce the number of colors 
this way, the effect is different from deleting colors in the Cross Stitch Design Wizard.

Color Order
Use the Color Select area of the Design panel to change the color order so that the design 
stitches from the inside out. This helps to reduce the effect of pulling on the fabric.

Add Borders
Add a simple border of backstitch along the edges of the design. Use a contrasting color 
to make the border stand out.

Add a more elaborate border by increasing the design size by a few squares, then flood fill 
with crosses or a pattern in the blank squares around the edge. You will need to convert 
the picture at a size that will allow the design and a border to fit inside the desired hoop.

Note that when you change the design size, the background picture will be removed. Save the design first 
so you have a copy of the design with the background picture, then use a new name for the design with a 
border.
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Design Options
Use the Design Options page to select how to start a new cross design.

Create QuickCross Design Load Picture for New Cross Stitch Design

Create a new design by converting color 
areas in a picture to crosses. Select the 
maximum number of colors and the desired 
thread range to use for the cross colors.

Create a new design by loading a picture, cropping or 
straightening as desired. Set the cross size and design 
area. The picture is loaded into mySewnet™ Cross 
Stitcher.

Load Existing Cross Stitch Design Start a New Cross Stitch Design with no Picture

Open an existing cross stitch design to 
preview it in the wizard, then close the 
wizard and load the design in mySewnet™ 
Cross Stitcher. The design area and palette 
are set according to the design loaded.

Select the desired cross size and design area, then 
close the Cross Stitch Design Wizard and start with a 
blank work area. 

Create a design
automatically from a picture
Load a background picture 
to create a design
Load a cross stitch design
Start a design without a picture
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Choose Picture
Use the Choose Picture page to select the picture you wish to convert to a QuickCross 
Design or load as a background for a new cross stitch design.

From Camera or Scanner will not be available if you do not have a WIA compliant scanner or digital 
camera attached to your computer.

After choosing or scanning a picture, you are returned to the Choose Picture page of the 
Cross Stitch Design Wizard. The picture is shown in the preview window. Click Next to 
continue.

Load a Picture
Click Load a Picture  to open a picture from clipart, or one you have previously scanned 
or created in an image editor. After selecting a picture, the preview box will show the 
selected picture. Click Next to continue.

The following file formats may be loaded: Windows or OS2 Bitmap (.bmp), JPEG-JFIF 
Compliant (.jpg, .jif, .jpeg), Portable Network Graphics (.png), Tagged Image File Format 
uncompressed (.tiff, .tif ), Windows Meta File (.wmf), Windows Enhanced Meta File (.emf ) 
and Windows Icon (.ico).

Select a picture file on 

Paste a copied picture

Import a file from a 

your computer

scanner or camera

The picture is previewed

Improve brightness & contrast

Create or Edit in Draw & Paint

Choose a picture folder

Click to select a picture

Scroll to view more folders

Change the icon size

Load the selected picture
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mySewnet™ Cross Stitcher is not used for picture editing or enhancement. If you wish to enhance the 
picture for conversion to a cross stitch design, use a picture editor. For example, you may wish to use 
mySewnet™ Draw & Paint to adjust and save a picture before loading it in mySewnet™ Cross Stitcher.

Select a Picture File
1 In the Choose Picture page of the Cross Stitch Design Wizard, click Load a Picture  and the Picture 

Viewer dialog box appears.
2 Double-click to expand the folders until the desired folder is highlighted.
3 Click on a picture to select it.
4 Click OK to open the picture in the Choose Picture page.
5 Click Cancel to exit without selecting a picture.

Paste Picture
Click Paste Picture  to load the picture in the Clipboard Block. The picture is shown in 
the preview area of the Cross Stitch Design Wizard.

From Scanner or Camera
Use From Scanner or Camera  to display the program that is used to acquire pictures 
from a scanner, a digital camera or another suitable device. Only devices that use Windows 
Image Acquisition (WIA) can be used to obtain pictures.

WIA (Windows Image Acquisition) is a standard method for transferring pictures from the device’s 
scanning or downloading program to another program, in this case the mySewnet™ Cross Stitcher module 
of the mySewnet™ Embroidery Software. If the manufacturer provides the appropriate software 
components needed for WIA compliance, these should have been installed when the device was installed.
Each scanner or digital camera has its own program that is used to scan or download 
pictures. Refer to the manual or online help provided with the program for instructions, if 
required. When the device and its software finish processing the Picture, it will be shown 
in the Choose Picture page.

Autolevel
Autolevel improves brightness and contrast in most photos, and can be used to bring out 
the color in underexposed pictures. By default Autolevel is enabled.

Autolevel does not make new adjustments each time a picture is loaded.

Occasionally Autolevel does not improve the appearance of a picture, and may need to be switched off.

Create New Picture and Edit Picture
Create a new picture  or edit an existing picture  in mySewnet™ Draw & Paint.

Back
Return to the Design Options page.

Next
Go to the Rotate and Crop Picture page.
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Rotate and Crop Picture

If required, rotate the picture to any angle from 0 to 359 degrees, in steps of 0.1 degree. 
For example, this is useful for straightening scanned pictures. Use Crop to select the 
section of the picture that is to be used, and Perspective Correction to adjust for 
perspective or skew.

Rotate
Rotate the picture to any angle from 0 to 359 degrees, in steps of 0.1 degree.

When the picture is rotated between the 90 degree steps, the picture is made larger and 
the detected background color is added. If there is no distinctive background color, white 
is used.

The size of the crop box may vary if the picture is rotated.

Crop
Use the Crop function to select the section of the picture that is to be used to create the 
design. When using Crop, the handles on the crop area are blue.

• When creating a QuickCross Design, the crop area selects the part of the picture to be 
converted to a cross stitch design.

• When loading a picture for a new design, the crop area selects the part of the picture to 
be used as the background for the new design.

The picture is automatically cropped to remove excess background color. If required, 
adjust the crop lines to select the desired part of the picture.

Sometimes, the automatic crop area may not appear to remove as much background color as possible. 
This can happen when the background color appears to be a plain color, such as white, but actually has 
minor variations that are not immediately visible. For example, this often happens with the JPEG-JFIF 
Compliant (*.jpg, .jif, .jpeg) picture format.
Click and drag anywhere inside the crop box to move the crop box. Click and drag outside 
the crop box to draw a new crop box.

Change the angle of the picture

Zoom in and out

Select the whole picture or 

Adjust the crop lines as desired

use the default crop settings

Correct the perspective in the picture Save the edited picture
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Select All
Click the Select All button to select the whole picture. Alternatively, double-click the 
picture to select the whole picture.

Automatic
Click Automatic to set the crop lines back to the default position for the current picture.

Rotate and Crop a Picture
1 Drag the rotational slider to rotate the picture to the desired angle.

Alternatively, enter a number in the rotation angle number box, or use the arrows to increase or 
decrease the angle of rotation.

2 Drag the blue handles on the crop area boundary line to select the desired part of the picture.
Hold the Ctrl key while dragging to resize the rectangle proportionally. Hold the Shift key while dragging to 
resize the rectangle without moving its center.

3 Drag anywhere inside the crop box to move the crop box.
If you need to expand a crop box again, make sure it is not touching the edge of the frame, as this will stop 
it expanding.

4 If desired, click Automatic to select the crop lines automatically, or click Select All to use the whole of 
the picture.

Perspective Correction
To remove the effects of perspective in a picture, or to correct skew, select Perspective 
Correction . When using Perspective Correction, the crop handles are red.

Move the red handles so that the crop lines frame the picture. Use the Zoom tools to view 
the outline of the picture more clearly.

When taking a picture, hold the phone or camera so as to avoid reflected light and shadow on your 
subject. To get the best possible results with a picture, use a scanner.

Stretch Picture
Drag the Stretch Picture  slider to make the picture in the Preview wider or narrower.

Enable perspective correction

Drag the red handles 
to select an area

Adjust the proportions of the picture Save the edited picture
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Save Picture
Use Save Picture  to save your edited picture.

Change the Perspective in a Picture
1 In the Rotate and Crop Picture page, ensure that Perspective Correction  is selected.
2 Move the pointer over one of the red crop handles in the corner.

The pointer changes to a diagonal double-headed arrow .
3 Move the red corner handles so that the crop lines frame the picture. The angle of the adjoining crop 

lines changes.
A version of the picture with the perspective corrected appears in the Preview area.
When taking a photo for a background or QuickCross design, hold the phone or camera so as to avoid 
reflected light and shadow on your subject. To get the best possible results with a picture, use a scanner.

4 Drag the Stretch Picture  slider to correct the proportions of the picture.
5 If desired, Save  the edited picture.

Zoom
Use the Zoom functions to change the view of the picture.

Use Zoom In  to magnify the view. Move the pointer over the picture and the pointer 
changes to the zoom in pointer . Then either click a point you want to zoom in towards, 
or click and drag a rectangle around the area you want to zoom in to and release the 
mouse button to zoom. When zoomed in, use the scroll bars to move around.

Use Zoom Out  to shrink the view. Move the pointer over the picture and the pointer 
changes to the zoom out pointer . Then click a point you want to zoom out from.

Click Zoom To Fit  to fit the picture to the preview area.

Click Real Size  to view the picture at its real size in pixels. This means that one pixel of 
the picture uses one pixel of the screen.

Back
Return to the Choose Picture page.

Next
Go to the Design Size page.
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Design Size

Use the Design Size page to set the picture size, hoop and cross size. Set the cross size, 
then set the desired hoop size. The preview shows the grid squares that fit in that hoop 
size. If desired, adjust the number of crosses.

Use Proportional to change the original proportions of the picture.

When starting a new design with no picture, the preview area shows the grid size of the new design.
Each grid square corresponds to one cross in a cross stitch design. When creating a 
QuickCross Design, it shows the amount of detail that is kept when the picture is 
converted to a cross stitch design.

When loading a chart or picture of a cross stitch, ensure that the number of grid squares used matches the 
original.

Cross Size
This is the Cross Size that will be used for the converted design. Set the Cross Size before 
changing the Height and Width or using Select Hoop.

Set the cross size from 1.0 to 30.0mm in steps of 0.1mm.

Select Hoop
Select a hoop to set the size of the cross stitch design. The design area will be a best fit to 
the selected hoop, using the chosen Cross Size.

Height and Width
Height and Width set the size in crosses that the picture will be when it is converted to a 
cross stitch design. Adjust the Height and Width in Crosses by typing numbers or clicking 
the up and down arrows. The maximum size for a design is 400 x 400 crosses.

Proportional
If this option is selected, when either Height or Width in Crosses is adjusted, the other 
dimension is altered automatically. This option is on when you start the Cross Stitch 
Design Wizard.

Set the size of the crosses

Zoom in and out

Choose a hoop to set the size

Set the dimensions in crosses

Cross stitch design dimensions
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Information
This shows the size of the design according to the Cross Size, Height and Width. Use this to 
ensure the design will fit in the desired hoop.

Zoom
Use the Zoom functions to change the view of the picture.

Use Zoom In  to magnify the view. Move the pointer over the picture and the pointer 
changes to the zoom in pointer . Then either click a point you want to zoom in towards, 
or click and drag a rectangle around the area you want to zoom in to and release the 
mouse button to zoom. When zoomed in, use the scroll bars to move around.

Use Zoom Out  to shrink the view. Move the pointer over the picture and the pointer 
changes to the zoom out pointer . Then click a point you want to zoom out from.

Click Zoom To Fit  to fit the picture to the preview area.

Click Real Size  to view the picture at its real size in pixels. This means that one pixel of 
the picture uses one pixel of the screen.

Back
For a QuickCross design, return to the Rotate and Crop Picture page. When starting a 
design with no picture, return to the Design Options page.

Next
For a QuickCross design, go to the Choose Thread Colors page.

Finish
When loading a picture, close the Cross Stitch Design Wizard and load the chosen picture 
on the main screen. When starting a design with no picture, close the Cross Stitch Design 
Wizard and open the main screen.
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Hoop Selection
Choose a hoop in the Hoop Selection dialog box. The new design area will be a best fit to 
the selected hoop, with the current Cross Size.

Hoop Group
The drop-down list of Hoop Groups shows all the machine Hoop Groups, and the My 
Hoops group, if used.

Hoop Size
The drop-down Hoop Size list shows the hoops in the chosen Hoop Group. Select the 
desired hoop size and a picture of the hoop will be shown in the Preview.

Included in My Hoops
Select (check) Included in My Hoops to add the selected hoop to the My Hoops list. Use 
the My Hoops list to create a list of your favorite hoops.

The selected hoops will be displayed in the My Hoops group in the order that they were selected.

Orientation
Select Natural or Rotated orientation according to the shape of the embroidery that is to 
fit in the hoop. Natural orientation is similar to the way the hoop would appear when you 
sit in front of your machine; note the position of the bracket.

It is recomended to use natural hoop orientation for designs with Twin Needle colors.

Select the hoop size Choose a machine or hoop group

Enter a size for a custom hoop Select the hoop orientation

Add the hoop
to My Hoops
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Enter Size
To enter a hoop size that is not listed in any of the Hoop Groups, click the Enter Hoop Size 
box so that it is selected (checked). The Width and Height boxes will become available. 
You can enter any size from 10mm to 4000mm. The preview shows the shape of the hoop 
you enter.

If you position the arrow pointer over the box without clicking, the alternative units and range will be 
shown.
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Choose Thread Colors

Use the Choose Thread Colors page to match thread colors to colors in the picture for 
creating a Quick Cross Design.

The picture is shown as blocks that correspond to the number of crosses that are created 
when the picture is converted to a cross stitch design. Thread colors are mapped to the 
blocks, according to the best match within the number of colors selected from the thread 
range.

Color Selection

Number of Colors
The Number of Colors  is initially set to the Recommended number of colors. The Cross 
Stitch Design Wizard determines the optimal number of colors for converting the picture 
into thread colors. When this number is changed, the list of colors and the preview are 
updated. The maximum Number of Colors is 256.

A high number gives a more realistic result for photographs if a suitable Thread Range is used, but this may 
cause a high number of isolated crosses and more movement stitches in the finished embroidery.

Apply
Click Apply to recalculate the threads with the new number of colors.

Reset
Return the thread list to the initial (recommended) set of threads.

When Reset is used, any custom thread matches that were made must be reselected.

Change All To
Click the drop-down arrow to choose a different thread range. When a thread range is 
chosen, each picture color in the list will be assigned the nearest matching thread color 
from the chosen thread range.

When a new thread range is chosen, all custom thread matches set by Change Thread will be lost.

Select a Thread Range

Delete all colors

Change a thread color

Choose a color from the picture

Zoom in and out

Choose a thread

Delete a color

Return to the original color list
Set the number of colors
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Picture and Thread Color List
The color list shows the colors that have been automatically selected. The colors are 
picked to give the closest representation of the original picture with the current Number 
of Colors. Each time the number of colors is changed, this list is updated.

Sometimes, when the Number of Colors is reduced to a low number, colors will be chosen 
that are averages of two or more prominent colors in the picture. This can give a 
posterized appearance to the Thread Color Preview. If this effect is not desired, increase 
the Number of Colors.

The same thread color may be matched to two or more colors in the picture. Each thread 
color can be individually changed with Change Thread. When thread colors are changed 
in the list, the Thread Color Preview is updated.

When more than one color in the picture is matched to the same thread color, the number of color changes 
in the final embroidery is reduced.

Change Thread
Click a color in the list, then click the Change Thread button. The Color Selection dialog 
box will appear so that a different thread color can be chosen. Alternatively, double-click a 
color in the list and the Color Selection dialog box will appear.

It is recommended only to use Change Thread after the main thread range has been selected.

Pick
Click Pick to add thread colors to the list by clicking the desired colors in the Source 
Picture.

When Pick is selected, the pointer changes to an eyedropper  over the source picture. 
Click the picture to pick up the color under the tip of the eyedropper, and the nearest 
matching thread color from the selected Thread Range will be automatically selected and 
added to the thread color list. The Thread Color Preview will be updated to show any other 
areas that can use the selected thread color.

The thread color is picked for the clicked color according to the RGB (red, green, blue) value at the point 
clicked. If there is already a thread color assigned to that exact RGB value, it will be highlighted in the list 
instead of adding a thread color to the list.

Delete
Delete the picture color currently highlighted in the list. The deleted color is replaced with 
the nearest remaining picture color in the list. The Thread Color Preview is re-displayed, 
with the reduced set of thread colors.

Delete All
Click Delete All to remove all the thread colors from the list if you wish to use Pick to 
choose colors from the Source Picture.

Previews

Source Picture
This shows the original picture, after being rotated and cropped, in full color.
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Thread Color Preview
This shows how the thread colors have been chosen to replace colors in the picture. This 
gives an approximate indication of where thread blocks will be in the final design.

If variegated threads have been selected, only the first color is shown in the preview.

Zoom
Use the Zoom functions to change the view of the picture. The same area of the picture is 
shown in both previews when the zoom level is changed.

Use Zoom In  to magnify the view. Move the pointer over the picture and the pointer 
changes to the zoom in pointer . Then either click a point you want to zoom in towards, 
or click and drag a rectangle around the area you want to zoom in to and release the 
mouse button to zoom. When zoomed in, use the scroll bars to move around.

Use Zoom Out  to shrink the view. Move the pointer over the picture and the pointer 
changes to the zoom out pointer . Then click a point you want to zoom out from.

Click Zoom To Fit  to fit the picture to the preview area.

Click Real Size  to view the picture at its real size in pixels. This means that one pixel of 
the picture uses one pixel of the screen.

Back
Return to the Design Size page.

Next
Go to the Design Preview page.
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Design Preview

Use the Design Preview page to view and check the final design before closing the Cross 
Stitch Design Wizard. 

Design Information
The design information boxes show the number of stitches in the cross stitch design, the 
height and width and the total number of color changes.

Zoom
Use the Zoom functions to change the view of the picture.

Use Zoom In  to magnify the view. Move the pointer over the picture and the pointer 
changes to the zoom in pointer . Then either click a point you want to zoom in towards, 
or click and drag a rectangle around the area you want to zoom in to and release the 
mouse button to zoom. When zoomed in, use the scroll bars to move around.

Use Zoom Out  to shrink the view. Move the pointer over the picture and the pointer 
changes to the zoom out pointer . Then click a point you want to zoom out from.

Click Zoom To Fit  to fit the picture to the preview area.

Click Real Size  to view the picture at its real size in pixels. This means that one pixel of 
the picture uses one pixel of the screen.

Back
If desired, use the Back button to go back through the Cross Stitch Design Wizard and 
modify settings before previewing the design again.

Finish
Accept the final design and close the Cross Stitch Design Wizard.

View the design information

Place the design in
the work area

Zoom in and out
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Open Existing Design
Use the Open Existing Design page to select an existing cross stitch design to open in 
mySewnet™ Cross Stitcher.

Load a Design
Click the Load a Design icon . The File Viewer dialog box will appear.

To see the name of a design, position the arrow pointer over the desired thumbnail. A 
label showing the file name will appear.

Select a Design File
1 Click Load a Design  and the Open dialog box appears.
2 Double-click to expand the folders until the desired folder is highlighted.
3 Click on a design to select it.
4 Click OK to open the design in the Open Existing Design page.
5 Click Cancel to exit without selecting a design.

Preview
The preview area shows the selected design in Block mode, with the name of the design 
underneath.

Click to select a design

Scroll to view more folders

Selected file name

Load the selected picture

Scroll to view more pictures
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Back
Return to the Design Options page.

Finish
Close the Cross Stitch Design Wizard and load the chosen design on the main screen.

How to Use the Cross Stitch Design Wizard
Create a Cross Stitch from a Photograph

1 Click New  and the Start Page of the Cross Stitch Design Wizard appears.
2 Leave Create QuickCross Design 

selected and click Next. The 
Choose Picture page of the 
Cross Stitch Design Wizard 
appears.

3 Click Load a Picture  and the 
Picture Viewer dialog box 
appears.

4 Browse to the folder 
Documents\mySewnet 
\Samples \Cross Stitch\Pics, click 
the file named 'Linnet.jpg' and 
click OK. The picture will be 
previewed in the wizard.

5 Click Next and the Rotate and 
Crop Picture page appears.

6 Initially, the whole picture is 
selected. In the picture area, 
move the pointer to the handle 
at the top right of the picture. 
Click and drag the handle to 
make the crop box smaller. 
Move the right side of the crop 
box until it is half way across the 
ear on the right, then release the 
mouse button or lift the pen.

7 Click and drag the handle on the 
top left until the line is half way 
across the ear on the left.

8 Click and drag the handle at the 
bottom right and move it 
upwards until it touches the 
button just under the girl’s chin.

9 Click and drag the handle at the 
top right and move it downwards until the crop box is square.
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10 Click Next. The Design Size page 
appears.

11 Change the Cross Size to 1.4mm.
Smaller cross sizes, such as this 
which is equivalent to Aida 18 
count, provide greater detail when 
creating cross stitch designs from 
photographs.

12 Click Select Hoop and the Hoop 
Selection dialog box appears. 
Ensure the Hoop Group is set to 
Universal, then set the Hoop Size 
to 100mm x 100mm - Universal 
Square Hoop 1. Click OK and the 
new design area will be 
calculated and previewed.

13 Click Next and the Choose Thread 
Colors page appears, showing only the cropped area of the picture.
The original picture is not affected by the Cross Stitch Design Wizard.

14 Select Robison-Anton Rayon 40 
as the Thread Range.

15 Set the Number Of Colors to 20 
and click Apply. The thread 
choice is automatically 
calculated.

16 Notice that the thread selection 
from Robison-Anton Rayon 40 
has a lot of brown tones for this 
picture. Click the Change All To 
drop-down arrow and choose 
Sulky Rayon 40 instead.

17 Click Apply again.
The Thread Range can be 
changed as often as desired.

The Cross Colors preview and thread color list may differ from the result shown. This is because even slight 
differences to the selected crop area will give different results in the cross stitch design.

18 Click Next. The Preview page 
appears.
This shows you the embroidery as 
it will be stitched out, giving 
information on the dimensions, 
the number of stitches, and the 
number of colors.

19 Click Finish. The cross stitch 
design will be created and then 
displayed on the screen. Any 
duplicate colors will be 
automatically combined into 
single colors in the color 
worksheet.

20 Click the Create tab, then click 
the Color block at the left of the 
tab.
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21 In the pop-up palette, click Add Color  and the Color Selection dialog box will appear so you can 
choose a new color.

22 Select Sulky Rayon 40 as the Thread Range.
23 Click the yellow Quick Color, and the thread list will jump to 1124 (Sun 

Yellow).
24 This color is rather bright, so click the paler yellow 1061 above it in the list 

(1061 Pale Yellow).
25 Click OK. The new color is added to the palette and is automatically 

selected.
26 Click the Cross Flood Fill icon  and the pointer changes to the paint 

bucket .
27 Click the solid background areas on the left and right.

If desired, also fill any individual colored crosses along the edges of the 
background where it meets the sweater and the girl’s hair. This will reduce the 
number of movement stitches in the finished embroidery.

28 Move the slider in the zoom bar to 100% to view the design at the size it 
will be stitched.

To save design and embroidery files for this cross stitch design, see “Create Cross Stitch and Embroidery 
Files for a Photo Design” on page 64. To print a worksheet, see “Print a Worksheet for an Embroidery” on 
page 134.
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Load a Picture of a House
1 In mySewnet™ Cross Stitcher , click New  and the Start Page of the Cross Stitch Design Wizard 

appears.
2 Select Load Picture for New Cross Stitch Design and click Next. The Choose Picture page of the Cross 

Stitch Design Wizard appears.
3 Click Load a Picture  and the Picture Viewer appears.
4 Browse to the folder 

Documents\mySewnet 
\Samples\Cross Stitch\Pics, click 
the file named 'Small House.jpg' 
and click OK. The picture will be 
previewed in the wizard.

5 Click Next twice and the Design 
Size page appears.

6 Ensure the Cross Size is set to 
2.0mm. 

7 Reduce the Width to 40 crosses, 
and the Height will also change 
to 40 crosses because 
Proportional is selected. The grid 
on the house picture will change 
accordingly.

A larger cross size, such as 2mm or more, gives a more traditional look to cross stitch designs.
8 Click Finish. The Cross Stitch Design Wizard will close, and the picture will be shown in the 

background of the design area.
To create a cross stitch design over this picture, see “Draw a House with Stitches” on page 92.

Start a Design Without a Picture
1 Close mySewnet™ Cross Stitcher  if it is open, and in mySewnet™ Configure  click the 

Appearance tab.
2 For Background, click the drop-down arrow and then click 

More Colors on the drop-down panel. The Colors dialog box 
appears, with the Standard tab selected.

3 In the hexagonal matrix, click the pale yellow hexagon that is 
just down and to the left of the central white hexagon, then 
click OK. The new color is shown on the Color button. 

4 Set the texture to Aida.
5 Click the Import tab and choose Robison-Anton Rayon 40 in 

the Import Thread Range drop-down list, then click OK.
6 Start mySewnet™ Cross Stitcher . The Design Options 

page of the Cross Stitch Design Wizard appears.
7 Select Start a New Cross Stitch Design with no Picture and 

click Next. The Design Size page appears.
8 Set the Cross Size to 1.5mm.
9 Click Select Hoop and the Hoop Selection dialog box appears.
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10 In the Hoop Selection dialog box select the Universal Hoop Group, then set Hoop Size to 240mm x 
150mm - Universal Large Hoop 2. Ensure the Orientation is Rotated, and click OK. 
The design area will be calculated and the preview area will show the grid size for the chosen hoop 
with the selected cross size.

11 Click Finish.
12 In the Home tab, click Design Properties and in the Design Properties dialog box, ensure that in 

Thread Count both Crosses and Backstitch are set to Single (2 Threads). Click OK.
13 In the View tab, ensure the grid is set to Every 5 Lines .

To start creating a sampler in this grid, see “Draw and Fill a Cross Stitch Border” on page 96.

Import a Cross Stitch Chart
1 In mySewnet™ Cross Stitcher , click New  and the Start Page of the Cross Stitch Design Wizard 

appears.
2 Select Load Picture for New 

Cross Stitch Design and click 
Next. The Choose Picture page 
of the Cross Stitch Design 
Wizard appears.

3 Click Load a Picture  and the 
Picture Viewer appears.
Click From Scanner or Camera to 
load a picture directly from your 
phone, scanner or camera.

4 Browse to the folder 
Documents\mySewnet 
\Samples\Cross Stitch\Pics, 
select the file named 'Bells 
phone photo.jpg' and click OK. 
The picture will be previewed in 
the wizard.

5 Click Next and the Rotate and 
Crop Picture page appears.
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6 Click to select Perspective 
Correction . The crop handles 
for selection become red.

7 Move the pointer over one of 
the red crop handles in the 
corner.
The pointer changes to a 
diagonal double-headed 
arrow .

8 Move the red corner handles so 
that the crop lines frame the grid 
for the cross stitch chart. A 
version of the picture showing 
the perspective changes that 
you made appears in the 
Preview area.
When taking a photo of a cross 
stitch chart, hold the phone or 
camera so as to avoid reflected light and shadow on your subject, and use a high resolution setting. To get 
the best possible results, use a scanner.

9 Use the Zoom tools for fine 
adjustments to the edges of the 
selected area.
You can use Stretch Picture  to 
ensure that the grid squares are 
actually square.

10 Click Next and the Design Size 
page appears.

11 Change the Width and Height 
numbers to match the number 
of squares in the grid for your 
chart. 
In this case the grid is 50 x 50, 
but the settings will probably 
show 49 x 50.

12 Deselect (uncheck) Proportional 
to attain an exact match.
Ideally, the grid on the screen 
should now fit over the grid in the picture.
If needed, click Back and adjust the selection area further, then try to match the two grids again.

13 Click Finish to load the picture onto the work area. You are now 
ready to create a cross stitch design over your loaded chart.

14 Use Add Color  in the Design Panel to add the thread colors 
from your chart.

15 Starting with the backstitch lines (and any French Knots), create 
stitches over the chart image, using the colors and their 
symbols as a guide.
You may find it easier to work in 2D View.
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4Viewing Cross Stitch Designs

View Mode
Use View Mode to switch between 3D , 2D  and Block  view. This changes the 
display of the crosses and other stitches.

Use mySewnet™ Configure to change the background color. If there is a background picture, when it is 
shown it will hide the background within the design area.

The thread type and number of colors in a thread does not affect the display on the 
mySewnet™ Cross Stitcher screen. All thread types are displayed the same as rayon 
threads. The stitches in variegated threads only use the first color in the thread.

3D
Use 3D  to display the design on a fabric background with the 
stitches drawn in 3D.

Use Texture in mySewnet™ Configure to turn the background fabric on and 
off. If any texture is selected in mySewnet™ Configure, mySewnet™ Cross 
Stitcher will show the 'Aida' fabric. The texture selected in mySewnet™ 

Configure is used in Design Player  and Life View .

If you would like to use fabric colors similar to the real Aida fabric colors, some of the RGB 
values for the background color you may wish to try are:

■ White (255, 255, 255)
■ Antique White (247, 247, 242)
■ Cream (246, 247, 224)
■ Parchment (235, 224, 200)
■ Pink (255, 220, 230)
■ Sky Blue (200, 232, 247)

3D View 2D View Block View 

Set the grid lines

Measure a distance

Show & fade the background

Remove the background Change the view mode

Set the thread number, cross & design size

View the Design Panel



mySewnet™ Cross Stitcher   Viewing Cross Stitch Designs              53

■ Christmas Red (250, 50, 50)
■ Christmas Green (0, 160, 0)
■ Navy Blue (0, 0, 110)
■ Black (30, 30, 30)

Follow the instructions in mySewnet™ Configure and select the RGB values in the Colors 
dialog box.

The RGB values are approximations of the fabric colors only. Remember that changing the background 
color will affect all mySewnet™ Embroidery Software modules.

Shortcuts
■ View Tab: 
■ Keys: Alt, V, 3

2D
Use 2D  to display the design on a plain background with the 
stitches drawn in 2D.

Shortcuts

■ View Tab: 
■ Keys: Alt, V, 2

Block
Use Block  to display the design on a plain background with 
the crosses drawn as blocks.

Shortcuts

■ View Tab: 
■ Keys: Alt, V, B

Background
Use Background to show or hide the background picture. It is useful to hide the 
background picture occasionally so that it is easier to see the stitches in the design.

Use the Background slider bar to show the background picture as On, Off, or faded.

Background On  shows the 
picture in the background.

Click and drag the slider to fade 
the colors in the background 

picture (here by 50%).

Background Off  hides the 
picture. 



54          mySewnet™ Cross Stitcher   Viewing Cross Stitch Designs 

Fade Background
Use the Fade background slider to vary the brightness of 
the background picture. Background On  shows the 
background at full brightness. Use the slider to fade  the 
background to make it easier to see the design. Use Background Off  to hide the 
background and see only the design.

Remove Background
Use Remove Background  to remove the background picture from a cross stitch design.

Click Remove Background  and the picture will be removed from the design area.

Shortcuts
■ View Tab: 
■ Keys: Alt, V, R

Grid
Use the Grid functions to switch the grid on and off. Use No Grid , Grid Every Line , 
Grid Every 5 Lines , or Grid Every 10 Lines .

A standard Full Cross fills one grid square. A Mini Cross fits one quarter of a grid square. 
Standard Backstitch exactly fits one side or the diagonal of a grid square. Freehand 
Backstitch can be any length, but the ends snap to half grid spacing. French knots snap to 
half grid spacing..

Use mySewnet™ Configure to change the color of the grid.

Shortcuts

Every Line Every 5 Lines Every 10 Lines No Grid 

Every Line View Tab: Keys: Alt, V, EL

Every 5 Lines View Tab: Keys: Alt, V, E5

Every 10 Lines View Tab: Keys: Alt, V, E1

No Grid View Tab: Keys: Alt, V, H
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Get Length
Use Get Length  to measure the distance between any two points on a design. 

Click the Get Length icon  and the mouse pointer changes to the Measure pointer . 
Then click and drag a line across the design. The length of the line is displayed. Right-click 
to deselect.

The length is shown in millimeters or inches, according to the setting for Show Measurements in 
mySewnet™ Configure. The alternative units are shown in parentheses.

Shortcuts
■ View Tab: 
■ Keys: Alt, V, G

Using Get Length
1 In the View tab, click the Get Length icon . The pointer 

changes to the measure pointer .
2 Click and drag across the part of a design you want to 

measure. The length of the line you are measuring is 
displayed.

3 Repeat the click and drag to measure any other distances, as 
required.

4 Right-click to deselect the function.

Design Information
The dimensions (Height  and Width ), Stitch Count , and number of colors  for 
the active embroidery are shown on the Design Panel.

Notes Area
Store up to 2000 characters of notes about a design, such as a description, keywords or 
category. This information is shown in the Notes area of the Design Panel. Click Edit  to 
open the Notes dialog box.

To keep the Notes information, Export your cross stitch designs as file type Husqvarna Viking / Pfaff (.vp4, 
.vp3 or .vip).
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Notes
Click Edit  to change the Notes for the currently 
selected design. The Notes dialog will appear.

The Notes dialog allows free text and keywords to be 
added to the Notes for the selected design. Type 
additional Notes in the Notes box.

Use Ctrl+Enter to start a new line of text.

Up to 2000 characters can be entered in the Notes.

Keywords
Select Keywords for the embroidery from the list, then 
click Add to add them to the Notes for the embroidery.

Change the Notes for a Design
1 Open the design for which you want to amend the notes.
2 Click Edit .
3 In the Notes text box make your desired changes to the Notes.

Use Ctrl+Enter to start a new line of text.
4 To add Keywords, select the keyword from the category heading or subcategory in the scrolling list. 

Then click Add.
Double-click to expand the folders until the desired keyword is highlighted. (Alternatively click on the + 
sign.)

5 Click OK to save your amended Notes and added keywords.

Zoom Commands
A number of functions are available to make it easier to navigate around designs, 
including the Zoom functions. By default, the design is shown at a size so that it fills the 
window, the same as Zoom To Fit.

You can also change the view of a design by using Hide Colors to select the colors and stitch types to see.

Shortcuts

Zoom To Rectangle Keys: Ctrl + 0

Zoom To Fit Keys: Ctrl + 9

Zoom Out Keys: Ctrl + -

Zoom In Keys: Ctrl + =

Click and drag to zoom in on an area

Zoom to Fit
Drag to zoom in and out

Click to zoom in instantlyClick to zoom out instantly

Select or input percentage zoom
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Zoom To Rectangle
Use Zoom To Rectangle  to enlarge the view of an area of the 
design.

Click the Zoom To Rectangle  icon to the right of the status bar, 
and the mouse pointer changes to the zoom in pointer . Then 
either click a point on the design you want to zoom in towards, or 
click and drag a rectangle around the area you want to zoom in to 
and release the mouse button or lift the pen to zoom.

Zoom To Rectangle is automatically deselected after you have used 
it.

Shortcuts
■ Status Bar: 
■ Keys: Ctrl + 0

If you have a wheel mouse, hold the Ctrl key and move the wheel to zoom.

Pan Mode
Use the Pan feature to move around the screen easily. The Pan feature works when you are 
zoomed in on part of the screen, making the scroll bars visible at the right and bottom of 
the work area. 

Hold the Space key down, then start to click and drag. The pan pointer  appears. Click 
and drag until the pointer is in the desired part of the screen.

The pan occurs in real time, that is you see the work area move as you drag across the 
screen.

Pan Around the Work Area
1 Click Zoom To Rectangle  and the arrow pointer changes to the zoom in pointer .
2 Click and drag to draw a box, then release to zoom in. Scroll bars appear to allow you to move around 

the screen at this higher zoom level.
3 Hold the Space key down, then start to click and drag. The pan cursor  appears.
4 Click and drag until the pointer is in the desired part of the screen. (If you have a wheel mouse, you 

can click the wheel to pan around the screen.)
5 Lift the pen or release the mouse button.

Zoom To Fit
Use Zoom To Fit  to view the whole design area. Click the Zoom To Fit icon and the view 
will zoom in or out to show the design area in the window.

If the window is very small then Zoom To Fit will zoom out as far as possible, which may not necessarily fit 
the whole design area in the window.
If the design area is very large, the zoom level may be set to the minimum zoom level. At the minimum 
zoom level, the grid, 3D fabric and background picture are not shown, so the screen may appear to be 
blank if there are no stitches in the design. Also, the stitch tools will be unavailable. Zoom in to see the grid 
and background picture and use the stitch tools.
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Shortcuts
■ Status Bar: 
■ Keys: Ctrl + 9

Zoom By Percentage
Use the drop-down list in the Status Bar to set percentage levels to zoom in for the active 
embroidery, from 25% up to 800%. Alternatively, enter a number in the percentage text 
box.

Select 100% to display the design at a magnification as close as possible to the Real Size setting you chose 
in mySewnet™ Configure.

Shortcuts
Keys: 100%: Ctrl + 1

200%: Ctrl + 2
400%: Ctrl + 3
800%: Ctrl + 4
75%: Ctrl + 5
50%: Ctrl + 6
25%: Ctrl + 7

Zoom Bar
Use the Zoom Bar to zoom in or out from the center of the currently selected picture or 
embroidery.

The Zoom Bar is on the right side of the Status Bar.

Use the slider to zoom in or out of the picture or embroidery, or click on the Zoom In  or 
Zoom Out  icons to increase or decrease magnification 10% at a time.
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Design Player
Use Design Player  to play through the stitches in the embroidery as if they were being 
stitched from an exported embroidery. All parts of the embroidery are shown, whether or 
not they are selected. 

The current Optimize for Sewing settings from mySewnet™ Configure are used.

Share
Use Share  to save a picture or video of your design.

Shortcuts
■ Home Tab: 
■ Keys: Alt, 9; Alt, H, J;

Using the Design Player
1 Click New , and in the Design Options page of the Cross Stitch Design Wizard select Load Existing 

Cross Stitch Design, then click Next. 
2 In the Open Existing Design page, click Load a Design  and browse to 

Documents\mySewnet\Samples\Cross Stitch\Krz\.
3 Scroll down to "My Sampler.krz", then click Finish to load the design into the work area.
4 In the Quick Access toolbar, click Design Player .The Design Player dialog opens.
5 Use the Play button  at the bottom left to start playing through the stitches in the design.
6 Use the controls to play forwards or backwards through the embroidery at different speeds, jump to 

the start or end of the stitches, and stop at any time.
Press Ctrl and use the mouse wheel to zoom in and out.

7 Use Share  to save a picture or video of your design. 

Start or pause play

Control play with
the slider

Design Information

Jump to the first stitch

Jump to the last stitch
Rewind

Play at double the
current speed
Share a picture or video 
online
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Life View 
Use Life View  to show how an embroidery exported from the project will look in 3D 
with real-world perspective. Zoom in to see detail, and move and rotate the embroidery in 
a three-dimensional view. All parts of the embroidery that are within the design area are 
shown, whether or not they are selected. 

Use Life View  at any time when you want to see the design with no grid, stitches 
selected, or markers displayed, and when you want to see the effects of glow in the dark 
and solar reactive threads.

Shortcuts
■ Home Tab: 
■ Keys: Alt, 8; Alt, H, L

Position
Use the position  slider to move to another part of the Life View window.

Click and drag the cross marker in the center of the box to view the desired part of the 
embroidery, using the zoom slider to control the magnification.

Rotation
Use the rotation  slider to view the stitching in the embroidery in three dimensions.

Click and drag the cross marker in the center of the box to change the angle at which the 
embroidery is viewed, and allow you to visualize the project in varying real-world views.

Alternatively, click and drag directly in the embroidery preview area to change the angle of view.
Use the zoom and position sliders to select the part of the embroidery to view.

Design Information

Move around the window

Change the 3D viewing angle

Zoom in and out

Light and dark effects
Reset
Animate the preview
Share a picture or video online
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Zoom
Use the zoom slider to change the magnification of the embroidery. Drag the slider bar to 
the right to magnify the view of the embroidery, and to the left to shrink the view of the 
embroidery. The box below the zoom bar displays the current magnification. 

Click the marker in the center of the zoom bar (100%) to view the embroidery at a 
magnification as close as possible to the Real Size setting you chose in mySewnet™ 
Configure.

When zoomed in, use the position slider to move around the embroidery.

Design Information
Life View shows the dimensions (Width  and Height ), the number of stitches  and 
the number of colors  in the embroidery.

Glow in the Dark
Use Glow in the Dark  to view the effect of using glow in the 
dark threads. The preview will darken to simulate the lights 
dimming, and the glow in the dark threads will be shown in their 
luminescent colors.

Glow in the Dark  is only available if glow in the dark thread colors are 
used in the design.

Solar Reactive
Use Solar Reactive  to view the effect of using photochromic threads. The preview 
simulates the sun shining on the design, and the photochromic threads change shade to 
show the colors they become in sunlight.

Solar Reactive  is only available if photochromic thread colors are used in the design.

Play Demo
Use Play Demo  to animate the preview and show the embroidery at different angles 
automatically. Click to start and stop the animation.

Photochromic threads change color in sunlight.
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Play My Demo
Use Play My Demo  to animate the preview using your own demo. 
Use the menu options to add the current position as a point in the 
demo, or reset to create a new demo.

The My Demo animation will be used for Life View in all modules. It is stored in the 
AnimationPath.txt file in the 
\User\AppData\Local\VSMSoftware\mySewnet\Embroidery1\LifeView folder.

Copy this file to another location as a backup before creating additional My Demo animation paths for 
Life View.

Reset
Use Reset  to set Rotation, Position and Zoom back to the default settings.

Share
Use Share  to save or share a picture or video of your design.

Share Picture
Save a picture of your design. Select a size for the picture, 
then save the picture to your computer. A progress bar 
shows during the upload.

Size
Select a size for your picture. Choose from Standard, 2x, 3x, 
and 4x. Standard size is the size of the picture in Design 
Player or Life View.

Save
Click Save  to save the picture to your computer. The Save As dialog appears for you to 
save the picture, with the default file name being the same as the design. Change the 
name as desired.

The following file formats may be saved: JPEG Low Quality (.jpg), JPEG High Quality (.jpg), 
Tagged Image File Format uncompressed (.tif ) and Portable Network Graphics (.png).
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Share Video
Save a video of your design. Name the video and select its size, quality and speed. Then 
save it to your computer. A progress bar is displayed while the video is created.

The higher the image quality, the slower the speed of upload and download.

Video Title and Created By
The video title and the name of the creator are used on the opening frames of the video. 
Enter the name of the video, and the name of the creator.

Size
The size of the moving image in pixels. The higher numbers create a higher quality video. 
Choose from 1080p (HD), 720p (HD), 480p and 360p. The initial setting is 480p.

Quality
The bit rate, or speed of data transfer. Choose between Low, Medium and High. The initial 
setting is Medium.

Speed
Set the speed of the Design Player for the video. Choose from Standard, 2x, 4x, 8x, 16x, 
32x, 64x, and 128x. The initial speed is 16x.

This option is only available for videos created from Design Player.

Video Information
The Total Duration of the video in minutes and seconds, and the estimated file size in MB 
are displayed. The duration and size vary according to the Size, Quality and Speed of the 
video.

File Name
Select a folder and name for the video file. Click Select to browse to a different folder on 
your computer.
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Start and Cancel
Click Start to create your video, using the settings that you chose above. A progress bar 
shows during the creation of the video, with an estimate of the creation time. Click Cancel 
to stop the video creation.

All other functions in the dialog box are unavailable (grayed out) during video creation.

Example
Create Cross Stitch and Embroidery Files for a Photo Design

1 Use the design you created in “Create a Cross Stitch from a Photograph” on page 46.

Alternatively, use New  or Open  to load Documents\mySewnet\Samples\Cross 
Stitch\Krz\Linnet.krz.

2 Use Life View  to view the design at the size it will be stitched.
3 In the Home tab, click Design Properties. In the Design Properties dialog box ensure Thread Count, 

Crosses is set to Single (2 Threads). Click OK.
4 Cllck Edit Notes  and in the Notes dialog box type 'Family Photo'. Click OK.
5 In the Quick Access toolbar, click Save As  and the Save As dialog box appears.
6 In the Save In box, browse to the folder Documents\mySewnet\My Designs. In the File Name box, 

leave the name as 'Linnet', as set by the picture name. Click Save.
This will save your design as a cross stitch design (.krz) file.

7 In the Quick Access toolbar, click Export  and the Export dialog box appears.
8 In the File Format drop-down list, ensure .vp4 is selected. 
9 Click OK. The Save As dialog box appears to save the embroidery.
10 In the Save In box, browse to the folder Documents\mySewnet\My Designs. In the File Name box, 

ensure the name is 'LinnetExported', then click Export.
To print a worksheet for this design, see “Print a Worksheet for an Embroidery” on page 134.
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5Choosing and Changing 
Thread Colors

Design Panel
The Design panel shows the design information, the Color Select area, and the tools used 
to add, change, move, merge and delete colors in the design. Set the thread count and 
direction for a thread color, and add notes to the design.

Show Design Panel
To open the Design Panel, click Show Design Panel  in the View tab.

Thread Colors
The Color Select area in the Design Panel shows the thread colors that are immediately 
available for drawing stitches in the design. The group of stitches using a particular thread 
color is called a color block. Not all colors in the color worksheet may have been used in 
the design. However, all colors that are used by the design will appear in the worksheet. 

The Color Select area can be used to change thread colors and to hide and show the 
stitches in any of the color blocks. The first color in the design is at the top of the list, 

Check the design information

Selected thread color

Add or change the notes for the design

Add or pick a color

Set the thread count or direction

Change, move, merge or delete a color
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followed by all the thread color blocks. The numbers show the order in which the colors 
are used, and the samples show solid blocks of each thread color in 3D.

There can be up to 255 color changes in a cross stitch design saved in .krz format. 

Designs converted from a picture in the Cross Stitch Design Wizard have an initial palette according to the 
thread range and colors chosen in the wizard.

Colors can be added or changed to any color available in the standard thread ranges, and 
an unlimited number of My Threads ranges. My Threads ranges, created in mySewnet™ 
Thread Cache, can contain threads copied from the standard thread ranges, plus custom 
threads based on existing threads or added as completely new threads.

Colors are added automatically when designs, shapes or lettering are inserted using thread colors that are 
not already in the palette. You can also change or add a color when selecting colors for stitch types in the 
Create tab. See “Select a Color in the Pop-up Palette” on page 80 and “Add a Color to the Pop-up Palette” on 
page 81.
New blank designs, including new designs that have a background picture but no crosses, 
start with a single color. Not all colors in the color worksheet may have been used in the 
design.

The order of colors in the Color Select area controls the stitch order when an embroidery is 
created. All crosses are created first, in the color order set in the Color Select area. After the 
crosses, stitches are created for backstitch and French knots. The first color is at the top of 
the list. The numbers show the order in which the colors are used to create each layer of 
stitches, and the samples show solid blocks of each thread color in 3D. 

Thread color effects such as puffy foam and special needles such as twin or wing needles are not available 
in mySewnet™ Cross Stitcher. To use such color effects, export your design and open it in mySewnet™ 
Embroidery.
To change a thread color in a design, click the thread color in the Color Select area and 
then click Change Color , or double-click the thread color. The Color Selection Dialog 
box opens. All stitches using that color will be changed.

Hidden Visible

Click a color to select it

Merge with color above

Pause over a thread 

Display or hide a color

Move a color down or up the stitch order

color to see its name

Change a color
Delete color

Set thread count or direction

Number of threads
Top thread direction

Pick a color from the picture

Add a color to the palette 
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To add a color to the design, click Add Color  and select a new color from the Color 
Selection dialog box.

Color Selection
The Color Selection dialog box is used to change existing colors or add new colors. Colors 
can be changed directly from the Color Select in the Design panel with Change Color  
or by double-clicking, or added with the Add Color icon .

You may choose any thread shade from the available thread manufacturers' palettes (for 
instance, Sulky Rayon 40 or Robison-Anton Cotton 50) or a thread you have added to My 
Threads. Select colors by visual selection or by typing in a shade number. Alternatively, 
click one of the Quick Colors to select the nearest matching thread color. Once the desired 
color is selected, click OK.

Change a Color
1 Click a color you wish to change in the color worksheet, or click the Add Color icon . The Color 

Selection dialog box will appear.
2 If required, change the thread range. Select the desired thread range from all thread ranges or only 

MyThreadRanges. The available shades for the thread range will be shown in the list.
The Abbreviation shows the reference used for the thread range when threads from that range are added 
to MyThreads.

3 Click a color in the list to select a thread shade visually. Use the scroll bar to browse through the list of 
threads.

4 If you know the shade number, click in the Find Thread box then type the required shade number.
5 Alternatively, choose a Quick Color Theme then click the desired Quick Color. The nearest shade that 

is available from the current thread range will be selected. This is also a quick way to jump to threads 
of that color (for example, click yellow in the Standard Theme to jump to yellow thread shades).

6 Click OK to confirm the color selection.
Click Manage to manage your threads in mySewnet™ Thread Cache.

Select a thread range

Show favorite thread ranges
Show all thread ranges

Search for a thread number

Click a thread color
to select a thread

View the thread information

Click in QuickColors to select the
nearest matching thread color

Choose a QuickColor Theme

Open Thread Cache
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Thread Colors in mySewnet™ Cross Stitcher
The thread type and number of colors in a thread does not affect the display on the 
mySewnet™ Cross Stitcher screen. All thread types are displayed the same as rayon 
threads. The stitches in variegated threads only use the first color in the thread.

Thread color effects such as puffy foam and special needles such as twin or wing needles are not available 
in mySewnet™ Cross Stitcher. To use such color effects, export your design and open it in mySewnet™ 
Embroidery.

Colors Dialog
The Colors dialog box is used to choose or change 
a color for a thread or fabric, or modify any color in 
a Quick Colors Custom theme.

When the Colors dialog box appears, it shows the 
Standard color selection. If desired, click one of 
the Standard colors. A highlight shows the 
selected color. The New/Current box shows the 
difference between the newly chosen color and 
the color currently used.

Click the Custom tab to be able to select any of 
the 16 million RGB colors.

Click in the blended color palette to choose a 
basic color, then use the slider at the side to 
choose the desired brightness level. The HSL and 
RGB values are updated as you change the color 
and the color is previewed in the New/Current 
box.

You can also directly enter Hue, Sat(uration), 
Lum(inance) (HSL) and/or Red, Green, Blue (RGB) 
values. Alternatively, use the up/down buttons on 
each of the HSL and RGB value boxes to make fine 
adjustments to the color.

Color Models

Hue, Saturation, Luminance (HSL) Color Model
Hue is the color (red, yellow, green, or blue) for the selected color, expressed as a value 
between 0 and 239. Saturation (Sat) is the strength or purity of color in a specified hue. 
This is related to the amount of gray in it and is measured from 0 (completely gray) up to a 
maximum of 240 (no gray). The higher the saturation, the purer or more vivid the color. 
Luminosity (Lum) is the intensity of lightness or darkness in a color, specified by a value 
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between 0 (black) and 240 (white). If Saturation is 0, the Luminosity setting specifies a 
shade of gray.

Red, Green, Blue (RGB) Color Model
The RGB model, one of the Additive Color models, is used on computer monitors. It has 
three primary colors — red, green, and blue — that it creates by emitting light. These 
three colors are combined in various proportions to produce all the colors displayed on 
your screen. They are referred to as additive because they combine to produce white. 
Primary colors are measured as a value from 0-255. The colors produced by combining the 
three primaries are a result of the amount of each of those shades present. For example, 
pure red has a red value of 255, a green value of 0, and a blue value of 0. Yellow has a red 
value of 255, a green value of 255, and a blue value of 0. If Red, Green and Blue are set to 
zero, the color is black; if all three are 255, they produce white.

Move, Merge and Delete Color Blocks
Use the arrows below the color worksheet to change the order (  and ) of the color 
blocks, and to select color blocks to merge  together selectively. For example, you can 
keep two adjacent identical color blocks in case you wish to vary them later.

Note: This may be useful if you want to merge two blocks of an identical thread color 
without affecting the color order of the rest of the design.

To select and change colors, see “Color Selection” on page 67.

Move and Merge Colors in the Worksheet
1 Select a color block in the worksheet to highlight it.
1 Click the Move Color Up arrow  button below the worksheet to move the block up the stitching 

order.
2 Click the Move Color Down arrow  button below the worksheet to move the block down the 

stitching order.
3 Click the Merge Colors  arrow button below the worksheet to combine the selected color block 

with the block above it.
Use Merge Colors to delete color changes easily. Also use it to combine color blocks with the same thread 
color, after first moving one of the color blocks so that they are adjacent.

4 Use Delete Color  to remove the selected color, and all stitches using it, from the design.

Color Order Considerations
The order of colors in the Color Select also controls the order of colors in the finished 
embroidery. While you are creating your cross stitch design, new colors are added when 
other designs are inserted or when you use shapes, patterns and text. Hence, the order of 
colors may not be the best order for stitching out when taking into consideration which 
areas may 'pull in' the most or which colors are on top for stitching out backstitch and 
French knots.

Stitch Pulling
Generally, the largest area of stitches (usually crosses) will pull the most. The effect of this 
can be avoided by stitching the largest area first. So it may help to move the color with the 
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most stitches to the top of the palette. You can check the stitch counts in the Design 
Information, and by printing the embroidery worksheet.

Alternatively, change the color order so that the design stitches from the inside out. This is 
effective when stitching designs that have complete cross coverage, such as designs 
created with the Cross Stitch Design Wizard.

Backstitch and French Knots
Backstitch and French knots are stitched out together in each color, after all the crosses 
have been stitched. However, backstitch is stitched before French knots. If you are using 
French knots for decorative details on top of any backstitch in a different color, move the 
colors in the palette to ensure that the French knot color is stitched out after the 
backstitch color.

Pick Color
Use Pick Color  to choose a color directly from the design or picture. 

Click the Pick Color icon and the pointer changes to an eyedropper . Click on a stitch or 
the background picture to select a color. Pick Color is automatically deactivated after a 
color has been chosen.

Select a thread color in the Create tab to choose a thread color for drawing crosses. See “Drawing Stitches” 
on page 80.

Shortcut
■ Design Panel: 

Locate a Color in the Design
1 In the Design window, click the Pick Color button  and the pointer changes to an eyedropper .
2 Move the eyedropper pointer over the design.
3 Click on a stitch or the background picture.

If you clicked on a stitch, the thread color is selected in the Color Select area.
If you clicked on the picture, the Color Selection dialog box opens with a thread of that color selected 
from the chosen Thread Range.
Pick Color is automatically deactivated after a color has been chosen.

Add Color
Use Add Color  to add a new thread color to the Color Select in the Design panel.

Click Add Color  and the Color Selection dialog box appears. Select the desired thread 
color and click OK. The color will be added to the end of the worksheet. To move the color 
within the worksheet, use the Move and Merge buttons.

Use the pop-up palette to select the color for drawing. See “Pop-up Palette” on page 80.

Shortcut
■ Design Panel: 
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Hide and Show Stitches
Hide Crosses
The Hide Crosses  button is used to hide all types of crosses in the design area.

Shortcuts

■ Home Tab: 
■ Keys: Alt, H, HC

Hide Backstitch
The Hide Backstitch  button is used to hide all types of backstitch in the design area.

Shortcuts

■ Home Tab: 
■ Keys: Alt, H, HB

Hide Knots
The Hide Knots  button is used to hide French Knots in the design area.

Shortcuts

■ Home Tab: 
■ Keys: Alt, H, HH

Display All
Display All  displays all stitches in the active design.

When stitches have been hidden by changing the color selection or using the Hide tools, 
click the button to view all stitches again. All the color blocks become visible.

Shortcuts

■ Home Tab: 
■ Keys: Alt, H, R

Design Properties 
Use the Design Properties dialog to set the cross size, the design size, the number of 
threads, and to set the direction of the top thread for crosses.
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Shortcuts
■ Home Tab; View Tab
■ Keys: Ctrl + D; Alt, H, DP; Alt, V, D

Cross Size
Set the Cross Size for the design from 1.0mm to 30.0mm in steps of 0.1mm.

Hand Cross Stitch Sizes
To create cross stitch designs at the same sizes as real counted fabrics, set the Cross Size as 
shown:

Select Hoop
Click Select Hoop to choose a hoop in the Hoop Selection dialog. The new design area will 
be a best fit to the selected hoop, with the current Cross Size. See “Hoop Selection” on 
page 39.

Width and Height
Set the Width and Height in crosses (grid squares) for the design from 5 to 400.

When the Width and Height are increased, grid squares are added to the edges of the 
design. When the Width and Height are reduced, grid squares are removed from the 
edges of the design.

Set the size of the crosses in the design
Choose a hoop as a guide to the design size

Set the width and height of the design

Set the number of threads used
for crosses and backstitch

Set the direction for the cross top thread

Use these settings for all new designs

Aida Count Cross Size

11 2.3mm (0.091")

14 1.8mm (0.071")

16 (also 32 on Linen) 1.6mm (0.063")

18 1.4mm (0.055")

22 1.2mm (0.047")
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Stitches at the edges of a design may be lost when the design size is reduced. Any freehand backstitch that 
has an end point outside the new design size is removed.

Design Area
This is the size of the whole design area, which is the Width x Cross Size and Height x Cross 
Size. This is shown in millimeters or inches, according to the setting in mySewnet™ 
Configure.

Thread Count
Change the number of threads used for crosses and backstitch throughout the design, 
and the top thread direction for crosses.

Note: To make new settings the default settings for all new designs, click Set As Default.

Crosses
Change the number of threads used to stitch out crosses in the design. Click the drop-
down arrow and select the desired number of cross threads. 

Increasing the number of threads will increase the stitch count in the final embroidery.
This is initially set to Single (2 Threads).

Use Single for small cross sizes. Increase the number of Cross Threads at larger cross sizes 
to give different density effects.

• Change the number of threads used for individual design colors in Color Properties.
• The number of cross threads does not affect the display of crosses on the mySewnet™ 

Cross Stitcher screen.

Backstitch
Change the number of threads used to stitch out backstitch in the design. Click the drop-
down arrow and select the desired number of backstitch threads.

Increasing the number of threads will increase the stitch count in the final embroidery.
This is initially set to Single (2 Threads).

• Change the number of threads used for individual design colors in Color Properties.
• The number of backstitch threads does not affect the display of backstitch on the 

mySewnet™ Cross Stitcher screen.

Top Thread Direction
Change the direction of the top thread for crosses in the design. Select Forward or 
Backward from the drop-down menu.

Single, Double and Triple
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This corresponds to the half of the stitch that would be placed by Half Cross Backward or Half Cross 
Forward respectively.

Use this to change the texture, with light reflecting differently off the threads than for the 
standard crosses. Top Thread Direction is initially set to Backward.

• Change the top thread direction used for individual thread colors in Color Properties.
• The top thread direction does not affect the display of crosses on the mySewnet™ Cross 

Stitcher screen.

Set as Default
After adjusting the design properties in this dialog, click Set As Default to use these 
settings for all new designs.

Color Properties
Use Color Properties  to to set the number of threads and the top thread direction for 
the selected color.

In the Design Panel, select the desired color in the Color Select area, then click the Color 
Properties  button.

Changes in the Color Properties dialog are only applied to the design when you click OK. If you click Cancel, 
all the current changes are lost.

Shortcut

■ Design Panel: 

Backward on top Forward on top

Set the number of threads used for the color
Set the Top Thread direction for the color

Default properties for the current design
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Thread Count
The Thread Count is the number of strands of thread used to stitch crosses and backstitch. 
This is normally Single (2 Threads).

All palette colors in a new design initially have their thread count set to the Design 
Default, as set in Design Properties. Use this setting to override the design default. When 
this is changed, it affects the thread count for both crosses and backstitch in the chosen 
palette color.

Click a color in the Color Select area, then in the Color Properties dialog box click the drop-
down arrow for Thread Count and select the desired option.

• Single would normally be used for a design Cross Size less than 2mm, with occasional 
use of Double for emphasis. 

• Triple and greater thread counts should only be used when the Cross Size is large and 
the extra thread count is needed for coverage.

Changes to thread count are not visible on the mySewnet™ Cross Stitcher screen. Increasing the number of 
threads will increase the stitch count in the embroidery, which can be seen in the stitch count in the Design 
Information, and using the Design Player and Life View.

Top Thread Direction
The Top Thread Direction affects which part of a cross is on top.

All colors in a new design initially have their top thread direction set to the Design Default, 
as set in Design Properties. Use this setting to override the design default. When this is 
changed, it affects full, mini, half width and half height crosses in the chosen color.

Remove Unused Colors
Use Remove Unused Colors  to delete any thread colors that do not have stitches in the 
design. This is useful, for example, if you have a lot of similar shades in the palette and you 
wish to ensure you continue to use only those colors that have already been used.

Unused colors are ignored by the print function, Design Player and Life View. Therefore, it is not vital to 
remove unused colors before using these functions.

Shortcuts

■ Home Tab: 
■ Keys: Alt, H, U

Remove Unused Colors From the Happy House Cross Stitch
1 In mySewnet™ Cross Stitcher , select File, New  to start the Cross Stitch Design Wizard, select 

Load Existing Cross Stitch Design, and click Next. in the Open Existing Design page click Load a 
Design  and load Documents\mySewnet\Samples\Cross Stitch\Krz\Happy House Extra Colors.krz. 
Click OK, then click Finish.
Alternatively, use the design you created in “Add Designs to the Happy House Sampler” on page 25.
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2 In the Home tab, click Remove Unused Colors . The initial thread 
color is removed, and the color list is reduced to the colors used in the 
design. 

3 Look at the Color Select area in the Design Panel, and move the mouse 
pointer over the threads.
Notice that there are some Sulky Rayon 40 colors from the inserted 
Small House design that are similar to Robison-Anton Rayon 40 colors 
used in the rest of the design. To make the design stitch out more 
efficiently, some of the similar colors can be replaced.

4 In the color list, click Sulky Rayon 40 1005 Black (number 10 in the list), 
then click Change Color . The Color Selection dialog box appears.

5 In the Thread Range drop-down menu, choose Robison-Anton Rayon 
40. The color changes to Robison-Anton Rayon 40 2296 Black. Click OK.

6 In the color list, click Sulky Rayon 40 1066 Primrose (number 13 in the 
list), then click Change Color . The Color Selection dialog box 
appears.

7 In the Thread Range drop-down menu, choose Robison-Anton Rayon 
40. The color changes to Robison-Anton Rayon 40 2461 Wheat. Click 
OK.

8 Click Sulky Rayon 40 1187 Mimosa Yellow (number 16 in the list), then 
click Move Color Down  until it is below Sulky Rayon 40 569 Garden 
Green.
This is to ensure that the French knots that make the yellow flower heads 
in the house garden are stitched after the green backstitch stalks.

9 Click Sulky Rayon 40 1187 Mimosa Yellow (now number 17 in the list), 
then click Change Color . In the Color Selection dialog box, select 
Robison-Anton Rayon 40 as the Thread Range, and then enter 2326 in the Find Thread box (Robison-
Anton Rayon 40 2326 Daffodil). Click OK.

10 Click Sulky Rayon 40 1246 Orange Flame (number 11 in the list), then click Change Color . In the 
Color Selection dialog box, select Robison-Anton Rayon 40 as the Thread Range, and then enter 2378 
in the Find Thread box (Robison-Anton Rayon 40 2378 Red). Click OK.

11 Click Edit Notes  on the Design Panel.
12 In the Notes text box in the Notes dialog box enter 'Happy House Sampler', then click OK to save the 

notes.
13 In the Quick Access toolbar, click Save As  and the Save As dialog box appears.
14 In the Save As dialog, change the folder to Documents\mySewnet\My Designs if necessary. Enter the 

file name 'Happy House' and click Save.
15 In the Quick Access toolbar, click Export . The Export dialog box appears.
16 In the Export dialog select .vp4 as the embroidery format and click OK. The Save As dialog box 

appears.
17 In the Save As dialog box, in the Save In box browse to the folder Documents\mySewnet\My Designs. 

In the File Name box, leave the name as 'Happy HouseExported', then click Export.
18 In the Quick Access toolbar, click Print  and the Print dialog box appears. Click OK to print a 

worksheet for the embroidery.

Quick Color Themes
Use Quick Color Themes for quick selection of thread colors using a related set of colors. 
Create your own Quick Color Themes, which are available for selecting thread colors in the 
Color Selection dialog box in most mySewnet™ Embroidery Software modules. Also use 
Quick Color Themes to set fabric colors in the Appliqué Selection dialog box.
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Select a Quick Color
1 Open a dialog box with the Quick Colors area, such as the Color 

Selection box.
2 Click the arrow to the right of the Quick Colors to choose a Quick Color 

Theme in the menu.
In this menu you can also select Edit Themes to create a new theme, or 
edit a Custom theme.

3 Click the desired Quick Color. The nearest shade that is available from 
the current thread range will be selected. 
This is also a quick way to jump to threads of that color (for example, click light yellow in the Standard 
Theme to jump to light yellow thread shades).

Add a Quick Color Theme
You can add or customize your own Quick Colors themes in the Color Selection or the 
Appliqué Selection dialog box in most mySewnet™ Embroidery Software modules.

1 Open a dialog box with the Quick Colors area, such as the Color Selection box.
2 Click the arrow to the right of the Quick Colors and select Edit Themes in the menu. The Edit Quick 

Color Themes dialog box opens.
Note that if one of the system Themes is selected, the editing options will be unavailable (grayed out).

3 Select a Theme from the drop-down menu at the top.
Your new Theme will be based on the colors in this theme.

Select a Theme

Delete a custom ThemeCreate a new custom Theme

Give your Theme a name

Choose a color block to edit
Edit the selected color

Apply your changes
Color sample box

Copy a color to the sample box
Paste the sample box color

Replace all colors with the
sample box color
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4 Click the Add New button. A new theme ’Untitled’ appears.
5 Give your new theme a name, then click Apply. 

You can now select your new theme from the drop-down list at 
the top.

6 Select a color in the palette.
7 Click the Edit Color button. The Colors dialog box appears.
8 Choose a new color from the Standard or Custom tab, then click 

OK. Your chosen color will replace the original color.
9 To copy a color, select a color in the palette, then click Copy 

Color. Your selected color will appear in the Color Box.
10 To paste the color in the Color Box, select a color in the palette, 

then click Paste Color. The color in the palette will be replaced.
11 To replace all colors in the palette, click Paste To All.
12 Click Apply to save the changes to your new Quick Color 

Theme.
13 Click Close to finish editing your new Theme.

To make further edits to your theme, select Edit Themes in the Quick Colors Theme menu.

Edit Quick Color Themes

Theme
Select a Theme from the drop-down list. 

Any new Theme will be based on the colors in this theme.

Add New
Click Add New to create a new theme.

Delete Theme
Click Delete Theme to remove a custom Theme.

You cannot delete system Themes.

Name
Enter the desired theme name.

Theme Colors
Click a color in the grid and a box will appear around the selected 
color.

Edit Color
Click Edit Color to change the currently selected color in the Colors 
Dialog Box. Alternatively, double-click a color to change it in the Colors Dialog Box.

Apply
Click Apply to save the changes you have made.

Copy Color
Click Copy Color to place the color in the color sample box, to the right of the button.

Use the color sample box to copy a color from one theme to another.
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Paste Color
Click Paste Color to replace the color in the currently selected grid position with the color 
in the sample box.

Paste To All
Click Paste To All to place the color in the sample box in all the grid positions. This is useful 
when starting a new Theme if you wish to vary the Theme around a single initial color.

Close
Click Close to finish editing the new theme. The new theme is added to the end of the 
Theme list.

You will be asked if you want to save any changes you have made, if you have not clicked Apply.

Change a Quick Color Theme
Select an existing Quick Color Theme you wish to change from the Theme drop-down list, 
then click Edit Theme.

The predefined Quick Color Themes may not be edited. However, you may use any predefined theme as the 
basis for a new theme.
The options are the same as when you Add a Quick Color Theme. See “Edit Quick Color 
Themes” on page 78.

Delete a Quick Color Theme
1 In the Edit Quick Color Themes dialog box, use the Theme drop-down list to select the Theme you 

wish to remove. 
2 Click Delete Theme. A message will appear to remind you that this action may not be reversed. 
3 Click Yes and the theme will be deleted.

The predefined Quick Color Themes may not be deleted.
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6Creating Stitches and Shapes

Drawing Stitches
Draw stitches of the chosen type and color in the design area. The pointer shows which 
stitch type is selected, and the Thread Color shows the drawing color.

Pop-up Palette

Select a Color in the Pop-up Palette
1 Click the Create tab.
2 Click to select a stitch type.
3 In the Color section click the displayed thread color to open the pop-up color palette.
4 Click a color to select it for drawing. The palette closes.
5 Draw stitches on the design area.
6 Click Thread Color again to select a different color.

Pick Color
Use Pick Color  in the pop-up palette to pick a color from the background picture, or 
the design.

Pick a Color from the Picture or Design
1 In the pop-up palette, click the Pick Color  button and the pointer changes to an eyedropper . 
2 Move the eyedropper pointer over the design or picture.
3 Click on the desired color.

Draw Full, Half or Quarter Crosses

Choose a thread color for drawing
Erase stitches of the selected type

Draw Backstitch or French Knots
Draw a cross or pattern flood fill area

Select No Fill, Cross Fill or Pattern Fill
Select No Outline, Backstitch Outline or Cross Outline

Select a shape & draw it in the work area

Smooth the shape

Draw a Freehand or Point shape

Create Tab

Click to open the pop-up palette

Add a color to the pop-up palette from the Color Selection dialog
Pick a color from the background picture or the design

Click a color to select it for drawing
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If you clicked on an area in the picture, the Color Selection dialog opens. Select or change the color to 
add it to the palette.
If you clicked on a stitch, the thread color is selected in the pop-up palette.
Pick Color is automatically deactivated after a color has been chosen.

Add Color
Use Add Color  in the pop-up palette to add a new thread color to the palette and set it 
as the draw color.

You can also add a color when selecting colors in the Design panel. See “Add Color” on page 70.

Add a Color to the Pop-up Palette
1 In the pop-up palette, click Add Color  and the Color Selection dialog appears.
2 Select the desired thread color.
3 Click OK to close the dialog. 

The color is added to the end of the palette and is selected for drawing.

Erase
Use Erase  to erase stitches of the selected type. It can then be used to erase stitches 
when a stitch drawing function is selected. 

When a cross type is selected, it will erase crosses according to the size of the selected 
cross type. To erase Standard Backstitch , Freehand Backstitch  or French Knots , 
the corresponding draw function must be selected. Erase also works with Cross Flood 
Fill  to erase an area of connected crosses of the same color.

Shortcut
■ Create Tab: 
■ Keys: Alt, C, E

Erase Stitches in a Design
1 Open the Create tab.
2 Select the stitch type that you want to erase, for example Full Cross, Mini Cross, Standard Backstitch or 

French Knot.
Erase will remove stitches of the same type. Use any type of cross to remove any other type of cross, and use 
backstitch to remove backstitch.

3 Click Erase . The drawing pointer turns red.
The red color indicates that Erase is enabled.

4 Draw on the work area to erase stitches of the selected type.
5 Click Erase  again to deselect stitch removal.
6 Alternatively, right-click and drag to remove stitches. The red pointer color indicates when Erase is 

enabled.

Crosses
There are four types of crosses:

■ A Full Cross fills a whole grid square. Parts of a full cross (Quarter Cross, Half Cross Forward 
and Half Cross Backward) can be placed or removed for quarter, half and three-quarter 
crosses.

■ A Half Height Cross is a cross in the top or bottom half of a grid square.
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■ A Half Width Cross is a cross in the left or right half of a grid square.
■ A Mini Cross is a small cross in any corner of a grid square.

When drawing crosses, any type of cross can replace all or part of any other type of cross. 
The size of the currently selected cross type determines how much of a grid square will be 
replaced or erased.

Backstitch and French knots are not affected by drawing and erasing crosses.

Full Cross
Use Full Cross  to place full crosses  and erase whole grid squares of 
crosses. Use single-click to place or erase one at a time, or click and drag to 
draw continuously.

Shortcut
■ Create Tab: 
■ Keys: Alt, C, CF

Quarter Cross
Use Quarter Cross  to place quarters of a full cross  in the corners of 
grid squares, and erase quarters of grid squares. Use single-click to place or 
erase one at a time, or click and drag to draw continuously. A quarter cross is 
placed in the corner of a grid square nearest to the point where you click.

It may be useful to zoom in when working with quarter crosses.
If part of a half cross forward or half cross backward is replaced or erased, a quarter cross is 
left in the other part.

Shortcut
■ Create Tab: 
■ Keys: Alt, C, CQ

Half Cross Forward
Use Half Cross Forward  to place  and erase the forward half of a full 
cross. Use single-click to place or erase one at a time, or click and drag to 
draw continuously.

If part of a cross is replaced or erased, a half cross backward is left in the other 
part.

Shortcut
■ Create Tab: 
■ Keys: Alt, C, CR
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Half Cross Backward
Use Half Cross Backward  to place  and erase the backward half of a full 
cross. Use single-click to place or erase one at a time, or click and drag to 
draw continuously.

If part of a cross is replaced or erased, a half cross forward is left in the other 
part.

Shortcut
■ Create Tab: 
■ Keys: Alt, C, CB

Mini Cross
Use Mini Cross  to place  small crosses that occupy one quarter of a grid 
square, and erase quarters of grid squares. Mini crosses are sometimes called 
'petit point'. Use single-click to place or erase one at a time, or click and drag 
draw continuously. A mini cross is placed in the corner of a grid square 
nearest to the point where you click.

It may be useful to zoom in when working with mini crosses.
Up to four mini crosses can be placed in each grid square. It is not possible to place or 
erase part of a mini cross.

If part of a half height or half width cross is replaced or erased, a mini cross is left in the 
other part.

It is recommended to use a minimum Cross Size of 1.8mm for the design when using Mini 
Crosses. Use Design Properties to set the Cross Size used by the design.

Shortcut
■ Create Tab: 
■ Keys: Alt, C, CM



84          mySewnet™ Cross Stitcher   Creating Stitches and Shapes 

Half Width Cross
Use Half Width Cross  to place  small crosses that occupy the left or 
right half of a grid square, and erase the left or right half of grid squares. Use 
single-click to place or erase one at a time, or click and drag draw 
continuously. A half width cross is placed in the side of a grid square nearest 
to the point where you click.

Two half width crosses can be placed in each grid square. It is not possible to place or 
erase part of a half width cross. If part of a half width cross is replaced or erased, the other 
half will become a mini cross.

It is recommended to use a minimum Cross Size of 1.6mm for the design when using Half 
Width Crosses. Use Design Properties to set the Cross Size used by the design.

Shortcut
■ Create Tab: 
■ Keys: Alt, C, CW

Half Height Cross
Use Half Height Cross  to place  small crosses that occupy the upper or 
lower half of a grid square, and erase the upper or lower half of grid squares. 
Use single-click to place or erase one at a time, or click and drag draw 
continuously. A half height cross is placed in the side of a grid square nearest 
to the point where you click.

Two half height crosses can be placed in each grid square. It is not possible to place or 
erase part of a half height cross. If part of a half height cross is replaced or erased, the other 
half will become a mini cross.

It is recommended to use a minimum Cross Size of 1.6mm for the design when using Half 
Height Crosses. Use Design Properties to set the Cross Size used by the design.

Shortcut
■ Create Tab: 
■ Keys: Alt, C, CH
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Backstitch
There are two types of backstitch in mySewnet™ Cross Stitcher: Standard  and 
Freehand . 

Standard Backstitch  is drawn in short sections that snap to the sides and diagonals of 
grid squares. The end points for Standard Backstitch are the corners of the grid squares. 

Freehand Backstitch  is drawn as a separate layer to Standard Backstitch. Freehand 
Backstitch is placed using end points that snap to half grid spacing anywhere on the 
design. A single section of Freehand Backstitch can be any length that will fit within the 
design.

Although the screen shows Standard Backstitch and Freehand Backstitch as separate 
layers, they are stitched out together when they are the same color. There will be 
movement stitches between sections of backstitch if they do not connect at an end point. 
Freehand Backstitch will not join to other backstitch without a movement stitch if it simply 
crosses over without the end points connecting. To reduce movement stitches, place 
Freehand Backstitch so that the end points connect to Standard Backstitch sections or 
other Freehand Backstitch sections.

It is possible to place Freehand Backstitch directly on top of Standard Backstitch and both sections will be 
stitched. This can be used for special effects, such as thickening a line without having to change the 

number of threads in Color Properties .

Standard Backstitch
Use Standard Backstitch  to outline  traditional cross 
stitch designs or to create blackwork. Standard Backstitch 
places lines along the sides of grid squares or diagonally 
across grid squares. Standard Backstitch is stitched out after 
the crosses.

Use single-click to place or erase individual lines of Standard Backstitch, or click and drag 
to draw connected Standard Backstitch lines.

Only standard backstitch can be placed or erased when Standard Backstitch is selected. 
Crosses, freehand backstitch and French knots are unaffected.

Two diagonal Standard Backstitch lines can produce an effect similar to a Full Cross. It is recommended to 
avoid placing this in the same square as a Full Cross, because the backstitch will stitch on top of the cross 
and hide it.

Shortcut
■ Create Tab: 
■ Keys: Alt, C, BS
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Freehand Backstitch
Use Freehand Backstitch  to place  lines of stitches 
that can be of any length, with each end snapping to half 
grid spacing. Each line of freehand backstitch is placed 
individually with click and drag.

When stitches are created, stitch points are placed along the freehand 
lines where they cross the grid. The end points of the complete line 
control whether or not a particular line of freehand backstitch is 
connected to any other lines of backstitch.
Only one line of freehand backstitch can go between any given pair of points on the grid. 
However, multiple layers of freehand backstitch may be placed on top of each other, as 
long as they each have at least one different end point. This can be used for different 
effects, such as making the edge of lacework secure.

Shortcut
■ Create Tab: 
■ Keys: Alt, C, BF

French Knot
Use French Knot  to place  French knots that snap to half grid spacing. Each French 
knot is placed or erased with a single click.

French knots are only scaled in comparison to the full cross size when the Cross Size in Design Properties is 
set between 2mm and 4mm. The French knots will not be any smaller or larger than they are at these 
limits.
In the created embroidery, French knots are stitched at the end of the same color block as 
backstitch of the same color.

For designs with a cross size smaller than 4mm, it is recommended to only have one French knot per grid 
square, or an equivalent spacing. If the French knots are closer than this then they may overlap and 
produce excessively dense stitches.
When French knots are placed on the corners or edges of the design, the created embroidery will be larger 
than the design area. If the design is an exact hoop size, this means the embroidery may be too large for 
the hoop. Check the embroidery dimensions in the Design panel.

Shortcut
■ Create Tab: 
■ Keys: Alt, C, K
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Flood Fill
Use Cross Flood Fill  or Pattern Flood Fill  to fill  an area with crosses or a fill 
pattern. An empty area can be flood filled until it meets existing crosses and/or backstitch. 
A connected area of the same colored crosses can be flood filled until it meets an empty 
area, backstitch or crosses in a different color. Crosses are not considered to be connected 
for flood fill if they only meet at a corner.

When an area is flood filled, the fill does not relate to the background picture. Sometimes 
it may help to hide the background picture so that you can clearly see the area you wish to 
flood fill; for example, if there are lines in the background picture that are similar to 
backstitch.

In some cases, the fill will not go through narrow areas. If the fill could not continuously connect a fill of full 
crosses through a narrow gap, the gap will act as a barrier to flood fill.

Cross Flood Fill
Use Cross Flood Fill  to fill an area with full crosses. An empty area can be flood filled 
until it meets existing crosses and/or backstitch.

Shortcut
■ Create Tab: 
■ Keys: Alt, C, FC

Flood Fill an Area with Crosses
1 Open the Create tab.
2 Select the desired cross color from the pop-up palette.
3 Click the Cross Flood Fill icon . The pointer changes to a paint can  when it is over the work 

area.
4 Click an area of the design to fill it with full crosses.

Erase can also be used with Cross Flood Fill to erase  areas of crosses.

Pattern Flood Fill
Use Pattern Flood Fill  to fill an area with a fill pattern. An empty area can be flood filled 
until it meets existing crosses and/or backstitch.

Flood Fill with Other Cross and Stitch Types
Several fill patterns are available to allow areas to be filled with cross types other than full 
crosses. These can be found in the Cross Basic Category. The cross types are:

• Half Cross Forward
• Half Cross Backward
• Mini Cross
• Half Width Cross
• Half Height Cross

There are fill patterns for three-quarter crosses in each of the four possible positions in a 
grid square. In addition, the French Knots Category has French knot patterns in various 
grid arrangements.
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Using Pattern Flood Fills
Use Flood Fill to place a pattern over an area that might be difficult to draw as a shape by 
first drawing crosses and then flood filling the crosses. Choose a color that is not already 
used in the design and draw the desired area as crosses. Then select the pattern and flood 
fill the crosses with the pattern.

Shortcut
■ Create Tab: 
■ Keys: Alt, C, FC

Flood Fill an Area with a Pattern
1 Open the Pattern tab.
2 Select the desired pattern from the gallery and set its colors.
3 Open the Create tab.
4 Click the Pattern Flood Fill icon . The pointer changes to a paint can  when it is over the work 

area.
5 Click an area of the design to fill it with the selected pattern.

Drawing Shapes
Draw one of 120 shapes with Place Shape , or draw an area or outline of any shape with 
Freehand Shape  and Point Shape .

Place Shape
Use Place Shape  to select one of 120 shapes and create an outline or filled area using 
that shape. Then adjust its size.

Draw a ring, a square, a star or other shape using Place Shape.

Shortcut
■ Create Tab: 
■ Keys: Alt, C, P

Create a Shape
1 In the Shape section of the Create tab select a fill and 

outline type. See “Shape Options” on page 90.
2 If drawing a shape with a Backstitch Outline , you 

may select Smooth to smooth the outline of the 
shape by using three-quarter crosses rather than full 
crosses.
Cross Outline  is not affected by Smooth.

3 Click the thread colors for your Fill and Outline 
choices to select a color for Cross Fill and your 
outline.

4 To change the colors or pattern for a Pattern Fill , choose the pattern and its colors in the Pattern 
tab.  See “Select a Pattern” on page 104.
If a color is chosen that does not exist in the palette, it is automatically added to the palette when a shape 
is drawn in that color.

5 Choose a shape from the Shape drop-down menu.
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6 Click the Place Shape  button to place the shape in the work area.
The outline and fill will use the chosen colors and stitch type.

7 Drag the shape to the preferred position, and resize it as desired using the 
square corner handles.
Hold down Ctrl as you drag to resize proportionally. Hold down the Shift key 
to resize from the center.

8 Right-click the shape to place it in the work area.
9 If desired, draw another shape or use Undo and draw the shape again.

Draw Shape
Use the Draw Shape  options Freehand Shape  and Point Shape  to draw an area 
or outline of any shape. 

Shortcut
■ Create Tab: 
■ Keys: Alt, C, D

Freehand Shape
Use Freehand Shape  to draw a line to create shape. 

Draw a line, and the line is closed automatically to form a shape. Adjust the shape by 
moving the nodes. 

Shortcut
■ Create Tab: 
■ Keys: Alt, C, D, DF

Draw a Freehand Shape
1 Select the Create tab in the ribbon bar.
2 In the Shape area select a Fill type and an Outline type.
3 In the Draw Shape  drop-down menu, select Freehand Shape . The pointer changes to the 

Freehand pointer .
4 Draw a line on the work area, then release the mouse button. The line is drawn as a closed line (a loop) 

with nodes.
If the desired line is not achieved when created initially, either redo the line or select and move the nodes as 
desired.

5 Move the pointer over one of the nodes on the line. The pointer changes to the Move Node 
pointer . Adjust the node as desired.
Use Ctlr–click to change a round node to a square node, to make the line straight.

6 When your line is as desired, right-click to place the shape.

Point Shape
Use Point Shape  to create a shape by placing points to create an irregular outline of 
curved and straight lines around the desired area.

Shortcut
■ Create Tab: 
■ Keys: Alt, C, D, DP
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Create a Point Shape
1 Select the Create tab of the ribbon bar.
2 In the Shape area select a Fill type and an Outline type.
3 In the Draw Shape  drop-down menu, select Point Shape . The pointer changes to the Point 

pointer .
4 Click to place a series of points for the shape.

As you click the third point on the line, the line becomes closed (it becomes a loop). As you place 
more points the line adjusts itself. 
The line may ’swing’ while you place points. Just carry on, you can adjust it afterwards.

5 Use Ctlr–click to place square nodes for straight lines.
6 Move the pointer over one of the nodes on the line. The pointer changes to the Move Node 

pointer . Adjust the node as desired.
When the Move Node pointer is active you can adjust existing nodes. If you click while the Point pointer  
is active, another point is added to the line.

7 When your line is as desired, right-click to place the shape.

Shape Options
Fill
Use a Cross Fill  to draw an area filled with crosses, or a Pattern Fill  to draw an area 
filled with a selected pattern. Use No Fill  to create an outline only.

Cross Fill
Use Cross Fill  to draw an area filled with crosses using Place Shape , Freehand 
Shape  or Point Shape .

To use a cross type other than Full Cross inside the shape, select the desired cross type from the Cross Basic 
Category of Fill Patterns.

Shortcut
■ Create Tab: 

Pattern Fill
Use Pattern Fill  to draw an area filled with the selected Pattern Fill using Place 
Shape , Freehand Shape  or Point Shape .

Select a pattern for the Pattern Fill in the Pattern tab of the ribbon bar. See “Select a Pattern” on page 104.

Shortcut
■ Create Tab: 

No Fill
Use No Fill  to create an outline without a fill. Use Place Shape , Freehand Shape  
or Point Shape  to draw an outline with no fill.

If both No Outline  and No Fill  are selected, the Shape options are grayed out (unavailable).

Shortcut
■ Create Tab: 
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Fill Color
Use this color for the fill in shapes using Cross Fill .

Click the Fill color thread sample and choose a color from the drop-down menu. Use Add 
Color  to select a color in the Color Selection dialog, or Pick Color  to select a color 
from the background picture.

Select the colors for a Pattern Fill  in the Pattern tab of the ribbon bar. See “Select a Pattern” on 
page 104.

Shortcut
■ Keys: Alt, C, FT

Outline
Use Backstitch Outline  to draw shapes with a freehand backstitch outline, or Cross 
Outline  to draw hollow shapes as an outline of crosses. Use No Outline  to create a 
fill area with no outline. 

Select an outline type, and then use Place Shape , Freehand Shape  or Point Shape  to draw a 
shape.

Backstitch Outline
Use Backstitch Outline  to draw shapes with a freehand backstitch outline that snap to 
half grid spacing. The shape is added to the design as a series of freehand backstitch lines 
that are connected at the corners of the shape. The backstitch is drawn in the currently 
selected Outline color.

Select Backstitch Outline  in the Create tab, then use Place Shape , Freehand 
Shape  or Point Shape  to draw a backstitch shape.

Shortcut
■ Create Tab: 

Cross Outline
Use Cross Outline  to draw shapes as an outline of crosses, one cross wide. The crosses 
are drawn in the currently selected Outline color.

Select Cross Outline  in the Create tab, then use Place Shape , Freehand Shape  or 
Point Shape  to draw a cross outline shape.

Shortcut
■ Create Tab: 

No Outline
Use No Outline  to create a fill area with no outline.

If both No Outline  and No Fill  are selected, the Shape options are grayed out (unavailable).
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In the Create tab, select one of the Fill options, then select No Outline . Use Place 
Shape , Freehand Shape  or Point Shape  to draw a filled shape with no outline.

Shortcuts
■ Create Tab: 

Outline Color
Use this color for the backstitch and cross outlines around shapes when drawing 
Backstitch Outline or Cross Outline shapes. 

Click the Outline color thread sample and choose a color from the pop-up palette. Use 
Add Color  to select a color in the Color Selection dialog, or Pick Color  to select a 
color from the background picture.

Shortcut
■ Keys: Alt, C, OT

Smooth
Use Smooth to smooth the outline around shapes by using three-quarter crosses rather 
than full crosses for the fill.

Smooth is not initially selected when mySewnet™ Cross Stitcher is opened. It must be selected if you wish to 
draw smoothed shapes.

Shortcut
■ Keys: Alt, C, S

How to Use Shapes
Draw a House with Stitches

1 Open mySewnet™ Cross Stitcher  and in the Start Page of the Cross Stitch Design Wizard select 
Load Picture for New Cross Stitch Design, then click Next. In the Choose Picture page, click Load a 
Picture  and load Documents\mySewnet\Samples\Cross Stitch\Pics\Small House.jpg., then click 
Next twice. In the Design Size page ensure the Cross Size is set to 2.0mm, and the Width and Height 
are set to 40 crosses. Then click Finish to display the house in the design area.
See “Load a Picture of a House” on page 49 for a detailed description of this process.

2 In the Home tab, click Design Properties and in the Design Properties dialog box ensure that Thread 
Count, Crosses and Backstitch are set to Single (2 Threads). Click OK.

3 On the View tab, ensure the Grid Size is set to Every 5 lines .
4 Click the Create tab. 
5 In the Shape section, ensure that No Fill  is selected (the icon to the left in the Fill area).
6 Click to select the Backstitch Outline  option (the 

middle icon in the Outline area).
7 Click the thread color for Outline, and in the pop-up 

palette click Add Color  . The Color Selection dialog 
box appears. 

8 In the Thread Range drop-down list, select Sulky Rayon 40.
Choose from any of the manufacturer’s thread ranges or one of the MyThreads ranges you created using 
mySewnet™ Thread Cache.

9 Enter 1005 in the Find Thread box, and the list will highlight Sulky Rayon 40 1005 (Black). Click OK.
The Outline thread is now black.
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10 In the Shape drop-down menu, ensure that Rectangle (shape 3) is selected.
11 Click Place Shape . A rectangular shape is placed in the center of the design area.
12 Click and drag the corners of the shape to make a rectangle which fits just inside the outline of the 

front of the house. The rectangle should be 24 grid squares wide by 11 high.
This is from about 10 squares in and 15 squares down from the top left of the design area, at the top left of 
the front of the house.

13 Right-click to place the shape.
14 In the Fill section, select Cross Fill .
15 Click the thread color for Fill, and in the pop-up palette click Add Color  . The Color Selection dialog 

box appears. 
16 Enter 1246 in the Find Thread box, and the list will highlight Sulky Rayon 40 1246 (Orange Flame). 

Click OK.

A red Cross Fill  and black Backstitch Outline  are now selected, and the Shape is set to rectangle.
17 Click Place Shape . A rectangular shape is placed in the center of the design area.
18 Click and drag the corners of the shape so that 

it forms a rectangle six grid squares wide by 
nine grid squares high to create a door for the 
house.

19 Right-click to place the shape.
20 At the left of the ribbon bar, click the thread 

color for Crosses, and in the pop-up palette 
select the black color.
This is Sulky Rayon 40 1005 (Black) that you 
selected earlier.

21 Click Full Cross .
22 Draw a roof gutter across the top of the wall, one grid square deep and one grid square wider than 

the wall on each side of the house.
23 Click the Standard Backstitch icon . This draws backstitch lines on the sides and diagonals of grid 

squares.
24 Now draw the roof. At the left hand end of 

the roof gutter, click and drag from one 
square in from the end (1), to place a line of 
five diagonal sections of standard 
backstitch up and to the right, then release 
the mouse button or lift the pen (2).
If you prefer, you can place each section of 
standard backstitch with a single click. Right-click is set to Erase, so you can use single right-clicks to erase 
individual sections of standard backstitch.

25 At the right hand end of the roof gutter, click 
and drag from one square in from the end (3), to 
place a line of five diagonal sections of standard 
backstitch up and to the left (4).

26 Click and drag along the grid line to place a line 
of backstitch along the top of the roof (2 to 4).
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27 Now draw the chimney. At the top right of the roof, start two grid squares in from the end. Click and 
drag to place a line three squares straight up, then a second line three squares left, then a third line 
three grid squares back down to the roof.

28 In the Shape section of the Create tab, click No Fill .
29 Ensure that Backstitch Outline  is selected.
30 Click the Smooth option so it is checked.

Use Smooth to smooth the outline around shapes.
31 In the Shape drop-down menu, select the Circle (shape 1).
32 Click Place Shape . A circle is placed in the center of the design 

area.
33 Drag the circle over the left window of the house, then hold down 

the Ctrl key and move the handles on the box so they lie along the 
grid lines framing the window. 
Holding the Ctrl key while dragging resizes the shape proportionally.

34 Click Zoom To Rectangle  and the arrow pointer changes to the 
zoom in pointer .

35 Click and drag around the left half of the house, then release the mouse button or lift the pen to zoom 
in.

36 Check the positioning of the circle, then right-click to place the 
shape.
If the window does not match the picture, click Undo and try again.

37 Look at the Design Panel. The Color Select area contains threads that 
are currently available for use in a design.
Colors can be added individually and then used, or added 
automatically when designs, shapes or lettering are inserted using 
thread colors that are not already in the palette. When the pointer is 
positioned over a color in this area, a tooltip shows the full thread color 
name.

38 At the left of the ribbon bar, click the thread color for Crosses, and in 
the pop-up palette click Add Color  . The Color Selection dialog 
box appears. 

39 Ensure the thread range is set to Sulky Rayon 40, and enter 1030 in the Find Thread box. The list will 
jump to Sulky Rayon 40 1030 (Periwinkle). Click OK. The color is added to the Color Select area and set 
as the drawing color in the ribbon bar.

40 Click the Cross Flood Fill icon  and the pointer changes to the paint bucket .
41 Click inside the window and it will fill with pale blue crosses.
42 At the left of the ribbon bar click the thread color for Crosses, and in the pop-up palette select the 

black color.
This is Sulky Rayon 40 1005 (Black) that you selected earlier.

43 Click the Freehand Backstitch icon .
Use Freehand Backstitch to add backstitch lines of any length to a design. Freehand Backstitch snaps to 
half-grid spacing. By contrast, Standard Backstitch only places fixed length lines that snap to the sides and 
diagonals of grid squares.

44 Click and drag a line across the middle of the window, then another line down the middle of the 
window.

45 Click the Home tab. 
46 Click Box Select .
47 Click and drag a square around the window.
48 Click the Copy icon . 
49 Click Zoom To Fit . 
50 Click Paste . A new copy of the window will appear at the top left of the 

screen.
51 Click and drag the window to the right-hand side of the house in a similar 

position to the window on the left.
52 Click the Create tab.
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53 At the left of the ribbon bar, click the thread color for Crosses, and in the pop-up palette click Add 
Color  . The Color Selection dialog box appears. 

54 Enter 1066 in the Find Thread box, Sulky Rayon 40 1066 Primrose is selected. Click OK.
55 Click the Cross Flood Fill icon  and the pointer changes to the paint bucket .
56 Click the front wall of the house.
57 At the left of the ribbon bar, click the thread color 

for Crosses, and in the pop-up palette select the red 
color.
This is Sulky Rayon 40 1246 (Orange Flame) that you 
selected earlier.

58 Click on the main part of the roof and the chimney.
Notice that you can change the fill color while you still 
have the Cross Flood Fill tool active.
If the whole picture fills with crosses, click Undo and 
check the backstitch outline of the roof for gaps.

59 Click the thread color for Crosses, and in the pop-up 
palette select the black color (Sulky Rayon 40 1005 
Black).
Click the Full Cross icon .

60 Click and drag under the door to place a row of six black crosses as a doorstep. (Alternatively, click six 
times to place individual crosses.)

61 Click the French Knot icon .
62 Click one square in from the left edge of the 

door and four squares up to place a door 
handle.

63 In the Shape section, select Cross Fill  and 
select No Outline .

64 Click the thread color for Fill, and in the pop-
up palette click Add Color  . The Color 
Selection dialog box appears. 

65 Enter 1011 in the Find Thread box, and the list 
highlights Sulky Rayon 40 1011 (Steel Gray). 
Click OK.

66 In the Shape drop-down menu, select the 
Rectangle (shape 3).

67 Click Place Shape . A rectangular shape is 
placed in the center of the design area.

68 Click and drag the corners of the shape so that the rectangle is placed under the doorstep, making a 
short path that is six crosses wide and three crosses high. Right-click to deselect.

69 Click the thread color for Fill, and in the pop-up palette click Add Color  .
70 In the Color Selection dialog box, enter 1100 in the Find Thread box to select Lt. Grass Green from 

Sulky Rayon 40. Click OK.
71 Place a rectangle of crosses that is 11 wide by four high on the left of the doorstep and path. It should 

be two squares wider than the house.
72 Click Zoom To Rectangle  and the arrow pointer changes to the zoom in pointer .
73 Click and drag around the grass rectangle.
74 At the left of the ribbon bar click the thread color for Crosses, and in the pop-up palette click Add 

Color  .
75 In the Color Selection dialog box, select Sulky Rayon 40 1187 (Mimosa Yellow). Click OK.
76 Click the French Knot icon .
77 Start two squares in and two squares down from the top left of the grass, and click in the center of the 

grid square to place the first yellow flower head. Move right and place four more flower heads in the 
center of alternate grid squares.

78 Click the thread color for Crosses, and in the pop-up palette click Add Color  .
79 In the Color Selection dialog box, Select Sulky Rayon 40 569 (Garden Green). Click OK.
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80 Click the Freehand Backstitch icon .
81 Start from the center of a grid square 

containing a yellow flower head and 
click and drag to draw a backstitch line 
two grid squares straight down. This is 
the stem for the flower. Repeat this for 
the other four flowers.

82 Click the Home tab. 
83 Click Box Select .
84 Click and drag a selection box around 

the grass and flowers.
85 Click Copy . 
86 Click Zoom To Fit . 
87 Click Paste  and the grass rectangle with flowers will appear in the top-left corner. 
88 Click and drag the pasted grass to the right-hand side of the path.

Use File, Save As to save the design as Small House.krz, and use Export  to export the design as Small 
HouseExported.vp4.

Draw and Fill a Cross Stitch Border
1 Close mySewnet™ Cross Stitcher  if it is open, and in mySewnet™ Configure  click the 

Appearance tab.
2 For Background, click the drop-down arrow and then click 

More Colors on the drop-down panel. The Colors dialog box 
appears, with the Standard tab selected.

3 In the hexagonal matrix, click the pale yellow hexagon that is 
just down and to the left of the central white hexagon, then 
click OK. The new color is shown on the Background button. 

4 Set the texture to Aida, then click OK.
5 Open mySewnet™ Cross Stitcher . The Cross Stitch Design 

Wizard opens at the Design Options page.
6 In the Design Options page select Start a New Cross Stitch 

Design with no Picture. 
7 Click Next, and the Design Size page appears.
8 Set the Cross Size to 1.5mm, and click Select Hoop.
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9 In the Hoop Selection dialog box select the Universal Hoop Group, then set Hoop Size to 240mm x 
150mm - Universal Large Hoop 2. Ensure the Orientation is Rotated, and click OK. The design area will 
be calculated and the preview area will show the grid size for the chosen hoop with the selected cross 
size.

10 Click Finish.
11 On the Home tab, click the Design Properties button. 
12 In the Design Properties dialog box ensure that in Thread Count both Crosses and Backstitch are set 

to Single (2 Threads). Click OK.
13 On the View tab, ensure that the grid is set to Every 5 Lines .
14 Click the Create tab on the ribbon bar.
15 In the Shape area, click the Backstitch Outline  option, and ensure that No Fill  is selected.
16 Click the thread color for Outline, and in the pop-up palette click Add Color  . The Color Selection 

dialog box appears. 
17 Ensure that Robison -Anton Rayon 40 is selected as the Thread Range.
18 Enter 2289 in the Find Thread box, and the list will highlight Robison-Anton Rayon 40 2289 (Rust). 

Click OK.
19 In the Shape drop-down menu, ensure that the square (shape 3) is selected.
20 Click Place Shape . A square is placed in the center of the design area.
21 Click and drag the corner handles on the square to create a rectangle one square inside each edge of 

the design area.
22 Right-click to place the rectangle.
23 Click Place Shape  to place a second square, then click and drag to create a second rectangle that 

is four squares inside the first rectangle. Right-click to place.
24 Click the Pattern tab in the ribbon bar, and in Category select Blackwork Basic.
25 In the pattern gallery, select the Lattice 1 pattern. When it is selected, a sample of the pattern and its 

color are shown to the right of the list.
26 Click the black thread color for the pattern and the Color Selection dialog box appears. Enter 2289 in 

the Find Thread box, and the list will highlight Robison-Anton Rayon 40 2289 (Rust). Click OK and the 
pattern preview will also show the new color.

27 Click the Create tab.
28 Click the Pattern Flood Fill icon  and the pointer changes to the paint bucket . Click in the space 

between the two rectangles. The border is filled with a cross stitch pattern.
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To add a title to this sampler, see “Create Title Text for a Sampler” on page 114.

After completing this exercise, you can use the Appearance tab of mySewnet™ Configure  to set the 
Background Color back to the default blue (RGB 211, 233, 255), and to change the texture to Woven.

Draw Filled Shapes for a Sampler
1 In the Appearance tab of mySewnet™ Configure , set the Background to RGB 255, 255, 204, and set 

the Texture to Aida.
2 Open mySewnet™ Cross Stitcher . The Cross Stitch Design Wizard opens at the Design Options 

page.
3 In the Design Options page select Load Existing Cross Stitch Design, and then click Next.
4 In the Open Existing Design page, click Load a Design  and browse to 

Documents\mySewnet\Samples\Cross Stitch\Krz\MySamplerText.krz. Click Finish to close the wizard.
Alternatively, use the design you created in “Add Letters and Numbers to a Sampler” on page 115.

5 Click the Multiply tab on the ribbon bar.
6 Click Use Multiply . Blue reflection line(s) appear in the design area.
7 Ensure that Reflect Across  is selected.
8 Click Zoom To Rectangle  and the arrow pointer changes to the zoom in pointer .
9 Click and drag around the central area of the design to zoom in.
10 Click the Create tab on the ribbon bar.
11 Select Freehand Backstitch .
12 At the left of the ribbon bar, click the thread color for Crosses, 

and in the pop-up palette click color 7, Robison-Anton Rayon 40 
2263 Foxy Red, then click outside the palette to close it.

13 Place the pointer on the central vertical grid line, three grid 
squares below the A.

14 Click and drag down and to the right, until the pointer is three 
squares above the top right part of the ’K’, then release the 
mouse button.

15 From there, click and drag to draw a horizontal line to the central 
vertical grid line to form a triangle.
Ensure the triangle is split by the center grid line, so that it is in the 
center of the design. If not, use Undo and try again.

16 Click the Multiply tab on the ribbon bar.
17 Click Use Multiply  so that it is no longer selected. The blue 

reflection lines are no longer shown.
18 Click the Home tab on the ribbon bar.
19 Click Box Select , then click and drag to select the triangle.
20 Click the Multiply tab on the ribbon bar.
21 Click Use Multiply . The blue 

reflection line appears again.
You cannot select an area while 
Multiply is enabled.

22 Click the Home tab on the ribbon 
bar.

23 Click Duplicate . A copy is 
placed below and to the right of 
the original, with a shadow copy 
to its left.

24 Move the pointer over the Flip 
Vertical handle on the copied 
block and it becomes the vertical 
double-arrow pointer. Click the 
Flip Vertical handle  to mirror 
the block vertically.

25 Move the copy so that it is level with the original triangle, and four squares to the right of it.
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26 Right-click outside the block to place both triangles.
27 If needed, click and drag the horizontal scroll bar at the bottom of the work area to the right, so that 

you can see the empty space to the right of the new triangle.
28 Click the Create tab on the ribbon bar.
29 In the Shape area, for Fill select Cross Fill , 

and for Outline select No Outline .
30 In the Shape drop-down menu select shape 

77, a teardrop.
31 Click Place Shape  to place the shape in the 

design area.
32 Click and drag the shape into the space to the 

right.
33 Hold down Ctrl, and click and drag a corner 

handle to resize the shape proportionally until 
it is the same height as the triangle.

34 Move the teardrop so that the tip of the 
teardrop is three grid squares to the right of 
the top right tip of the triangle.

35 Right-click to place the shape.
36 Click Cross Outline .
37 Click the Outline color for Shapes, and in the pop-up palette click Add Color  .
38 In the Color Selection dialog, ensure that Robison-Anton Rayon 40 is selected as the Thread Range.
39 In the Find Thread box enter 2461 (Robison-Anton Rayon 40 2461 Wheat), then click OK.
40 In the Shape pop-up menu select 39, a star.
41 Click Place Shape  to place the shape in the design area.
42 Click and drag the shape into the empty space to the right of the teardrop.
43 Hold down Ctrl and click and drag a handle to resize the star proportionally until it is the same height 

as the teardrop, and place it between the teardrop and the sampler frame.
44 Right-click to place the shape.
45 Click Zoom To Fit . You can now see all the shapes on the left that were duplicated by the Multiply 

feature.

46 Click the Multiply tab on the ribbon bar.
47 Click Use Multiply  so that it is no longer selected. The blue reflection lines are no longer shown.
48 Click the Pattern tab.
49 In the Pattern area, scroll down to select the Chevron 1 pattern from the Blackwork Basic Category.
50 In Thread Colors, click the color for the pattern. In the Color Selection dialog box, enter 2263 in the 

Find Thread box (Robison-Anton Rayon 40 2263 Foxy Red), then click OK.
51 Click the Create tab on the ribbon bar.
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52 Click the Pattern Flood Fill icon  then click inside the center triangle.
53 Click the Pattern tab on the ribbon bar.
54 Scroll up to select the Brick 1 pattern from the Blackwork Basic Category.
55 Click the color for the pattern. In the Color Selection dialog box, enter 2263 in the Find Thread box 

(Robison-Anton Rayon 40 2263 Foxy Red), then click OK.
56 Click inside the triangle on the right.

If desired, turn off the grid to see the effect of the brick pattern, then turn the grid on again to continue.
57 Select the Stripes 3 pattern from the Cross Basic Category.
58 Click the first color for the pattern. In the Color Selection dialog box, enter 2289 in the Find Thread 

box (Robison-Anton Rayon 40 2289 Rust), then click OK.
59 Click the second color for the pattern. In the Color Selection dialog box, enter 2332 in the Find Thread 

box (Robison-Anton Rayon 40 2332 Penny), then click OK.
60 Click in the teardrop shape on the right to fill it with the stripes.
61 Select the Check 4 pattern from the Cross Basic Category.
62 Click the second color for the pattern. In the Color Selection dialog box, enter 2289 in the Find Thread 

box (Robison-Anton Rayon 40 2289 Rust), then click OK.
63 Click in the teardrop shape on the left to fill it with the check pattern.
64 Select the Diagonal 4 pattern from the Cross Basic Category.
65 Click the first color for the pattern. In the Color Selection dialog box, enter 2461 in the Find Thread 

box (Robison-Anton Rayon 40 2461 Wheat), then click OK.
66 Click the second color for the pattern. In the Color Selection dialog box, enter 2580 in the Find Thread 

box (Robison-Anton Rayon 40 2580 Green Grass), then click OK.
67 Click in the star on the left to fill it with diagonal stripes.
68 Select the Weave 3 pattern from the Mixed Category.
69 Click the first color for the pattern. In the Color Selection dialog box, enter 2461 in the Find Thread 

box (Robison-Anton Rayon 40 2461 Wheat), then click OK.
70 Click the second color for the pattern. In the Color Selection dialog box, enter 2580 in the Find Thread 

box (Robison-Anton Rayon 40 2580 Green Grass), then click OK.
71 Click in the star on the right to fill it with the weave pattern.

To create a new fill pattern for the final triangle, see “Create a Fill for a Triangle in a Sampler” on page 108.

After completing this exercise, you can use the Appearance tab of mySewnet™ Configure  to set the 
Background Color back to the default blue (RGB 211, 233, 255), and to change the texture to Woven.
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Multiply
Use Multiply to create symmetrical designs quickly and easily. All changes in the design, 
such as adding and removing stitches, pasting selections and inserting designs, are 
multiplied.

Repeat stitch placement or edit actions automatically by reflecting across, down or 
rotating.

You cannot use the selection tools to make new selections when the Multiply function is active. Use them 
before activating Multiply to select and copy stitches which can then be pasted and multiplied.

Use Reflect Across  to reflect horizontally. Use Reflect Down  to reflect vertically.

Use Reflect Across and Down  to create four 
copies around the Multiply center point.

Use Rotate  to create four rotated copies around 
the Multiply center point.

Use Reflect 8-Way  to create eight copies. 
Additional blue lines show the eight segments.

Enable Multiply function

Choose reflection & rotation options Click to set new axis of rotation/reflection

Reset axis of rotation/reflection in center of work area
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Click Use Multiply  on the Multiply tab of the ribbon bar to turn Multiply on and off. 
Choose one of the reflection or rotation Multiply methods to repeat actions. The blue 
Multiply reflection lines on the design area show how your actions will be repeated.

Use Multiply
Select Use Multiply  to turn the Multiply function on and off. The blue Multiply 
reflection lines show that Multiply is active.

Shortcuts
■ Multiply Tab: 
■ Keys: Alt, M, M

Method
Choose a Multiply method.

Place Center
Use Place Center  to change the position of the blue Multiply reflection lines.

Click Place Center  and the pointer changes to the cross-hair pointer . Click to 
reposition the central point of the blue Multiply lines.

Shortcuts
■ Multiply Tab: 
■ Keys: Alt, M, P

Reset Center
Use Reset Center  to reset the position of the blue Multiply reflection lines to the center 
of the design area.

Shortcuts
■ Multiply Tab: 
■ Keys: Alt, M, R

Create an Embroidery Pattern with Multiply
1 Click to select the Multiply tab.
1 Click Use Multiply . The blue reflection lines appear on the design area.
2 Select one of the Multiply methods to choose the number of reflections and rotations.
3 If desired, click Place Center  to move position of the reflection lines.
4 Draw some crosses. The drawing will be reflected by the Multiply lines.
5 Click Use Multiply  again to remove the reflection lines and return to standard design creation.

Reflect Across Reflect Down Reflect Across 
and Down

Rotate 4 Way Reflect 8 Way
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Create a Decoration for a Sampler Title with Multiply
1 In the Appearance tab of mySewnet™ Configure , set the Background to RGB 255, 255, 204, and set 

the Texture to Aida.
2 Open mySewnet™ Cross Stitcher . The Cross Stitch Design Wizard opens at the Design Options 

page.
3 In the Design Options page select Load Existing Cross Stitch Design, and then click Next.
4 In the Open Existing Design page, click Load a Design  and browse to 

Documents\mySewnet\Samples\Cross Stitch\Krz\MySamplerBorderTitle.krz. Click OK, then click 
Finish to close the wizard.
Alternatively, use the design you created in “Create Title Text for a Sampler” on page 114.

5 Click the Multiply tab on the ribbon bar.
6 Click Use Multiply . Blue reflection line(s) appear in the design area.

The reflection lines are not part of the design. They only show the effect of the Multiply feature.
7 Click to select Reflect Across and Down .
8 Click Zoom To Rectangle  and the arrow pointer changes to the zoom in pointer .
9 Click and drag around the center of the design where the reflection lines cross.
10 Click the Create tab on the ribbon bar.
11 In the Shape area, click the Cross Outline  option, and ensure that No Fill  is selected.
12 Click the Outline color for Shapes and in the pop-up palette click 

the final color (block 6) to select Robison-Anton Rayon 40 2581 Old 
Dark Tex Orange.
This was the final color used in the lettering.

13 In the Shape drop-down menu, select shape 9, a triangle.
14 Click Place Shape . A triangle is placed in the center of the 

design area.
15 Hold down Ctrl, and click and drag one of the corner handles until 

the triangle is 8 squares along its vertical and horizontal edges.
16 Move the triangle into the center of the reflected area.
17 Right-click to place the triangle.
18 Click the Pattern tab in the ribbon bar, and in Category select French Knots.
19 In the list of pattern samples click Centers Sparse. The patttern is previewed on the right.
20 Click the Create tab on the ribbon bar.
21 Click the Pattern Flood Fill icon  and the pointer 

changes to the paint bucket . Click in the space inside 
the triangle that you drew. All four triangles are filled with 
french knots.
Notice that all actions, including flood fill, are multiplied 
across the reflection lines.

22 Click the Multiply tab on the ribbon bar.
23 Click Use Multiply  so that it is no longer highlighted. 

The blue reflection lines will no longer be shown.
24 Click Zoom To Fit .
25 Click the Home tab on the ribbon bar.
26 Click Box Select , then click and drag around the motif 

in the center of the design area.
27 Click and drag the motif to the gap between 'MY' and 

'SAMPLER'. Position it two squares from the top border, 
and so that it is midway between the 'Y' and the 'S'.
Now create some lower case letters for the sampler. See “Add Letters and Numbers to a Sampler” on 
page 115.

After completing this exercise, you can use the Appearance tab of mySewnet™ Configure  to set the 
Background Color back to the default blue (RGB 211, 233, 255), and to change the texture to Woven.
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7Using Patterns

Select a Pattern
The Pattern section of the Pattern tab on the ribbon bar is used to choose a fill pattern. 
First select a Category, then click a pattern in the gallery. When a fill pattern is selected, it is 
used for Pattern Flood Fill  and in place of crosses inside shapes and TrueType® text.

You can also design your own fill patterns.

Choose a Fill Pattern
1 Click the Pattern tab.
2 Click the drop-down arrow for Category and choose 

a fill pattern category. The gallery will show six of the 
patterns from the chosen category.

3 To select a pattern visually, browse through the 
gallery of patterns and click the desired pattern.
The pattern is shown to the right of the pattern 
gallery, with its colors on its left.
Use the arrows to the right of the pattern gallery to 
move up and down the list of patterns six at a time, or 
click to open the gallery for viewing.

4 Click one of the Thread samples to the left of the 
pattern preview to select a different color in the 
Color Selection dialog box. When a color is changed, 
the pattern preview shows the new color.
The pattern in the gallery is not affected by changing the pattern colors. The colors are reset when a new 
pattern is selected. If a pattern has colors that are not in the Color Select, they are automatically added 
when the pattern is used.

5 Use the selected pattern for Pattern Flood Fill , and creating shapes and TrueType® text.
You can draw crosses and use Cross Flood Fill while a pattern is selected. The pattern remains selected until 
you close, or select another pattern.
The pattern colors will only be added to the Color Select on the Home tab, and the pop-up palette, once the 
selected pattern has been used as a fill.

Category
Choose a Pattern Category from the drop-down menu. The Pattern gallery will show 
patterns in the chosen category. The available categories are:

■ Blackwork Basic
■ Blackwork Fancy
■ Cross Basic
■ Cross Fancy

Choose a Pattern Category

Click a sample to select a pattern

Change the thread colors for the pattern Preview the pattern

Create a new pattern
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■ French Knots
■ Mixed
■ My Patterns

The My Patterns Category is only available if you have created your own cross stitch patterns.

Shortcut
■ Keys: Alt, P, C

Pattern
The Pattern gallery shows six of the patterns from the chosen category. Scroll down, or 
view the complete gallery to see more patterns.

Shortcut
■ Keys: Alt, P, P

Thread Colors
Click one of the pattern colors and the Color Selection dialog box appears, so you can 
choose a new color for the pattern.

Preview
Preview the pattern with the changed colors.

Create New Pattern
Use Create New Pattern  to create a new fill pattern from the currently selected stitches 
in the New Fill Pattern dialog box. See “Design New Patterns” on page 106.

Shortcuts
■ Pattern Tab: 
■ Keys: Alt, P, N
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Design New Patterns
Create a new fill pattern from a design you drew.

To make a fill pattern, first draw a sample of the pattern you would like to create. Then 
select the sample with one of the selection tools, and in the Pattern tab click Create New 
Pattern . The New Fill Pattern dialog box appears.

The Create New button on the Pattern tab is only available if the selection is not larger than 32 grid squares 
high or wide, and if there are no more than 15 colors in the selection. Also, a blank selection may not be 
saved as a pattern.
The Basic Pattern shows the area you selected in the design. The Repeated Pattern shows 
how the pattern will be repeated when it is used to fill an area. Inspect the Repeated 
Pattern to ensure the pattern will give the desired result.

Click the drop-down arrow for Save in Category and select the desired Category. My 
Patterns is the recommended Category and is always selected when the dialog box 
appears. New Categories can also be added as needed.

Click in the New Pattern Name box and enter a name for the pattern.

If desired, adjust the Horizontal Gap and Vertical Gap. The Repeated Pattern will show the 
effect of adjusting these settings. The maximum Gap size is 32, but the minimum Gap is 
negative. The Gap can be decreased until each repeat of the pattern overlaps all but one 
grid square of the previous repeat.

Click OK and the fill pattern is saved in the chosen Category. It is automatically selected as 
the current fill pattern on the Pattern tab.

Stitch Types in Fill Patterns
A pattern may contain any stitch type.

Select a Category for saving your pattern
Create a new pattern Category
Enter a name for your pattern

Preview your pattern alone and repeated

Set the gap between the pattern repeats
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Try to ensure that individual crosses are not alone in a pattern, and that there are no short, 
disconnected sections of backstitch. This will reduce the need for movement stitches 
when the pattern is stitched out.

If you wish to use freehand backstitch in a pattern, try to use short sections where 
possible. When a pattern is used to fill an area, freehand backstitch in the pattern will only 
be placed when both end points lie within the fill area. Long sections of freehand 
backstitch are less likely to have both ends in the fill area and may not give the desired 
result.

Colors in Fill Patterns
Colors are stored in fill patterns with the current number of threads and top stitch 
direction, as set in the design or on the individual color in Color Properties. The system fill 
patterns were designed with Single threads and the top thread as Backward, as these are 
the most common settings for mySewnet™ Cross Stitcher designs.

Pattern Names
Use only letters, numbers, spaces and underline characters. The name will be used for a file 
with .cpk extension. This will ensure that the file name does not have any invalid 
characters in it.

Create a New Fill Pattern Category
You may create a new pattern Category when you are saving a new fill pattern. Click the 
New Category button and the New Fill Pattern Category dialog box appears.

Enter a name for the Category and click OK. The new Category is automatically selected 
for saving the new fill pattern.

Use only letters, numbers, spaces and underline characters. The name will be used for a folder. This will 
ensure that the folder name does not have any invalid characters in it.
If you do not save any fill patterns in the new Category before closing mySewnet™ Cross Stitcher, it will not 
exist when you restart mySewnet™ Cross Stitcher.

Removing Patterns from a Category
mySewnet™ Cross Stitcher patterns are files with a .cpk extension. They are stored in 
folders with the Category names within the 
\User\AppData\Local\mySewnet\Embroidery1\Cross\Patterns folder.

To delete a pattern, close mySewnet™ Cross Stitcher and start Windows® Explorer (right-
click the Start button and click Explore). Browse to the desired Category folder, highlight 
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the desired pattern file and delete it. Restart mySewnet™ Cross Stitcher and the pattern 
will no longer be available.

Creating and Using Patterns
Create a Fill for a Triangle in a Sampler

1 In the Appearance tab of mySewnet™ Configure , set the Background to RGB 255, 255, 204, and set 
the Texture to Aida.

2 Open mySewnet™ Cross Stitcher . The Cross Stitch Design Wizard opens at the Design Options 
page.

3 In the Design Options page select Load Existing Cross Stitch Design, and then click Next.
4 In the Open Existing Design page, click Load a Design  and browse to Documents\mySewnet 

\Samples\Cross Stitch\Krz\MySamplerShapesDrawn.krz. Click Finish to close the wizard.
Alternatively, use the design you created in “Draw Filled Shapes for a Sampler” on page 98.

5 Click Zoom To Rectangle  and the arrow pointer changes to the zoom in pointer .
6 Click and drag around the space in between the triangle and teardrop on the left to zoom in.
7 Click the Create tab on the ribbon bar.
8 Click the Standard Backstitch icon .
9 In the Design Panel, click the dark red in the Color Select area (color 7, Robison-Anton Rayon 40 2263 

Foxy Red).
10 Draw a backstitch triangle inside the area of empty space. Click and drag to place four horizontal 

sections of backstitch, then two diagonal sections up above the center of the line, then two diagonal 
sections back down to the end of the line.
This will be temporary, you could use any area of empty space.

11 Click the Home tab on the ribbon bar.
12 Click Box Select .
13 Click and drag a selection box that exactly fits around the triangle.
14 Click the Pattern tab on the ribbon bar.
15 Click Create New Pattern  and the New Fill Pattern dialog box 

appears. The Basic Pattern shows the area you have selected. The 
Repeated Pattern shows a preview of how the pattern will look when it 
is used.
The Create New Pattern button is only available when an area is selected that may be saved as a new fill 
pattern.
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16 Leave Save In Category set to My Patterns. Click in the New Pattern Name box and type Triangle, then 
click OK. The New Fill dialog box closes.
The pattern is added to MyPatterns, and it is automatically selected as the current Fill Pattern.

17 The triangle used to create the pattern is no longer needed. Click on the selection area on the design, 
click the Home tab on the ribbon bar, then click Delete  to remove the triangle from the design.

18 Click Zoom To Fit .
19 Click the Create tab on the ribbon bar.
20 Click the Click the Pattern Flood Fill icon  then click inside the triangle on the left. The triangle will 

be filled with the Triangle pattern you created.
21 Click the View tab on the ribbon bar.
22 Click No Grid  to turn the grid off so that the backstitch can be seen more easily.

23 Click Edit Notes  on the Design Panel. The Notes dialog box opens.
24 In the Notes text box enter 'Text Shapes and Patterns', then click OK to save the notes.
25 In the Quick Access toolbar, click Save As  and the Save As dialog box appears.
26 In the Save As dialog, change the folder to Documents\mySewnet\My Designs if necessary.
27  Change the file name to 'My Sampler' and click Save.
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28 In the Quick Access toolbar, click Export . The Export dialog box appears.

29 In the Export dialog select .vp4 as the embroidery format and click OK. The Save As dialog box 
appears.

30 In the Save As dialog box, in the Save In box browse to the folder Documents\mySewnet\My Designs. 
In the File Name box, leave the name as 'MySamplerExported', then click Export.

31 If desired, in the Quick Access toolbar, click Print  and the Print dialog box appears. Click OK to 
print a worksheet for the embroidery.

After completing this exercise, use the Appearance tab of mySewnet™ Configure  to set the Background 
Color back to the default blue (RGB 211, 233, 255), and to change the texture to Woven.
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8Creating Text
Use the Letter tab to add text and monograms to your design. You can switch freely 
between TrueType® and Fixed fonts until your text has the desired appearance.

Fixed Font
Create lettering using a fixed font. See “Fixed Font” on page 118.

Shortcut
■ Keys: Alt, E, FF

TrueType Font
Create lettering using a TrueType font. See “TrueType Font” on page 111.

Shortcut
■ Keys: Alt, E, T

TrueType Font
Select TrueType Font on the Letter tab to convert TrueType® or OpenType® characters to 
crosses, crosses with backstitch outlines or a backstitch outline only. If a fill pattern is 
selected, it will be used in place of crosses when the text is applied.

Create TrueType Text
1 Click the Letter tab on the ribbon bar.
2 On the left of the Letter tab, click TrueType Font.
3 Enter the desired text in the Letters box. Press Enter for extra lines of text.
4 In the TrueType font area, click the Font drop-down menu and choose the desired TrueType® font.
5 Choose the desired text Style from the drop-down menu. The text style is Regular if no other style is 

selected.
6 If there is more than one line of text, choose Left , Center  or Right  Alignment.
7 Adjust the Size as desired. It is recommended to use a minimum Size of 12. The maximum is 72.
8 In Fill type, select Cross Fill , Pattern Fill  or No Fill .
9 In Outline type, select Backstitch Outline  or No Outline .
10 To select a fill pattern, click the Pattern tab, choose any available fill pattern, then click the Letter tab.
11 If you have selected Cross Fill, click the Cross color and Color Selection dialog box appears. Choose a 

new cross color for the body of the text and click OK.
12 If you have selected Backstitch Outline, click the Outline color and the Color Selection dialog box 

appears. Choose a new color for the standard backstitch outline around the characters and click OK.

Set Fixed Font or TrueType Font

Choose a TrueType Font, Style and Size

Enter text for your lettering

Set the text alignment

Choose a cross or pattern fill & color

Place the lettering in the work area
Set outline type and color

Letter Tab
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If colors are used that are not in the palette, they are automatically added to the palette when the text is 
fixed in the design.

13 If desired, click the Smooth option so it is selected, to smooth the edges of characters.
Smooth uses three-quarter crosses rather than full crosses to smooth the edges. It is recommended to only 
use this for large characters.

14 Click Apply. The text will appear on the design in a selection box, and Box Select is automatically 
activated.

15 Click and drag inside the selection box to move the text to the desired position.
16 If desired, change the text or any text options (including fill pattern) and click Apply again to change 

the text before it is fixed in place.
17 Click outside the selection box to set the text in place.

You must do this for each section of text if you are placing several sections of text.

Font
Click the drop-down arrow and choose any TrueType® or OpenType® font installed on your 
computer.

Shortcut
■ Keys: Alt, E, FO

Style
Click the drop-down arrow and select a Style, for example Regular, Bold or Italic.

Shortcut
■ Keys: Alt, E, ST

Size
Use Size to set the height of the text. Use a minimum of 12 for simple fonts such as Arial, 
and larger sizes for fonts with more detail. The maximum Size is 72.

Shortcut
■ Keys: Alt, E, SI

Letters
Click in the Letters box and enter the desired text. Press Enter to start a new line of text.

Alignment
If multiple lines of text have been entered, use the Alignment to change how the lines are 
placed relative to each other. Choose Left , Center  or Right  alignment.

Shortcuts

Fill and Outline
These options control the way the text is converted to crosses and backstitch.

Left Letter Tab: Keys: Alt, E, AL

Center Letter Tab: Keys: Alt, E, AC

Right Letter Tab: Keys: Alt, E, AR
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Cross Fill
Select Cross Fill  to use the currently selected Cross color for the characters.

To use a cross type other than Full Cross inside the characters, select the desired cross type from the Cross 
Basic Category of Fill Patterns. 

Shortcut
■ Letter Tab: 
■ Keys: Alt, E, CC

Pattern Fill
Select Pattern Fill  to use the currently selected fill pattern for the characters.

Shortcut
■ Letter Tab: 
■ Keys: Alt, E, CP

No Fill
Use No Fill  to create an outline without a fill.

If both No Outline and No Fill are selected, Apply is grayed out (unavailable).

Shortcut
■ Letter Tab: 
■ Keys: Alt, E, CN

Cross Color
Click the Cross color and the Color Selection dialog box appears, so you can choose a new 
cross color for the text.

Shortcut
■ Keys: Alt, E, CT

Backstitch Outline
Select Backstitch Outline  to place the characters as an outline of standard backstitch in 
the currently selected Outline color.

Shortcut
■ Letter Tab: 
■ Keys: Alt, E, OB

No Outline
Select No Outline  to place the characters as a fill without an outline.

If both No Outline and No Fill are selected, Apply is grayed out (unavailable).

Shortcut
■ Letter Tab: 
■ Keys: Alt, E, ON
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Outline Color
Click the Outline color and the Color Selection dialog box appears, so you can choose a 
new color for the standard backstitch outline around the characters.

Shortcut
■ Keys: Alt, E, OT

Smooth
Select Smooth to make the edges of characters smooth by using three-quarter crosses 
rather than full crosses. It is recommended to use this only for large characters.

Shortcut
■ Keys: Alt, E, Sm

Apply
Click Apply  and the text will appear on the design in a selection box, and Box Select is 
automatically activated. Click and drag inside the selection box to move the text to the 
desired position. The text is not fixed in place until you click outside the selection box.

Shortcut
■ Letter Tab: 
■ Keys: Alt, E. Y

How To Use TrueType Text
Create Title Text for a Sampler

1 In the Appearance tab of mySewnet™ Configure , set the Background to RGB 255, 255, 204, and set 
the Texture to Aida.

2 Open mySewnet™ Cross Stitcher . The Cross Stitch Design Wizard opens at the Design Options 
page.

3 In the Design Options page select Load Existing Cross Stitch Design, and then click Next.
4 In the Open Existing Design page, click Load a Design  and browse to 

Documents\mySewnet\Samples\Cross Stitch\Krz\MySamplerBorderOnly.krz. Click Finish to close the 
wizard.
Alternatively, use the design you created in “Draw and Fill a Cross Stitch Border” on page 96.

5 In the View tab, ensure that Every 5 Lines  is selected.
6 Click the Letter tab on the ribbon bar.
7 On the left of the Letter tab, click TrueType Font.
8 Select Comic Sans MS as the Font, select Bold from the Style drop-down menu, and set the Size to 20.
9 In the Fill area, ensure Cross Fill  is selected and Smooth is unchecked.
10 Click the thread color for Fill, and in the pop-up palette click Add Color  . The Color Selection dialog 

box appears. 
11 Ensure that Robison-Anton Rayon 40 is selected as the Thread Range.
12 In Find Thread enter 2334 (this will select Robison-Anton Rayon 40 2334 Terra Cotta). Click OK.
13 Press CAPS LOCK on the keyboard and enter 'MY', two spaces then 'SAMPLER' in the Text box. Press 

CAPS LOCK again to turn it off.
14 Click Apply and the text appears at the top left of the design area.
15 Click and drag the text to place it in the center, two grid squares below the top border, with four 

squares on either side.
16 Click the Create tab.
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17 At the left of the ribbon bar, click the thread color for Crosses, and in the pop-up palette click Add 
Color  . The Color Selection dialog box appears. 

18 Click the green in the Quick Colors in row 2, column 6 and Robison-Anton Rayon 40 2580 Green Grass 
is selected. Click OK to choose this color.
If a different color is selected, click the drop-down arrow to the right of the Quick Colors and ensure that 
the Standard theme is enabled.

19 Click the Cross Flood Fill icon  and the pointer changes to the paint bucket . Click the 'Y' and 'L' 
in MY SAMPLER. They are filled with the green.

20 In the Design Panel click the second color (Robison-Anton Rayon 40 2289 Rust). At the left of the 
ribbon bar, the thread color for Crosses changes to this color.

21 With this color selected, click the 'S' and 'E'.
22 At the left of the ribbon bar, click the thread color for Crosses, and in the pop-up palette click Add 

Color  . The Color Selection dialog box appears. 
23 Enter 2596 in the Find Thread box, Robison-Anton Rayon 40 2596 Marine Gold is selected and click 

OK. Then click the 'A' and 'R'.
24 At the left of the ribbon bar, click the thread color for Crosses, and in the pop-up palette click Add 

Color  . The Color Selection dialog box appears. 
25 Enter 2581 in the Find Thread box, Robison-Anton Rayon 40 Old Dark Tex Orange is selected. Click OK. 

Then click the 'M' in the middle of 'SAMPLER'.

To add a decoration to this title with Multiply, see “Create a Decoration for a Sampler Title with Multiply” 
on page 103.

After completing this exercise, you can use the Appearance tab of mySewnet™ Configure  to set the 
Background Color back to the default blue (RGB 211, 233, 255), and to change the texture to Woven.

Add Letters and Numbers to a Sampler
1 In the Appearance tab of mySewnet™ Configure , set the Background to RGB 255, 255, 204, and set 

the Texture to Aida.
2 Open mySewnet™ Cross Stitcher . The Cross Stitch Design Wizard opens at the Design Options 

page.
3 In the Design Options page select Load Existing Cross Stitch Design, and then click Next.
4 In the Open Existing Design page, click Load a Design  and browse to 

Documents\mySewnet\Samples\Cross Stitch\Krz\MySamplerBorderTitleDecorated.krz. Click Finish to 
close the wizard.
Alternatively, use the design you created in “Create a Decoration for a Sampler Title with Multiply” on 
page 103.

5 In the View tab, ensure that Every 5 Lines  is selected.
6 Click the Letter tab in the ribbon bar.
7 Ensure that TrueType Font is selected.
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8 Change the Font to Arial, and ensure that Style is set to Regular.
9 Set the Size to 11.
10 In the TrueType Font Colors section, select Cross Fill  and No Outline .
11 Click the thread color for Fill, and in the pop-up palette click color number 5 (this will select Robison-

Anton Rayon 40 2596 Marine Gold). 
12 In the Letters box, enter 'abcdefghijklmnopqrstuvwxyz', then click Apply .
13 Click and drag the text to the bottom of the design, so the bottoms of the 'g', 'p', 'q' and 'y' are one 

square up from the border, and the ’a’ is 5 squares to the right of the left border. The selection box will 
overlap the border. Click outside the selection box to set the text in place.

14 In the Letter tab, change the Font to Times New Roman, and set the Style to Bold.
15 Set the Size to 14.
16 In the Text box, change the text to '0123456789'.
17 In the TrueType Font Colors section, select Pattern Fill  and ensure that No Outline  is selected.
18 Click the Pattern tab in the ribbon bar.
19 Select Cross Basic as the Category, then click Check 1 in the pattern gallery.
20 There are two colors for the pattern. Click the first color and the Color Selection dialog box will 

appear. 
21 The color is currently set to Robison-Anton Rayon 40 2461 Wheat. Enter 2263 in the Find Thread box 

(Robison-Anton Rayon 40 2263 Foxy Red) and click OK.
22 Click the Letter tab in the ribbon bar.
23 Click Apply .
24 Click and drag the text to position it so that the '3' is two squares above the lowercase 't' and the '9' is 

two squares from the border on the right.
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25 Click outside the selection box to set the text in place.

26 Change the Font to Verdana, and set the Style to Regular.
27 Set the Size to 12.
28 In the TrueType Font Colors section, select Cross Fill  and No Outline .
29 Click the thread color for Fill, and in the pop-up palette click color number 6 (this will select Robison-

Anton Rayon 40 2581 Old Dark Tex Orange). 
30 Press CAPS LOCK on the keyboard and, in the Letters box, change the text to 'STUVWXYZ'.
31 Click Apply .
32 Click and drag the text to position it two squares above the lowercase letters and two squares from 

the border on the left. Click outside the selection box to set the text in place.
33 In the Letters box, change the text to 'ABCDEFGHIJKLMNOPQR'. Press CAPS LOCK to turn it off.
34 Click Apply .
35 Click and drag the text to position it in the middle and so that the tail of the Q is two squares above 

the numbers. Click outside the selection box to set the text in place.

36 Click the Create tab.
37 In the Shape section, select Cross Fill  and Cross Outline .
38 Click the thread color for Fill, and in the pop-up palette click color number 6 (this will select Robison-

Anton Rayon 40 2581 Old Dark Tex Orange).
39 Click the thread color for Outline, and in the pop-up palette click color number 3 (this will select 

Robison-Anton Rayon 40 2334 Terra Cotta).
40 In the Shape drop-down menu, select shape 1, a circle.
41 Click Place Shape . A circular shape is placed in the center of the design area.
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42 Hold down Ctrl, and click and drag one of the corner handles until the circle is 5 squares wide.
Holding down Ctrl keeps the proportions.

43 Drag the circle into the gap between the Z and 0.
44 Click Zoom To Rectangle  and the arrow pointer changes to the zoom in pointer .
45 Click and drag around the gap between the Z and 0.
46 Right-click to place the shape.

The final shape is the nearest to a circle that can be made at this size.
47 Click Zoom To Fit .
48 Click Save As  and the Save As dialog box appears.
49 In the Save As dialog, change the folder to Documents\mySewnet\My Designs if necessary. Enter the 

file name 'My Sampler Text' and click Save.
This provides a text sampler that you can decorate later, starting from your 'MySamplerText.krz' design.
To add filled shapes to this sampler, see “Draw Filled Shapes for a Sampler” on page 98.

After completing this exercise, you can use the Appearance tab of mySewnet™ Configure  to set the 
Background Color back to the default blue (RGB 211, 233, 255), and to change the texture to Woven.

Fixed Font
Select Fixed Font on the Letter tab of the ribbon bar to place text using pre-defined fonts. 
Fixed Text is applied according to the design of the characters, which can include any type 
of stitch.

Create Fixed Text Lettering
1 Click the Letter tab in the ribbon bar.
2 On the left of the Letter tab, click Fixed Font.
3 Enter the desired text in the Letters box. Press Enter for extra lines of text.
4 To choose a font, click the drop-down arrow to the right of the font display and select a category and 

font from the gallery.
The font names include additional information to the actual name of the lettering style. 2C and 3C indicate 
the font uses two or three colors. UC indicates the font has only uppercase characters. LC indicates the font 
has only lowercase characters. At the end of the font name is the font size, which is the height of the 'A' 
character in grid squares. For instance, Sans Cross 3C 7 uses three colors and the 'A' is seven grid squares 
high.

5 If there is more than one line of text, choose Left , Center  or Right  Alignment.
6 To use colors different from the default colors, click a thread sample in Fixed Font Colors, and the 

Color Selection dialog box appears. Choose a new color and click OK.
If colors are used that are not in the palette, they are automatically added to the palette when the text is 
fixed in the design.

7 Click Apply. The text will appear on the design in a selection box.
8 Click and drag inside the selection box to move the text to the desired position.
9 If desired, change the text or any text options and click Apply again to create a new version of the 

text.
10 Click outside the selection box to set the text in place.

You must do this for each section of text if you are placing several sections of text.

Use a Fixed Font or TrueType Font

Choose a Fixed Font from the gallery

Enter text for your lettering

Set the text alignment

Choose your lettering colors

Place the lettering in the work area

Letter Tab
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Fill patterns are not used by Fixed Fonts when the text is applied. However, the characters may be flood 

filled with any pattern using Pattern Flood Fill  after they have been fixed in place.

Font
Click the drop-down arrow and choose any Fixed Font installed on your computer for 
mySewnet™ Cross Stitcher from the gallery. Scroll through the list of fonts by Category, 
and click a font sample to select it.

The font names include information in addition to the actual name of the lettering style. 2C and 3C 
indicate the font uses two or three colors. UC indicates the font has only uppercase characters. LC indicates 
the font has only lowercase characters. At the end of the font name is the font size, which is the height of 
the 'A' character in grid squares. For instance, Sans Cross 3C 7 uses three colors and the 'A' is seven grid 
squares high.

Font Category
There are 7 themed font categories:

Alignment
If multiple lines of text have been entered, use the Alignment to change how the lines are 
placed relative to each other. Choose Left , Center  or Right  alignment.

Letters
Click in the Letters box and enter the desired text. Press Enter to start a new line of text.

Display Decorative fonts.

Elegant Stylish fonts with a heritage feeling, such as gothic alphabets.

Floral Fonts with leaves and flowers decorating the letters.

Modern Fonts with 'clean' designs in modern styles.

Retro Celticf and other classic style fonts.

Script Fonts with an appearance of handwriting.

Traditional Old-fashioned serif fonts.
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Apply
Click Apply  and the text will appear on the design in a selection box, and Box Select is 
automatically activated. Click and drag inside the selection box to move the text to the 
desired position. The text is not fixed in place until you click outside the selection box.

Fixed Font Colors
Fixed Fonts can have up to three colors in them. Click the desired color and the Color 
Selection dialog box appears, so you can choose a new color. When a new color is chosen, 
all stitches in the current font that use the color will be affected. The colors are reset when 
the font is selected again.

Fill patterns do not affect Fixed Fonts.

Create Text for the Happy House Sampler
1 In the Home tab, click Design Properties and in the Design Properties dialog box, ensure that Thread 

Count, Crosses and Backstitch are set to Single (2 Threads). Click OK.
2 In the View tab, ensure that Grid is set to Every 10 Lines .
3 In the File menu, click New  or Open  and load Documents\mySewnet\Samples\Cross 

Stitch\Krz\Line of buds for Happy House.krz.
Alternatively, set up the work area and create the line of buds as described in “Place a Border of Buds for the 
Happy House Sampler” on page 25.

4 Click the Letter tab.
5 At the left end of the Letter tab, click Fixed Font.
6 In the Fixed Font area, click the drop-down 

arrow to view the font gallery.
7 Click and drag the scroll bar on the right of 

the box down to the Modern font 
category.
The Fixed Font names include the type of 
stitches in the font, and the number at the 
end is the height in grid squares of the 'A' 
character in the font. Additionally, fonts that 
use more than one color will have 2C (two 
color) or 3C (three color) in the name.

8 Click the font 'Sans Cross Narrow 7'. The 
gallery closes.

9 Click in the Letters box and type 'Welcome 
To Our'.

10 Click Apply. The text will appear on the 
design and it is automatically selected 
with Box Select.

11 Click and drag the selection so that the text is centered under the top border of buds, with the tops of 
the uppercase letters two grid squares below the buds. The left side of the W should be three squares 
from the left edge. The selection box will overlap the buds, but the buds will not be affected.

12 Click outside the selection box to deselect the text and set it in place.

13 In the drop-down list of fonts, select 'Sans Cross 9'.
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14 In the Letters box, delete the previous text, type 'Happy', press Enter, then type 'House' so that the text 
is on two lines. 

15 In the Fixed Font Colors box, click the blue color block and the Color Selection dialog box appears.
16 Ensure that Robison-Anton Rayon 40 is selected as the Thread Range. In the Find Thread text box, 

enter 2378 and the list will jump to 2378 (Red). Click OK and the color block will change to red.
This changes the color of the lettering from the blue used by the font to red.

17 Click Apply and the text will appear 
on the design, and it is automatically 
selected with Box Select.

18 Click and drag the selection to 
position the text centrally, with a 
gap of two grid squares under the 
'Welcome To Our' line. Click outside 
the selection box to set the text in 
place.

19 The Box Select  function is still 
selected, so click and drag a 
selection box around the word 
'House'.

20 Move the word 'House' exactly four 
squares up from its current position, 
so that the top of the 'H' is only one 
square below the 'y' of 'Happy'.

21 Click outside the text to deselect it and set it in place.
To add cross stitch designs to this sampler, see “Add Designs to the Happy House Sampler” on page 25.



122          mySewnet™ Cross Stitcher   Editing Designs 

9Editing Designs

Edit Crosses, Backstitch and French Knots
Draw Color and Erase
Choose a thread color from the pop-up palette in the Color area of the Create tab to select 
a drawing color. Click the Erase  icon to erase stitches when drawing, or right-click while 
drawing with a color to erase stitches.

Edit Crosses
Use any type of cross to replace and erase any other type of cross. When drawing full 
crosses, they will replace or erase any combination of small or part crosses in a grid square. 
When drawing any other size of cross, they will replace or erase according to their size and 
shape. Crosses can be drawn, replaced and erased by single clicks or click and drag.

Edit Backstitch
Standard and freehand backstitch are edited separately.

Standard backstitch replaces existing standard backstitch if it is drawn in the same place. 
Standard backstitch can be drawn, replaced and erased by single clicks or click and drag.

Freehand backstitch will only replace existing freehand backstitch if it is drawn with 
exactly the same end points. If either end point is different, a new line of freehand 
backstitch is added. Freehand backstitch is drawn and replaced one line at a time with 
click and drag, and erased one line at a time with single clicks.

Edit French Knots
French knots are drawn, replaced and erased individually with single clicks. Only one 
French knot can exist at each half grid point.

Select
The select functions in the Home tab allow you to select an area of stitches. A selection 
can be rotated in 90 degree steps, mirrored, moved, copied, cut and duplicated.

When stitches have been selected, they have a selection box around them on the design 
area. Click and drag inside the selection box to move it.

When making a selection, only stitches that are on grid points that are completely enclosed by the 
selection line will be included in the selection. If the selection line crosses freehand backstitch lines, the 
freehand backstitch will not be included because you have not completely enclosed both ends.

Inserting or Pasting a Selection
When a new selection is added to a design by paste, insert or the Letter functions, it is 
automatically selected and Box Select is activated. The selection is placed in the top left 
corner of the visible design area.
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Deselecting a Selection
Click the work area outside a block to deselect it. The selection box around the block will 
disappear and the selection will become part of the design. Any colors in the selection 
that were not in the palette will be added to the palette.

Selections are also automatically deselected when any new selection is added to the 
design, or when other functions that affect the design are activated.

Box Select
Use Box Select  to select crosses and backstitch in a rectangular area. Click Box Select 
and the pointer changes to the box select pointer . Click and drag around the area you 
want to select. Only stitches that are on grid points that are completely enclosed by the 
selection line will be selected. When you release the mouse button, the block will show 
you the extent of the selection. Click outside the block to make a new selection using this 
method.

The block can be moved, mirrored horizontally and vertically and rotated in 90 degree 
steps. The block can be copied or cut to the clipboard and then pasted to the same or 
another cross stitch design. The block can also be deleted.

Box Select is also activated automatically when a block is pasted into a design.

If the wrong area is selected, click outside the box to deselect.
Box Select is not available to make new selections when the Multiply function is active.

Shortcut
■ Home Tab: 
■ Keys: Alt, H, B

Freehand Select
Use Freehand Select  to select a block of stitches within an area of any shape. Click 
Freehand Select and the pointer changes to the freehand select pointer . Click and drag 
to draw an irregular outline around the desired area. When you release the mouse the area 
is closed automatically with a straight line between the last mouse position and the start 
position. The block will show you the extent of your selection. Click outside the block to 
make a new selection using this method. Right-click to deselect.

Freehand Select is not available to make new selections when the Multiply function is active.

Shortcut
■ Home Tab: 
■ Keys: Alt, H, FS

Point Select
Use Point Select  to select a block of stitches within an area of any shape made of 
straight and curved lines. Click Point Select  and the pointer changes to the Point select 
pointer . Click a series of points to create an irregular outline of straight and curved 
lines around the desired area, using Shift+click to place a square (straight line) point. Click 



124          mySewnet™ Cross Stitcher   Editing Designs 

and drag  to reposition an existing point. Click Delete to remove the last–placed point. 
Right-click when the area is complete. The block will show you the extent of your 
selection. Only stitches that are on grid points that are completely enclosed by the 
selection line will be selected. Point Select may be easier to use than Freehand Select for 
precise selections. Right-click to deselect.

The block can be moved, mirrored horizontally and vertically and rotated in 90 degree 
steps. The block can be copied or cut to the clipboard and then pasted to the same or 
another cross stitch design. The block can also be deleted.

If the wrong area is selected, click in the design area, but outside the box, to deselect.
Point Select is not available to make new selections when the Multiply function is active.

Shortcut
■ Home Tab: 
■ Keys: Alt, H, FP

Select All Visible
Use Select All Visible  to select the whole design automatically with Box Select. The 
selection box will be shown around the edge of the design. Click outside the box, in the 
work area outside the design, to deselect.

Shortcut
■ Home Tab: 
■ Keys: Ctrl + A; Alt, H, SA

Select None
Use Select None  to deselect all of the stitches in the design area.

Shortcut
■ Home Tab: 
■ Keys: Ctrl + A; Alt, H, SN
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Modify a Selection
Flip Vertical and Horizontal
Mirror the selected block of stitches vertically or horizontally using the flip handles on the 
selection box. 

Move the pointer over one of the handles and it becomes a double-arrow pointer. Click 
the Flip handle to mirror the block horizontally or vertically.

Rotate 90
Use Rotate 90  to rotate a selection in 90 degree steps.

When a selection is rotated, the size of the selection box may change. This helps to show the position the 
selection will take each time it is rotated.

Shortcut
■ Home Tab: 

■ Keys: Alt, H, 9

Flip Vertical Handle

Flip Horizontal handle
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Cut, Copy, Paste and Duplicate
Once stitches have been selected with one of the selection tools, they can be cut and 
copied. Only stitches that are completely enclosed by the selection line will be selected. 
The selection on the clipboard can be pasted as many times as desired within the 
mySewnet™ Cross Stitcher module.

Cut
Use Cut  to cut out the selection and place the stitches on the clipboard. The selection 
can then be pasted back in.

Shortcuts
■ Home Tab: 
■ Keys: Ctrl + X; Alt, H, CU

Copy
Use Copy  to copy the selection to the clipboard, without affecting the current 
selection. The selection can then be pasted back in.

Shortcuts
■ Home Tab: 
■ Keys: Ctrl + C; Alt, H, CO, CO

Copy Embroidery
Click Copy Embroidery  to place the selected stitches as a cross stitch embroidery on 
the clipboard. You can then paste this embroidery into another mySewnet™ Embroidery 
Software module.

If no stitches are selected, the complete design is copied.

Shortcuts
■ Home Tab, Copy: 
■ Keys: Alt, H, CO, CE

Paste
Use Paste  to paste the selection on the clipboard back into the design.

When a selection is pasted, it does not become part of the design until it is 'fixed' by being deselected. 
Therefore, if a part of a design is copied and pasted to a different design, new colors from the pasted 
selection will not appear in the palette until the selection is fixed in place.
Embroideries that have been copied from other mySewnet™ Embroidery Software modules may not be 
pasted into mySewnet™ Cross Stitcher because they are not cross stitch designs. However, you may use 
Copy Embroidery to copy a design from mySewnet™ Cross Stitcher to another mySewnet™ Embroidery 
Software module.

Shortcuts
■ Home Tab: 
■ Keys: Ctrl + V; Alt, H, P
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Duplicate
Use Duplicate  to make a copy of the selected block of stitches, which is automatically 
pasted on the work area below and to the right of the original.

Shortcuts
■ Home Tab: 
■ Keys: Alt, H, DU
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Delete
Use Delete  to delete a selection after it has been selected using one of the selection 
tools.

This function differs from Cut because it does not place the stitches on the Clipboard. 
Therefore stitches that have been Deleted cannot be pasted into another design 
(although Undo can be used if the wrong stitches are deleted).

Use Delete Color on the Design panel to remove a color from the design.

Shortcuts

■ Home Tab: 
■ Keys: Del; Alt, H, DE

Undo and Redo
Undo
Use Undo  to reverse the last action. If you are not satisfied with the result, click Redo.

Each time you use Undo the undone action becomes a Redo. For instance, you might 
erase a cross and then Undo the erase. You could now Redo the erase or do something 
else. If you erase a different cross instead of using Redo then the Redo is lost, along with 
any other Redos that may have followed.

There are unlimited Undo steps. Undo steps are only lost when you close a design.

Shortcuts
■ Quick Access Toolbar: 
■ Keys: Ctrl + Z; Alt, 6

Redo
Use Redo  to reverse the last action that was undone by Undo. If you are not satisfied 
with the result, click Undo.

Redo only works if nothing has happened after the last Undo. For instance, if you change a 
palette color, then Undo and draw some crosses, then it is not possible to Redo the color 
change because something different has happened instead.

There are unlimited Redo steps. Redo steps are only lost when you close a design.

Shortcuts
■ Quick Access Toolbar: 
■ Keys: Ctrl + Y; Alt, 7
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10Printing
Use the Print page to select your print settings, and to preview and print a worksheet for 
your cross stitch embroidery. In mySewnet™ Embroidery, you may print an overview of the 
embroidery on a project background or split into sections. The printed pages match the 
Export settings for the embroidery. 

To open the print page in mySewnet™ Cross Stitcher, click File, Print .

Print Page
Select the printer and page layout in print setup, and choose a scale, hoop, units of 
measurement, and details to be printed. Then click Print to print the embroidery 
worksheet and/or overview.

Shortcuts
■ Quick Access Toolbar: 

Print
Click Print to open the Print page and print the project. See “Print” on page 132.

Design Scale
Select 25%, 50%, 75%, 100% or ’to fit’ scaling when printing your design. This is how large 
the design will print compared to the real size of a stitched out cross stitch embroidery. 
Use a reduced Design Scale if you want to ensure that the worksheet fits on one page. 
Look at the print preview pane to see how many pages will be printed.

Grid
This determines whether or not a grid will be printed with the design.

Select information & grid

Select measurement units

Choose a scale

Print the worksheets

Preview the printout
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Flip design for felting or reverse embroidery
Flip the embroidery for being stitched in reverse, or for felting effects. 

Print Information
This determines what additional information is printed. All items are selected initially.

Dimensions
The size of the embroidery and the stitch count.

Hoop
The hoop used for the embroidery.

Color Information
The sequence of thread colors used and, if available, the thread specification (range and 
thread number).

Notes and Settings
Any notes or settings that are included with the embroidery.

Export Options
The Export options used for the embroidery, as set in the Export dialog box.

Technical Information
The distance of each edge of the embroidery from the center of the embroidery.

Units of Measurement
Select between Millimeters and Inches.

Print Setup
Click Print Setup to select a printer in the Print Setup dialog. Choose the units of 
measurement (inches or millimeters) and print quality. Select and enter details for a table 
of contents.

Preview Pane
The preview pane displays the embroidery as it would appear when printed. Other 
information, such as the Dimension, Color Information, Notes, Settings and Technical 
Information, is shown depending on the choices made in the Worksheets section of the 
Print dialog box.

The print preview toolbar offers you options to zoom in and out of the page, and to show 
multiple pages  or individual pages . If there are multiple pages, step through them 
with Next Page  and Previous Page .

Print Preview Toolbar
The print preview toolbar offers you the following options:
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Next Page
Preview the next page  to be printed. If this is grayed out when you are on Page 1 then 
there are no more pages and the print fits on one page.

Previous Page
Preview the previous page  to be printed.

Multiple Pages
Select  how many printed pages to preview at a time.

Individual Page
Preview only one  page at a time.

Zoom In
Take a closer look at the page to be printed.

Zoom Out
Take a larger look at the page to be printed.
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Print Setup
This is displayed when you click the Print Setup button in the Print dialog box.

Use Print Setup to select the destination printer and its connection.

Printer
Select the printer you want to use.

Paper Size
Select the size of paper that the embroidery is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources. Specify the tray here.

Orientation
Choose Portrait or Landscape. Generally, you should not need Landscape for the standard 
hoop sizes as the embroidery is rotated automatically by the print process when you print 
an embroidery that uses a Rotated hoop.

Properties
Displays a dialog box that provides additional printing choices, specific to the type of 
printer you have selected.

Print
Print the embroideries and background that are displayed on the mySewnet™ Cross 
Stitcher screen. Other information, such as the Dimensions, Color Information, Notes and 
Technical Information is printed depending on the choices made in the Print page, where 
the scale may also be altered, and a grid turned on or off. If possible, the hoop will be 
printed with the same orientation as on the screen. If a horizontal hoop is too wide to fit 
on the paper at the Design Scale chosen in the Page page then the hoop will be rotated 90 
degrees when it is printed.
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The Print dialog box appears, where you may specify number of copies, the destination 
printer, and other printer setup options.

Shortcut
■ Keys: Ctrl + P
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Print an Embroidery Worksheet
Use Print  to print a worksheet in 3D for the embroidery created from your design.

See “Print Page” on page 129..

Print a Worksheet for an Embroidery
1 Click New  and in the Design Options page of the Cross Stitch Design Wizard select Load Existing 

Cross Stitch Design, then click Next. In the Open Existing Design page, click Load a Design  and 
load Documents\mySewnet\Samples\Cross Stitch\Krz\Linnet.krz, then click Finish.
Alternatively, use the design you created in “Create a Cross Stitch from a Photograph” on page 46, saved 
and exported as described in “Create Cross Stitch and Embroidery Files for a Photo Design” on page 64.

2 Drag the slider to the center of the Zoom bar to view the design at the size it will be stitched.
3 In the Home tab of the ribbon bar, click Design Properties.
4 In the Design Properties dialog box, ensure Thread Count, Crosses is set to Single (2 Threads). Click 

OK.
5 Click Edit Notes  on the Design Panel.
6 In the Notes text box in the Notes dialog box enter 'Family Photo' and click OK to save the notes.
7 Click File, Print.
8 In the Print window ensure that Design Scale is set to 100%, deselect (uncheck) Grid and ensure all 

the Print Information options are checked.
Look at the Print Preview. The preview shows the number of stitches and the cross size.

9 Click Print and print the design.

You can also print a worksheet using the Print  button in the Quick Access toolbar.
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11Troubleshooting

Error Messages
Acquiring and Loading Pictures

"Not enough memory to load this picture."
This message may appear if the picture is very large. If you are loading the picture, use 
picture editing software to reduce it size. If you are acquiring the picture from a scanner or 
digital camera, change the settings in the acquiring or scanning application so the picture 
is smaller.

"LoadImage: GDI+ out of memory."
This message could appear if the selected picture is not a valid picture file. For example, it 
might have an extension such as .bmp or .jpg, yet not be a proper picture file.

Opening Cross Stitch Designs

"Cannot open file "xx.krz". The device is not ready."
This message appears if the desired cross stitch design (.krz) file is not where the module 
expects it to be. For example, if a design was loaded into the program from a USB memory 
stick, then closed and the memory stick removed. The message would appear if you tried 
to load the design from the recent files list on the File menu.

"No valid cross stitch data (Unknown file format)."
This message appears if the file you are attempting to load is corrupt. For example, it 
might have a .krz extension, yet not be a proper cross stitch design file.

Saving Cross Stitch Designs

"Cannot create file "xx.krz". Access is denied."
This message appears if, for instance, you attempt to save the design to a CD. A CD-ROM is 
read only, therefore you will not be able to save the design.

Editing Thread Colors

"This will remove all stitches of this color. Do you wish to continue?"
This message appears when you click Delect Color in the Color Select area, if there are 
stitches using the selected color in the cross stitch design. Click Yes to continue, for 
example, to remove a color that is only used in the background.
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Choosing Thread Colors

"The color xx has been found in your database, but the thread color is not 
exactly the same."
This message appears if the Thread Range and Color Number of the selected color are 
identical to those in your thread database, but some aspect of the color is different. It 
could be a different material or weight, or have additional colors as a variegated thread. 
This could happen if the design you are attempting to edit was supplied by someone with 
a different version of the color, for instance if they have edited it in MyThreads, or if they 
have a later version of the thread database. If you click OK, the color will be replaced with 
the near match. You can alter it to any other color if desired. If you click Cancel, the color 
will not be changed. To import the new color from an embroidery if it is a MyThreads color, 
use mySewnet™ Thread Cache. To check for the latest updates for the mySewnet™ 
Embroidery Software, use Smart Update in mySewnet™ Configure.

"Could not find xx in your database. Matching to closest thread in yy."
This message appears if the Thread Range of the selected color is not found in your thread 
database. This could happen if the design you are attempting to edit was supplied by 
someone with a later version of the thread database. If you click OK, the color will be 
replaced with the nearest match in the Import Thread Range you have set in mySewnet™ 
Configure. You can alter it to any other color if desired. If you click Cancel, the color will not 
be changed. To check for the latest updates for the mySewnet™ Embroidery Software, use 
Smart Update in mySewnet™ Configure.

"Error - thread range is corrupt or missing. Cannot change thread. Restore 
MySettings or reinstall the thread database."
This message appears if there is a problem with your thread database. You will be unable 
to choose a thread color. First close all the modules of the mySewnet™ Embroidery 
Software, close down your computer and restart. If this does not clear the problem, restore 
a backup with Restore MySettings, if you have created one using Backup MySettings in 
mySewnet™ Configure. Otherwise, you either need a new version of the thread database, 
or a repair install of your mySewnet™ Embroidery Software software. To check for the 
latest updates for the mySewnet™ Embroidery Software, use Smart Update in mySewnet™ 
Configure.

If the error still appears, then repair the installation. First, delete the following files from 
ProgramData\VSMSoftware\mySewnet\System:

■ User.sqlite
■ System_cdb2.sqlite

This assumes you have installed your mySewnet™ Embroidery Software software in the default location. If 
these file are not present then this is the reason for the error. The file names may be shown without their file 
extensions.
Put your mySewnet™ Embroidery Software software USB stick in your computer and re-
run the Applications installation. (If you downloaded your software, double-click on the 
mySewnet™ Applications file.) When the choice appears, select the "Modify or remove" 
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option and click Next. In the next screen, select Repair and click Next. Continue with the 
installation and follow the on-screen instructions. When the installation is complete, the 
thread database will be restored to its original installation state. This means that the 
MyThreads database will have the default set of threads.

This will also reset MyThreadRanges and custom Quick Color Themes to their installation states. Check 
Smart Update in mySewnet™ Configure after repairing the installation.

"Error. Please select a valid thread."
This message appears if you attempt to click OK in the Color Selection dialog box when 
MyThreads is selected as the thread range and MyThreads is empty.

To prevent this message appearing again, use mySewnet™ Thread Cache to add at least 
one thread to MyThreads.

Exporting Embroideries

"Embroidery too large for export format."
Certain formats are limited to the number of stitches they can save or the size of hoop 
used on their specific embroidery machine, for example .sew. If you attempt to save a file 
in this format that is bigger than the largest available hoop size or has more stitches than 
are allowed, this message would appear.

"Unrecognized file extension."
This message appears if you type an incorrect extension that does not belong to any 
embroidery types in the File Name box when trying to save a file.

"Cannot save file."
This message appears if, for instance, you attempt to save the embroidery to a CD. A CD-
ROM is read only, therefore you will not be able to save the embroidery.

"Embroidery has too many stitches for file format."
There is a limit on the number of stitches that may be saved to an embroidery file in Pfaff 
(.pcs) file format. This message appears if the embroidery you attempt to save to this 
format exceeds this limit.
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Other Topics
Screen Appearance

"I have changed grid color and spacing and now I wish to return to the 
original settings."
Use mySewnet™ Configure to change the grid color. Follow the instructions in mySewnet™ 
Configure and select Blue Gray (RGB values 102, 102, 153) from the standard color drop-
down on the Grid Color button.

Use Screen Preferences to change the grid spacing. Set the Grid lines to 5 lines.

"I have changed the screen background color and now I wish to return to 
the original light blue."
Use mySewnet™ Configure to change the background color. Follow the instructions in 
mySewnet™ Configure and select the RGB values 211, 233, 255 in the Colors dialog box.

To use Reset All Modules
1 Ensure your designs are saved in any mySewnet™ Embroidery Software modules that are open.
2 Click mySewnet™ Configure on the QuickLink toolbar.
3 Click Reset All Modules.
4 A message will appear, indicating that all modules will be closed and reset. Click OK.
5 A message will appear, asking you to ensure that all other mySewnet™ Embroidery Software modules 

have closed, apart from mySewnet™ Configure. Click OK.
6 A message will appear, indicating that all modules have now been reset. Click OK. The toolbars in your 

module will have been restored.
If preferred, you can check individual toolbars in View, Customize. Use this to see if the missing toolbar has 
been turned off, and also to reset the toolbar if icons have been added to or removed from the toolbar. If 
this does not restore the toolbar, use Reset All Modules.

"I have used a variegated thread, but it is only showing as a single color."
Only the first color in a variegated thread is shown in a cross stitch design. To see the effect 
of a variegated thread, use Design Player or Life View.

"I have placed backstitch, but it is not visible at all zoom levels."
If the grid color is similar to the color of backstitch, then the backstitch may blend with the 
grid at certain zoom levels so that it is hard to see. Turn off the grid temporarily to see 
where you have placed your backstitch. Backstitch may also be easier to see in Block 
mode.

"I have loaded a picture for a new design, but the screen is blank when 
the Cross Stitch Design Wizard closes."
The background picture and grid are not shown at the smallest zoom level. In 3D, the 
fabric is also not shown at the smallest zoom level. When the Cross Stitch Design Wizard 
closes, the screen automatically zooms to fit the design size chosen in the Cross Stitch 
Design Wizard. If the design size was large, then the smallest zoom level is used. As there 
are no stitches, the screen appears to be blank because the picture, fabric and grid are not 
shown. Zoom in to see the picture, fabric and grid.
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"Stitches seem to be missing when I open my cross stitch designs after I 
have been working for a while."
This will only happen if you have used Hide Colors to hide some of the colors or stitches in 
a design you were working on previously. The Hide Colors options are not reset 
automatically until you restart mySewnet™ Cross Stitcher. Click the Hide Colors icon, then 
click Reset.

"I can’t see the picture, fabric or grid when I Zoom To Fit."
The background picture and grid are not shown at the smallest zoom level. In 3D, the 
fabric is also not shown at the smallest zoom level. When Zoom To Fit is used, the smallest 
zoom level may be used if the design is large. Zoom in to see the picture, fabric and grid.

Using the Cross Stitch Design Wizard

"The From Scanner or Camera option is not available, even though my 
scanner/camera is plugged in."
The From Scanner or Camera option may not be available, even though you have installed 
and connected a scanner/camera, if it does not support Windows Image Acquisition 
(WIA). If your scanner/camera supports a different image acquisition system, e.g. TWAIN, 
create a .PNG or .JPG file of the image in My Pictures, and load it from there.

Loading Cross Stitch Designs

"I can't drag and drop designs from the Open dialog box."
To drag and drop embroideries onto the Work Area, in Windows® 10 and 11, click File 
Explorer on the Status Bar.  Then follow the instructions under Drag and Drop. See “Load a 
Design with Drag and Drop” on page 15.

Flood Fill

"I have loaded a picture for a new design, but Flood Fill covers the whole 
picture when I try to fill colored areas of the picture."
Pattern Flood Fill and Cross Flood Fill are not affected by areas of color in a background 
picture. An empty area of the design can be flood filled until it meets existing crosses and 
backstitch. A connected area of the same colored crosses can be flood filled until it meets 
an empty area, backstitch or crosses in a different color. To clearly see the areas that will be 
flood filled, turn off the background picture.

"Flood Fill does not fill the whole area as expected."
In some cases, Flood Fill and Cross Flood Fill will not go through narrow areas. If the fill 
could not continuously connect a fill of full crosses through a narrow gap, the gap will act 
as a barrier to the flood fill.
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"I have a pattern that uses freehand backstitch. When I use it to fill an area 
it does not seem to fill the area completely or some lines of freehand 
backstitch appear to be missing."
When a pattern is used to fill an area, freehand backstitch in the pattern will only be placed 
when both end points lie within the fill area. Long sections of freehand backstitch are less 
likely to have both ends in the fill area and may not give the desired result. If you wish to 
use freehand backstitch in a pattern, try to use short sections where possible.

Editing Cross Stitch Designs

"When I use Rotate 90 on a selection, the selection becomes a square."
The selection area is extended by Rotate 90 so that you can clearly see where the selection 
will be placed by each click of the Rotate 90 icon. The stitches in the selection area are not 
changed.

"Nothing seems to happen sometimes when I use Undo after using Erase."
Each time you click with Erase, this is recorded as an action you can Undo. If you click in 
blank space, or you miss the item you are trying to Erase, the action is still recorded for 
Undo. Hence, when you Undo, the Erase action is undone, even though it seemed to have 
no effect on the design.
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Creating and Stitching Embroideries

"The embroidery is larger than the design size I had selected in Design 
Properties."
This may happen if you have French knots on the edges of your design. French knots are 
drawn by placing their center point on any point that snaps to half grid spacing. Therefore, 
if they are placed along the edges of the design, half the French knot will be outside the 
grid. If French knots are placed on all edges of the grid, the resulting embroidery will be 
larger than the design by the size of a French knot.

French knots are only scaled in comparison to the full cross size when the Cross Size in Design Properties is 
set between 2mm and 4mm. The French knots will not be any smaller or larger than they are at these 
limits.

"The embroidery seems to have too many stitches."
Check Design Properties to ensure you do not have a large number of strands for crosses 
and/or backstitch in the design. Increasing the number of strands will increase the 
number of stitches.

"The embroidery is very thick when it stitches out."
Check Design Properties to ensure you do not have a large number of strands for crosses 
and/or backstitch in the design. Increasing the number of strands will increase the density 
of stitches.

"There seem to be some very thick lines of stitching where I used 
backstitch in the design."
Standard Backstitch and Freehand Backstitch are drawn on two separate layers in 
mySewnet™ Cross Stitcher, but they are stitched out together if they are the same color. In 
addition to this, Freehand Backstitch can be placed in multiple layers over the same line, as 
long as the end points of each line are different.

This is used, for example, to place different colors of Freehand Backstitch on top of each 
other to secure the edges of lace. Each layer will stitch out separately according to the 
color order in the design, but the same thread color is used in the stitchout to give a single 
color to the lace effect.
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12Quick Reference Guide

Ribbon Tabs
File Tab/Menu

Home Tab

New Start a new cross stitch design.
Ctrl + N

New Window Open an additional mySewnet™ Cross Stitcher window.
Ctrl + Shift + N

Open Open an existing cross stitch design.
Ctrl + O

Recent Open a recently used cross stitch design.

Insert Browse for designs and insert one into the current design.
Ctrl + I; Alt, 1

Save Save the design with its current name.
Ctrl + S; Alt, 2

Save As Save the design with a new name.
Ctrl + Shift + S; Alt, 3

Export Save the selected design as a .vp4 embroidery file, or in an 
alternative embroidery format, optimized for stitching.
Ctrl + E; Alt, 4

Send Send the selected embroidery to the mySewnet™ Cloud, or to the 
connected machine or computer.
Ctrl + K

Print Print a worksheet for the current design.

Configure Open mySewnet™ Configure.

Exit Close the module.
Alt + F4

Copy Copy the selection to the clipboard.
Ctrl + C; Alt, H, CO, CO

Copy Embroidery
Place the selected stitches as a cross stitch embroidery on the 
clipboard to copy into another module.
Alt, H, CO, CE

Paste Paste the current contents of the clipboard as a new selection.
Ctrl + V; Alt, H, P

Cut Remove the selection and place the selection on the 
clipboard.
Ctrl + X; Alt, H, CU
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Duplicate Make a copy of the selected block of stitches, which is pasted 
below and to the right of the original.
Alt, H, DU

Delete Delete the current selection.
Del; Alt, H, DE

Box Select Select a block of stitches by opening a square or rectangular 
box around it.
Alt, H, B

Freehand Select Select a block of stitches within an area of any shape by 
drawing around it. 
Alt, H, FS

Point Select Select a block of stitches within an area of any shape made of 
straight and curved lines.
Alt, H, FP

Select All Visible Select everything in the design.
Ctrl + A; Alt, H, SA

Select None Deselect all of the stitches in the design area.
Ctrl + Shift + A; Alt, H, SN

Rotate 90 Rotate the selection in 90 degree steps.
Alt, H, 9

Remove Unused Colors Delete any thread colors that do not have stitches in the 
design.
Alt, H, U

Hide Crosses Hide all types of crosses in the design area.
Alt, H, HC

Hide Backstitch Hide all types of backstitch in the design area.
Alt, H, HB

Hide Knots Hide French Knots in the design area.
Alt, H, HH

Display All Display all stitches in the active design.
Alt, H, R

Design Properties Set the cross size, the design size, the number of threads, and 
the direction of the top thread for crosses.
Ctrl + D; Alt, H, DP

Life View Show how an embroidery exported from the design will look 
in 3D with real-world perspective. Create a picture or video of 
your design.
Ctrl + L; Alt, H, L; Alt, 8

Design Player Play through the stitches in the design as if they were being 
stitched from an exported embroidery. Create a picture or 
video of your design.
Ctrl + J; Alt, H, J; Alt, 9
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Create Tab
Thread Color Select the thread color for drawing stitches from the pop-up palette.

Alt, C, T

Erase Erase stitches of the selected type.
Alt, C, E

Full Cross Place and edit Full Crosses.
Alt, C, CF

Quarter Cross Place and edit Quarter Crosses.
Alt, C, CQ

Half Cross 
Forward

Place and edit Half Forward Crosses.
Alt, C, CR

Half Cross 
Backward

Place and edit Half Backward Crosses.
Alt, C, CB

Mini Cross Place and edit Mini Crosses.
Alt, C,CM

Half Width 
Cross

Place and edit Half Width Crosses.
Alt, C, CW

Half Height 
Cross

Place and edit Half Height Crosses
Alt, C, CH

Standard 
Backstitch

Place and edit Backstitch that follows grid lines.
Alt, C, BS

Freehand 
Backstitch

Place and edit Backstitch of any length.
Alt, C, BF

French Knot Place and edit French Knots.
Alt, C, K

Cross Flood Fill Flood Fill an area with crosses.
Alt, C, FC

Pattern Flood 
Fill

Flood Fill an area with the current Fill Pattern.
Alt, C, FP

Shape
Fill

No Fill Create an outline without a fill.

Cross Fill Draw an area filled with crosses.

Pattern Fill Draw an area filled with the selected Pattern Fill.

Fill Color Use this color for the cross fill in a shape.
Alt, C, FT

Outline

No Outline Create a fill area with no outline.

Backstitch 
Outline

Draw shapes as freehand backstitch outlines.

Cross Outline Draw shapes as an outline of crosses, one cross wide.

Outline Color Use this color for the backstitch and cross outlines around shapes.
Alt, C, OT
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Multiply Tab

Smooth Use Smooth to smooth the outline around shapes by using three-
quarter crosses rather than full crosses. Smooth only affects shapes.
Alt, C, S

Draw Shape

Freehand Shape
Draw a line to create shape.
Alt, C, D, DF

Freehand Shape
Create a shape by placing points.
Alt, C, D, DP

Place Shape Select one of 120 shapes and create an outline or filled area using that 
shape.
Alt, C, P

Use Multiply Turn Multiply on and off. The blue reflection lines are shown on the design 
when Multiply is switched on.
Alt, M, M

Method Select the reflect or rotate method.
Alt, M, O

Place Center Change the position of the Multiply lines.
Alt, M, P

Reset Center Reset the position of the Multiply lines to the center of the design area.
Alt, M, R
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Letter Tab
Fixed Font Create lettering using a fixed font.

Alt, E, FF

TrueType Font Create lettering using a TrueType® or OpenType® font.
Alt, E, T

Fixed Font Gallery

TrueType Font
Font Choose a font for creating lettering.

Alt, E, FO

Style Select a Style, for example Regular, Bold or Italic.
Alt, E, ST

Size Set the height of the text. 
Alt, E, SI

Letters
Letters Enter some text for your lettering.

Alignment
Left Place multiple lines of text with a straight left edge.

Alt, E, AL

Center Place multiple lines of text that are centered above and below each 
other.
Alt, E, AC

Right Place multiple lines of text with a straight right edge.
Alt, E, AR

Fixed Font Colors
Thread Use these colors for fixed font letters.

TrueType Font Colors

Fill
No Fill Draw letters as an outline without a fill

Alt, E, CN

Cross Fill Draw letters as an area filled with crosses.
Alt, E, CC

Pattern Fill Draw letters as an area filled with the selected Pattern Fill
Alt, E, CP

Fill Color Use this color for the cross fill in lettering.
Alt, C, CT

Outline
No Outline Draw letters without an outline.

Alt, E, ON

Backstitch 
Outline

Draw letters with a freehand backstitch outline.
Alt, E, OB
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Outline Color Use this color for the backstitch and cross outlines around shapes.
Alt, C, OT

Smooth Use Smooth to smooth the outline around letters by using three-
quarter crosses rather than full crosses.
Alt, E, Sm

Apply Place the created text in the design area.
Alt, E, Y
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Pattern Tab

View Tab

Category Choose a Pattern Category from the drop-down menu. 
Alt, P, C

Pattern Select a pattern from the gallery.
Alt, P, P

Thread Colors Choose different colors for the pattern.

Preview Preview the pattern with the changed colors.

Create New 
Pattern

Create a new fill pattern from the currently selected stitches.
Alt, P, N

Grid Show or hide the background grid.

Every Line Show every line in the grid.
Alt, V, EL

Every 5 Lines Show every fifth line in the grid.
Alt, V, E5

Every 10 Lines Show every tenth line in the grid.
Alt, V, E1

No Grid Do not show the grid.
Alt, V, H

Get Length Measure the distance between any two points on a design.
Alt, V, G

Background
Fade 
Background

Use the slider to vary the brightness of the background picture.

Remove 
Background

Remove the background picture from the design.
Alt, V, R

View Mode
Block View the design in Block mode.

Alt, V, B

2D View the design in 2D View mode.
Alt, V, 2

3D View the design in 3D View mode.
Alt, V, 3

Design 
Properties

Set the cross size, the design size, the number of threads, and the 
direction of the top thread for crosses.
Ctrl + D; Alt, V, D

Show Design 
Panel

Show the Design Panel.
Ctrl + D; Alt, V, S
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Help Tab
Help Topics List help topics.

F1; Alt, L, H

About mySewnet™ 
Cross Stitcher

Display module information, version number and copyright.
Alt, L, A
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Toolbars
Quick Access Toolbar

Status Bar
Use the Select Tools on the Status Bar to select stitches in your design.

Use the Zoom Commands on the Status Bar to navigate around embroideries.

Insert Browse for designs and insert one into the current design.
Alt, 1

Save Save the design with its current name.
Ctrl + S; Alt, 2

Save As Save the design with a new name.
Alt, 3

Export Save the selected design as a .vp4 embroidery file, or in an alternative 
embroidery format, optimized for stitching.
Ctrl+ E; Alt, 4

Print Print a worksheet for the current design.
Ctrl + P; Alt, 5

Undo Undo the last action.
Ctrl + Z; Alt, 6

Redo Redo the last action.
Ctrl + Y; Alt, 7

Life View Show how an embroidery exported from the design will look in 3D 
with real-world perspective. Create a picture or video of your design.
Ctrl + L; Alt, H, L; Alt, 8

Design Player Play through the stitches in the design as if they were being stitched 
from an exported embroidery. Create a picture or video of your design.
Ctrl + J; Alt, H, J; Alt, 9

Box Select Select a block of stitches by opening a square or rectangular box 
around it.

Freehand Select Select a block of stitches within an area of any shape by drawing 
around it. 

Point Select Select a block of stitches within an area of any shape made of 
straight and curved lines.

Select All Visible Select everything in the design.
Ctrl + A

Select None Deselect all of the stitches in the design area.
Ctrl + Shift + A

Zoom To Rectangle Increase magnification of an area of the embroidery.
Ctrl + 0

Zoom To Fit Fit the work area to the screen.
Ctrl + 9

100%
Display at 100% magnification.
Ctrl + 1
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200%
Display at 200% magnification.
Ctrl + 2

400%
Display at 400% magnification.
Ctrl + 3

800%
Display at 800% magnification.
Ctrl + 4

75%
Display at 75% magnification.
Ctrl + 5

50%
Display at 50% magnification.
Ctrl + 6

25%
Display at 25% magnification.
Ctrl + 7

Zoom Out Decrease magnification.
Ctrl + -

Zoom In Increase magnification.
Ctrl + =
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Design Panel
Design Information
The Information shows the dimensions (Width  and Height ), the number of 
stitches  and the number of colors  in an embroidery created from the design.

Color Select
A worksheet panel showing the color blocks in the design. It is used to change the thread 
color, show which color blocks are visible and turn the display of color blocks on and off, 
and show the Thread Count and Top Thread Direction for each thread color.

Notes
Enter up to 2000 characters in the Notes for additional information about the design.

Change Color Change the color for the selected thread.

Move Color Down Move the selected color block down the stitching order.

Move Color Up Move the selected color block up the stitching order.

Merge Colors Combine the selected color block with the block above it.

Delete Color Remove the selected color, and all stitches using it, from the design.

Color Properties Adjust the Thread Count and Top Thread Direction for the selected 
thread color.

Add Color Add a new thread color to the worksheet.

Pick Color Pick a color from the design or background picture.
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Index
Numerics
2C................................................................. 118, 119
2D..............................................................................53
3C................................................................. 118, 119
3D..............................................................................52
90 Degree Rotate ............................................. 125

A
Abbreviation for Thread Range......................67
About......................................................................... 3
Acrobat Reader® .................................................... 2
Add

Borders..........................................................30
Color ...................................................... 70, 81
Quick Color Theme...................................77
To Palette Automatically ....88, 112, 118

Aida
Count..................................................... 10, 72
Fabric.............................................................52

Alignment ................................................. 112, 119
Apply Text ................................................. 114, 120
Area

Deselect........................................... 123, 124
Design......................................................5, 73
Work................................................................. 5

Assisi Work .............................................................12
Autolevel ................................................................33
Automatically

Add to Palette ........................88, 112, 118

B
Background...........................................................53

Color ....................................................52, 110
Fabric.............................................................52
Faded.............................................................54
Off...................................................................54
On...................................................................54
Picture Removed.......................................30

Backstitch...............................................................85
And French Knots ............................. 70, 82
Connected...................................................86
Edit .............................................................. 122
Freehand.................................................6, 86
Freehand on Top of Standard..........9, 85
Hide ...............................................................71
Outline ................................................91, 113
Standard..................................................6, 85
Standard and Freehand............................ 8
Threads .........................................................73

Backward
Half Cross .....................................................83
On Top...........................................................74

Bar
Status............................................................... 5
Title .................................................................. 4
Zoom.............................................................58

Blackwork...............................................................12
Block ........................................................................53
Blue ..........................................................................69
Borders....................................................................30
Box Select.................................................. 101, 123

C
Camera.................................................................... 32
Category...............................................................104

Create New................................................107
Font..............................................................119
Removing Patterns.................................107

Change
All To .............................................................. 41
Thread........................................................... 42
Thread Colors ............................................. 65

Chart
Cross Stitch ................................................. 50

Choose
New Thread Color ..................................... 68
Thread Colors ............................................. 41

Choose and Change Thread Colors .............. 65
Choose Picture..............................................32, 46
Close

mySewnet Cross Stitcher ..........................3
Color

Add .........................................................70, 81
Background ...................................... 52, 110
Choose New Thread................................. 68
Combinations............................................. 11
Configuration............................................. 74
Cross ..................................................113, 114
Draw ............................................................122
Edit ................................................................. 78
Fill ................................................................... 91
Grid ................................................................ 54
Information...............................................130
List.................................................................. 42
Models .......................................................... 68
Outline.......................................................... 92
Paste .............................................................. 79
Pick..........................................................70, 80
Preview Thread.......................................... 43
Reduce Changes ....................................... 30
Select................................................... 65, 152
Selection ...................................................... 41
Thread........................................................... 68

Color Blocks
Move and Merge....................................... 69

Color Order............................................................ 30
Considerations........................................... 69

Color Palette
Thread........................................................... 65

Color Select ........................................................... 65
Color Selection..................................................... 67
Color Worksheet .................................................. 65
Colors

Choose and Change Thread ................. 65
Choose Thread........................................... 41
Fixed Text...................................................120
In Fill Patterns...........................................107
In mySewnet Cross Stitcher .................. 68
Number of ................................................... 41
Remove Unused........................................ 75
Thread........................................................... 65

Combinations of Color...................................... 11
Configuration
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Color ..............................................................74
Connected Backstitch........................................86
Considerations

Color Order..................................................69
Copied Embroideries ...................................... 126
Copy...................................................................... 126

Color ..............................................................78
Corners or Edges with French Knots ............86
Count

Thread................................................... 10, 75
Counts

Stitch ............................................................... 9
Create

New Category ......................................... 107
Picture...........................................................14
QuickCross Design............................ 28, 31
Stitches .........................................................80
Text.............................................................. 111

Create New Pattern ......................................... 105
Cross

Color ................................................. 113, 114
Full.............................................................6, 82
Half Backward ............................................83
Half Forward ...............................................82
Half Height .............................................6, 84
Half Width...............................................6, 84
Mini ...........................................................6, 83
Mode .............................................................52
Outline ..........................................................91
Quarter ....................................................6, 82
Size ..................................................10, 37, 72
Threads .........................................................73

Cross Fill..................................................................90
Cross Flood Fill .....................................................87
Cross Stitch

Eastern European......................................12
Hand Sizes ...................................................72
Thread Colors .............................................68

Cross Stitch Design
Files .................................................................. 6
Load Existing ...................................... 28, 31
Load Picture for New ....................... 28, 31
Wizard ...........................................................28

Cross Stitch Design Assistant............................ 1
Cross Stitch Designs

Hints on Planning ....................................... 8
Managing.....................................................14
Viewing.........................................................52

Crosses ....................................................................81
And Movement Stitches........................... 8
Edit .............................................................. 122
Hide ...............................................................71
Remove Isolated........................................30

Crosses/Fill Pattern .......................................... 113
Custom Color........................................................68
Cut ......................................................................... 126
Cutwork Needle Line .........................................20

D
Default

Set As..................................................... 73, 74
Delete ................................................................... 128

Quick Color Theme...................................79
Thread Color ...............................................42

Delete All
Thread Color ...............................................42

Deselect
Selection ....................................................123
Wrong Area.....................................123, 124

Design
Create QuickCross .............................28, 31
Element Library ......................................... 16
Elements ...................................................... 16
Files ...................................................................6
Information.......................... 5, 55, 61, 152
Insert ............................................................. 16
krz from Previous Version .........................6
Load............................................................... 45
Load Existing .......................................28, 31
Load Picture for New ........................28, 31
New with no Picture .........................29, 31
Open Existing............................................. 45
Options......................................................... 31
Preview......................................................... 44
Print ..................................................................9
Scale ............................................................129
Styles ............................................................. 12

Design Area...................................................... 5, 73
Design Edges with French Knots.............. 8, 86
Design New

Patterns ......................................................106
Design Panel ..........................................5, 65, 152

Show.............................................................. 65
Design Player........................................................ 59

Video Speed................................................ 63
Design Properties ............................................... 71
Design Size ....................................................... 8, 72

Reduced ....................................................... 73
Design Wizard ...................................................... 28
Designs

Edit ...............................................................122
Hints and Tips on QuickCross............... 30
Hints on Planning........................................8
Managing .................................................... 14
Open Recently Used ................................ 15
Viewing......................................................... 52

Desktop Shortcuts.................................................3
Different Thread Ranges................................... 30
Digital Camera ..................................................... 32
Dimensions

Page Setup ................................................130
Direct USB Connection ..................................... 22
Direct USB Settings ............................................ 24
Direction of Top Thread .............................73, 75
Display

All.................................................................... 71
Double .................................................................... 73
Drag and Drop to Load Design ...................... 15
Draw

Shape ............................................................ 88
Draw Color and Erase ......................................122
Draw Shape........................................................... 89
Duplicate..............................................................127

E
Eastern European Cross Stitch ....................... 12
Edges with French Knots.................................. 86
Edit

Backstitch ..................................................122
Color .............................................................. 78
Crosses........................................................122
Crosses, Backstitch and French Knots122
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Designs ...................................................... 122
French Knots............................................ 122
Menu .......................................................... 142
Picture................................................... 14, 33
Quick Color Theme...................................79

Eight Copies Multiply...................................... 101
Embroideries

Copied........................................................ 126
Preferred Saving Format........................... 7

Embroidery
Export............................................................18
Files .................................................................. 7

Enhance Eye Highlights ....................................30
Enter Size................................................................40
Erase.........................................................................81

Draw Color................................................ 122
With Flood Fill ............................................87

Error Messages .................................................. 135
Existing Cross Stitch Design .................... 28, 31
Exit.......................................................................3, 24

Save On.........................................................17
Explorer...................................................................15
Export ......................................................................18
Export Options.................................................. 130
Eye Highlights ......................................................30

F
Fabric

Aida................................................................52
Background.................................................52

Fade
Background.................................................54

File
Formats........................................................... 6
Name .............................................................15

File Menu............................................................. 142
Files

Cross Stitch Design..................................... 6
Embroidery ................................................... 7
Picture............................................................. 7
Sample............................................................ 2

Files of Type...........................................................15
Fill

Color ..............................................................91
Erase with Flood........................................87
Flood....................................................6, 8, 87
Pattern Colors.......................................... 107

Fill Pattern
Stitch Types .............................................. 106

Fill Patterns and Fixed Text Fonts ..... 119, 120
Fill Through Narrow Gaps ................................87
Finding Information ............................................. 1
Finish .......................................................................46
Fixed Text ............................................................ 118

Colors ......................................................... 120
Fixed Text Fonts

Fill Patterns..................................... 119, 120
Flip

Horizontally or Vertically ..................... 125
Flip design for felting or reverse embroidery130
Flood Fill .......................................................6, 8, 87

Erase ..............................................................87
Font ............................................................. 112, 119

Category.................................................... 119
Color ........................................................... 118
Fill Patterns..................................... 119, 120

Format for Saving Embroideries.......................7
Forward Half Cross.............................................. 82
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Four Copies Multiply........................................101
Freehand

Select.................................................101, 123
Freehand Backstitch...................................... 6, 86

And Standard Backstitch...........................8
Over Standard Backstitch ................. 9, 85

Freehand Shape .................................................. 89
French Knot...................................................... 6, 86
French Knots..................................................70, 82

And Movement Stitches............................9
Edit ...............................................................122
On Corners or Edges................................ 86
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Full Cross ........................................................... 6, 82
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Off................................................................... 54
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I
Import Chart ......................................................... 50
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Import Thread Range in mySewnet Configure6
Inches ......................................................................55
Included in My Hoops .......................................39
Information

Color ........................................................... 130
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For Hand Cross Stitchers ........................10
Print ............................................................ 130
Readme .......................................................... 2
Technical ................................................... 130
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Insert or Paste Selection ................................ 122
Isolated Crosses
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K
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